# Table of Contents

## WELCOME
- Objectives .......................................................... 1
- Key Points .......................................................... 1

## BASICS

### SOURCING OVERVIEW
- What is Sourcing? .................................................. 2
- Core Functionality and Process Flow ......................... 2
- Work Groups and Events ........................................ 4
- Inviting Suppliers ................................................... 4
- Notifications ......................................................... 10
- Sourcing Definitions .............................................. 11

## EVENTS

- Sourcing Events Home ............................................ 31
- Event Overview .................................................... 31
- Event Creation ..................................................... 45
  - Create an Event .................................................. 47
  - Update an Event ................................................ 48
  - Copy an Event .................................................. 48
  - Delete an Event ................................................ 49
  - Hide Event Prices .............................................. 49
- Event Setup .......................................................... 50
  - Event Setup ..................................................... 52
- Event Users .......................................................... 58
  - Event Users ..................................................... 59
- Event Description .................................................. 62
  - Event Description .............................................. 63
- Event Prerequisites ............................................... 63
  - Event Prerequisites ........................................... 64
- Event Buyer Attachments ......................................... 65
  - Buyer Attachments .............................................. 66
- Event Supplier Attachments ....................................... 67
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Value for Events</td>
<td>126</td>
</tr>
<tr>
<td>Configure Best Value Setting</td>
<td>127</td>
</tr>
<tr>
<td>Supplier Disqualification</td>
<td>128</td>
</tr>
<tr>
<td>Configure Automatic Disqualifying Responses</td>
<td>130</td>
</tr>
<tr>
<td>Manually Disqualify or Requalify a Supplier</td>
<td>132</td>
</tr>
<tr>
<td>Event Internal Notes</td>
<td>133</td>
</tr>
<tr>
<td>Add Internal Notes to an Event</td>
<td>134</td>
</tr>
<tr>
<td>Exports and Imports</td>
<td>134</td>
</tr>
<tr>
<td>Event Q&amp;A Board</td>
<td>135</td>
</tr>
<tr>
<td>Manage the Q &amp; A Board on an Event</td>
<td>136</td>
</tr>
<tr>
<td>Event Approvals</td>
<td>139</td>
</tr>
<tr>
<td>Award Notifications</td>
<td>140</td>
</tr>
<tr>
<td>Send Award Notifications</td>
<td>144</td>
</tr>
<tr>
<td>Multi-Stage Events</td>
<td>145</td>
</tr>
<tr>
<td>Add an Event Stage</td>
<td>149</td>
</tr>
<tr>
<td>Event Amendments</td>
<td>152</td>
</tr>
<tr>
<td>Amend an Event</td>
<td>153</td>
</tr>
<tr>
<td>Canceling an Event</td>
<td>154</td>
</tr>
<tr>
<td>Cancel an Event</td>
<td>154</td>
</tr>
<tr>
<td>Withdrawing Events</td>
<td>154</td>
</tr>
<tr>
<td>Withdraw an Event</td>
<td>155</td>
</tr>
<tr>
<td>Closing Events Early</td>
<td>155</td>
</tr>
<tr>
<td>Extending Events</td>
<td>156</td>
</tr>
<tr>
<td>Extend an Event</td>
<td>156</td>
</tr>
<tr>
<td>Reopening an Event</td>
<td>157</td>
</tr>
<tr>
<td>Reopen an Event</td>
<td>157</td>
</tr>
<tr>
<td>Archiving an Event</td>
<td>158</td>
</tr>
<tr>
<td>Archive an Event</td>
<td>158</td>
</tr>
<tr>
<td>Export Event Information</td>
<td>159</td>
</tr>
<tr>
<td>Export Event PDF</td>
<td>161</td>
</tr>
<tr>
<td>Event History</td>
<td>163</td>
</tr>
<tr>
<td>View and Export Event History</td>
<td>165</td>
</tr>
<tr>
<td>Event Search</td>
<td>167</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Event Search Results</td>
<td>168</td>
</tr>
<tr>
<td>Search for an Event</td>
<td>169</td>
</tr>
<tr>
<td>Event Search Exports</td>
<td>171</td>
</tr>
<tr>
<td>Export Event Search Results</td>
<td>172</td>
</tr>
<tr>
<td>Events and Requisitions</td>
<td>173</td>
</tr>
<tr>
<td>Create Cart / Requisition from Sourcing Event</td>
<td>175</td>
</tr>
<tr>
<td>Create Sourcing Event from Requisition Line Items</td>
<td>176</td>
</tr>
<tr>
<td>SUPPLIER RESPONSE AND EVALUATIONS</td>
<td>178</td>
</tr>
<tr>
<td>SUPPLIER RESPONSES AND EVENT EVALUATIONS</td>
<td>178</td>
</tr>
<tr>
<td>UPDATING SUPPLIER PROFILES THROUGH EVENT RESPONSES</td>
<td>178</td>
</tr>
<tr>
<td>Supplier Responses Page</td>
<td>179</td>
</tr>
<tr>
<td>Specific Supplier Response Pages</td>
<td>181</td>
</tr>
<tr>
<td>Panel Questionnaire Responses</td>
<td>182</td>
</tr>
<tr>
<td>Complete a Panel Questionnaire</td>
<td>186</td>
</tr>
<tr>
<td>Export / Import My Questionnaire</td>
<td>187</td>
</tr>
<tr>
<td>Export / Import A Questionnaire on a Panelist Behalf</td>
<td>189</td>
</tr>
<tr>
<td>EVENT EVALUATIONS</td>
<td>191</td>
</tr>
<tr>
<td>Evaluations Overview</td>
<td>191</td>
</tr>
<tr>
<td>Evaluation Actions</td>
<td>192</td>
</tr>
<tr>
<td>Evaluate Supplier Responses</td>
<td>198</td>
</tr>
<tr>
<td>Review Panel Questionnaire Responses</td>
<td>199</td>
</tr>
<tr>
<td>View Evaluations Page</td>
<td>200</td>
</tr>
<tr>
<td>Export All Responses for an Event</td>
<td>201</td>
</tr>
<tr>
<td>Export a Saved Scenario for an Event</td>
<td>202</td>
</tr>
<tr>
<td>Return to Evaluator</td>
<td>203</td>
</tr>
<tr>
<td>Split Award Options</td>
<td>203</td>
</tr>
<tr>
<td>Evaluation Workflow</td>
<td>206</td>
</tr>
<tr>
<td>PROXY BID RESPONSES</td>
<td>208</td>
</tr>
<tr>
<td>Respond to an Event via Proxy Bid</td>
<td>208</td>
</tr>
<tr>
<td>Responding to an Event via Proxy Bid</td>
<td>211</td>
</tr>
<tr>
<td>Initiating Contracts For Awarded Events</td>
<td>218</td>
</tr>
<tr>
<td>Initiate Contract Director Contract from Sourcing</td>
<td>220</td>
</tr>
<tr>
<td>Initiating Contracts+ Contracts For Awarded Events</td>
<td>221</td>
</tr>
</tbody>
</table>
SOURCING REPORTS

Supplier Award Summary .................................................................................................................. 237
View the Supplier Award Summary Report .................................................................................... 238
Benchmarking via SmartProcure ................................................................................................... 240
Cost Savings Reports ....................................................................................................................... 240
View the Cost Savings Summary and Detail Reports .................................................................... 242
Cycle Time Summary Report .......................................................................................................... 245
View the Cycle Time Summary Report ........................................................................................... 246

SOURCING ADMINISTRATION AND SETUP .................................................................................. 248

TEMPLATES AND LIBRARIES ........................................................................................................ 264
Managing Libraries .......................................................................................................................... 266
Add a New Library ............................................................................................................................ 267
Edit an Existing Library .................................................................................................................... 272
Libraries - Descriptions .................................................................................................................... 272
Add/Edit Library Descriptions ......................................................................................................... 273
Libraries - Prerequisites ....................................................................................................................... 273
Add/Edit Library Prerequisites ......................................................................................................... 274
Libraries - Attachments ..................................................................................................................... 276
Add/Edit Library Attachments ......................................................................................................... 276
Libraries - Questions ......................................................................................................................... 277
Add/Edit Library Questions .............................................................................................................. 278
Libraries - Additional Item Fields ..................................................................................................... 281
Add/Edit Additional Item Fields in the Library ............................................................................... 282
Libraries - Items ............................................................................................................................... 285
Add/Edit Library Items ...................................................................................................................... 286
Using Library Elements in Events ................................................................................................... 292
Managing Templates ......................................................................................................................... 293
Add a New Template .......................................................................................................................... 293
Welcome

Objectives

The purpose of this handbook is to familiarize administrators and users with the functionality available in the JAGGAER ONE Sourcing solution. It will help you:

- Understand general administrative tasks such as user management, supplier communication and system reporting. In addition, this handbook will help you configure items such as email templates and supplier/end-user questions that are available in the Sourcing solution.

- Understand administrative tasks related to Sourcing such as work groups, event management, commodity code management and Diversity classification configuration.

- Understand how both internal users and suppliers can use the application to enter, track and analyze supplier information.

- Guide suppliers in how to respond to events.

Key Points

This handbook will show you how to perform functions for the Sourcing solution. It is important to note that much of the how, when, and why the system is used is determined by your organization’s business practices. We suggest that you supplement this document with your organization’s business practices, goals, and policies.

It is important to note that some administrators may only have permissions to perform a subset of the administrative functions. We recommend that each organization has at least one administrator with full rights to the system.
Basics

Sourcing Overview

What is Sourcing?

When beginning a major purchase or work group, buyers require a significant amount of information from potential suppliers. For many, this is a manual process involving a large amount of paperwork and the mailing or faxing of forms and background information. Automated responses simplify the process, enabling easier distribution of response opportunities and details, along with rapid follow-up communication when needed.

Sourcing is the process of automating those responses.

Core Functionality and Process Flow

The JAGGAER ONE sourcing solution is an on-demand bid management solution that helps you achieve significant process efficiencies and cost savings over traditional bid processes. Sourcing enables you to:

- Increase savings from your sourcing processes by sourcing more often and more effectively
- Automate your entire bid process from start to finish
- Increase the accuracy of supplier responses and match to complex award criteria
- Gain efficiencies in processing time - move from weeks to days

Manage RFX Processes from Simple to Complex

Sourcing provides a single platform for managing traditional sourcing activities such as sealed bids, requests for quote and invitations to bid. Purchasing agents are able to use a number of different methods (e.g. templates, copying previous events or uploading lists of bulk items) in order to expedite the event creation process. Once a buyer has created specifications for a bid, suppliers are invited and the customer can monitor the progress of those responses.

Online Supplier Registration and Supplier Portal

Suppliers can register for system access, view events, enter responses and manage their own profiles.
Two Way Event Communication

You can monitor open events in real time to determine which suppliers have viewed a specific opportunity, which are currently working on responses, and which have actually submitted responses. You can view suppliers by name, commodity or special classifications. Throughout the process, you can easily create and issue event amendments, answer supplier questions and respond to one or all suppliers at once.

Analyze & Award Events

Sourcing offers a variety of ways to evaluate responses from the event process. Use a side-by-side view for comparisons or generate spreadsheets to share with evaluators.

A Sourcing Event Process
Work Groups and Events

In Sourcing, you will configure Work Groups that are the larger 'buckets' of work that need to be done. Work Groups may include an office remodeling, building a new facility, upgrading computers, or ongoing maintenance work.

Events are the individual types of work that need to be done within a work group. For example, with the office remodeling, you may have an event for the painting, an event for the cubicles to be installed, and an event for the electrical work.

For both work groups and events, you will configure how users may interact with the work group and/or event.

Inviting Suppliers

For each Sourcing Event, you will invite suppliers to respond. The supplier response may be in the form of bids or information. You will configure the requirements for the supplier response.

You may configure your organization to only invite suppliers who exist in the JAGGAER database, or you may allow users to manually invite suppliers with no current supplier record in the database. You may also search for suppliers by NAICS code. An event may also be configured to force supplier invitations based on the commodity codes on an event. An appropriate contact must exist or be provided for the supplier. It may be a supplier with whom you have never done business before, or a supplier that does not yet have a Supplier Network Portal. Through the response to the sourcing event, a supplier without a portal will register for a Supplier Network Portal.

Notifications

You may choose to enable notifications for certain Sourcing activities taking place in your organization through the application.

Notification preferences can be set at the role or user level. You can choose to receive an email, an in-application notification, both, or none. See Setting Notification Preferences in the User Profile in the Site Basics Handbook or online searchable help and Managing Roles in the online searchable help for additional information.

Sourcing notifications are found in the following Notification Preferences sections:

- **Sourcing Director** - Contains notifications related specifically to sourcing activities (supplier intent, sourcing events, panel questionnaires, etc.).
- **Shopping, Carts & Requisitions** - Contains notifications related to shopping cart and requisition activities (cart assigned, requisition submitted into workflow, cart rejected or returned, etc.)
- **Catalog Management** - Contains notifications related to catalog management (PunchOut status changed, submission import error, price file approved or rejected, etc.)
- **Form Request** - Contains notifications related to form request workflow (form request approved, form request rejected, etc.)
- **Administration and Integration** - Contains notifications related to administration and integration (workflow step errors, import/export, etc.).

For a description of a notification, click the 🔄 associated with the notification, as shown below.
Sourcing Definitions

Following are definitions of common terms used in the Sourcing solution.

Close Date

The Close Date is the date / time when the bidding period ends and suppliers can no longer submit a response.

Contacts

Contacts on an Event are users who a supplier may contact for additional information. The supplier will see the contact information when viewing the event.

Estimated Value

The customer may indicate a total estimated value for an event. Workflow may also be configured based on this value. If the organization does not typically use this information, the field can be hidden on all events via field management.

Event Creator

An Event Creator can create new events for a work group and assign users to the event. An Event Creator cannot edit or view events created by other Event Creators of the work group (unless the user is also an Event Manager). A user must have the Create Events With Templates, Create/Own Events, or Manage work group Events permission to be assigned as an Event Creator.

Event Manager

An Event Manager can create, view and edit all events created within the work group. A user must have the Manage work group Events permission to be assigned as an Event Manager.

Event Owner

An Event Owner has full control over the event. An Event Owner can be inherited as an Event Manager on a work group, or can be explicitly set for the event.
**Event Price Viewers**

When Confidential Pricing is set to **Optional** for an event, only users added to the **Event Price Viewers** access group of an event are able to view the estimated price, target price, historic prices, minimum, maximum, supplier prices, and for Reverse Auctions, the reserve price and bid decrement for that event. All other users will see the word **Confidential** anywhere a price would be displayed. Only users with event access such as a Stakeholder or Event Owner are eligible to be added to the **Event Price Viewers** access group.

**Event Type**

An **Event Type** is a type of Sourcing Method, or the name of what event methodology you will use. This could be an auction, a request for proposal, a request for information, etc. With an event type, you will control what sections of an event are included for the different methods. See **Event Types**, on page 35 for additional information.

**Library**

A **Library** is compilation of different components of the event, such as the description, questions or items, that can be reused in events. These can be used to populate both the event, as well as panel questionnaires. They can also be commodity specific: as you will have different questions for a food event vs. a construction event. See **Templates and Libraries**, on page 264 for additional information.

**Manually Invited Supplier**

A manually invited supplier is one who has been invited to an event but for whom no record exists in the database currently. This allows organizations to invite new suppliers that do not currently exist in the database, without creating a record for the supplier if they do not respond. The supplier is given a link to respond by registering for a portal. Once the supplier responds by registering for a portal, a record is created for the supplier in the database, and they are in the system with a supplier profile. They can then respond to the event.

**Notification Recipients**

If buyer notification restriction has been enabled, either at the work group level or system wide, events will include an access group called Notification Recipients. Only users added as notification recipients will be eligible to receive system-generated event notifications for events administered with this control option. The Event Creator and Event Managers are equipped to manage the Notification Recipients access group.
**Open Date**

The Open Date is the date / time when suppliers can begin responding to the Sourcing event.

**work group Administrator**

A **work group Administrator** can create child work groups and assign access to child work groups. A **work group Administrator** can also edit the existing work groups where they have been assigned to the work group Administrator access group.

A user must have the Administer Work Groups permission or the Sourcing Configuration permission to be assigned as a work group Administrator.

**work group**

A **work group** is a hierarchical structure to segregate your event content. It can either mimic your organization’s hierarchy or be driven by a commodity hierarchy. The work group structure can be used to control access to events as well as event features (public vs. not, allowing alternate items vs not).

**Proxy Bid**

A proxy bid is when the customer enters a bid response on behalf of a supplier, using responses provided by the supplier via mail, email or phone. This is used when a supplier may not have or desire access to a supplier portal. A user must be an Event Owner with either Create/Own Events or Manage work group Events permission, and also have Create Proxy Bid in order to enter responses on behalf of the supplier.

**Release Date**

The Release Date is optional for an event, and is the date when invitations are sent to suppliers. Suppliers will be able to view the event in their portal, but cannot submit responses until the event is Open.

**Sealed Bids**

An event that uses sealed bids will not show the supplier bid response until the sealed bid open date passes. If the customer is entering a proxy bid for a sealed bid event, the sealed bid open date must pass before entering a proxy response. The events that use sealed bids will be indicated with an envelope icon in event search results.
**Stakeholder**

A Stakeholder has view access to all events in the work group. A user must have one of the sourcing permissions related to events to be assigned as a Stakeholder: View Events, Create/Own Events, Manage work group Events, Approve/Reject Sourcing Event, or Finalize Award Scenario.

**Template and Library Manager**

Template and Library Manager can create new libraries with associations to one or more work groups and one or more event types. The library creator is able to control which work groups can make use of which libraries and on which event types in those work groups. A user must have the Create Templates and Libraries permission in order to be added as a Template and Library Manager.

**Template**

A **Template** is the way you will implement your method of sourcing. You may have multiple RFP templates, depending on what you buy and where you buy. For example, regulatory constraints may drive some of the prerequisites. These control the structure of the event and what “sections” (prerequisites, questions, items, attachments etc.) are going to be available to the event creator. Templates are used in creating events of the same method, so you don’t have to manually enter information for each event. See **Managing Templates**, on page 293 for additional information.
Events

Events are the heart of the Sourcing solution. The functions you perform in nearly every other area of the application support the events you create and manage in the Events area. Depending on your access, you create, view, update, copy, and delete existing events in this area. You can also add attachments to events and invite suppliers to participate in events.

Sourcing Events Home

The Sourcing Events Home page provides quick access to key tasks and activities related to the administration of sourcing events from one location. A default sourcing events dashboard is supplied by JAGGAER, but organizations can create their own versions and replace it.

Default Sourcing Events Home Page

The default dashboard on the Sourcing Events Home page is provided by JAGGAER and allows you to view a summary of event information in a graphic format, perform an event search, use quick links, and view events with key event dates occurring in the previous or next seven days. What you see on the Sourcing Events Home page may be different if your organization has customized the dashboard.

Customizing the Sourcing Events Home Page

Organizations can create custom versions of the Sourcing Events Home page and make them available to users who have access to the page. Organizations can define what information is displayed on a custom dashboard by adding or removing widgets.

Users with appropriate permissions can create custom dashboards by clicking the Configure This Dashboard link on the Sourcing Events Home page. See Configurable Dashboards in the Site Basics Handbook or online searchable help for details.

Event Overview

The pages and options that show for an event depend on the associated work group and Event Type. Options will also depend on your organization’s configuration for the components that are allowed as part of each event, such as being available on a Public Site, or allowing for auto scoring options.

The following image shows an event in Draft status on the Event Setup page. Note: Some options, such as Respond by Proxy, Sealed Bid and Public Site, will only show if your organization and work group are configured to allow them on events.
1. **Sourcing Event Identification.** You will see the name of the event, event number, event type and event status. If the event has multiple stages, the stage name will show with a link to View Event Stages.

2. **Settings and Content.** This section displays the detail section of the event. Sections configured for the event type display. A green checkmark indicates required elements of the section are completed. A number indicates the number of items/documents in the section. **Note:** Sections vary according to the event type. Not all sections or settings will show on every event.

   a. **Setup** - The Event Setup page contains the basic information such as event name, type, associated work group, commodity codes, specific bid and public site settings, and dates. See *Event Setup*, on page 50.

   b. **Users** - The Users page shows the users assigned to the event as Creator, Owners, Contacts and Stakeholders. Users are inherited from the associated work group, but may be edited on the specific event. A user with appropriate permissions can make edits to assigned users. If Confidential Pricing is enabled, users can also be assigned to the event as Event Price Viewers. See *Event Users*, on page 58.

   c. **Description** - The Description page contains the basic description of the event that is shown to suppliers. For multi-stage events, a Stage Description is also available. See *Event Description*, on page 62.

   d. **Prerequisites** - The Prerequisites page contains any information and/or documents you want the supplier to review as part of responding to the event. See *Event Prerequisites*, on page 63.

   e. **Buyer Attachments** - This page is used to include attachments, such as a diagram or additional information, that would be helpful to the supplier. See *Event Attachments*, on page 65.

   f. **Supplier Attachments** - You may include this page to allow suppliers to add attachments to supplement their bid response. See *Event Supplier Attachments*, on page 67.

   g. **Questions** - You may ask specific questions related to the event. You will configure the type of response such as a Yes/No selection, text box, file upload, etc. See *Event Questions*, on page 67.

   h. **Additional Item Fields** - You may create up to 20 additional item fields to collect additional information from suppliers. See *Additional Item Fields*, on page 89.

   i. **Items** - If the event is for specific products or services, you may list out the items on this page. See *Event Items*, on page 73.
j. **Suppliers** - This page is where you will add suppliers to the event or see what suppliers have been invited to respond to the event. See Event Suppliers, on page 99.

k. **Review and Submit** - For draft events, this page shows the status of all the event detail pages and alerts the user if required information is not completed. If all required information for the event is satisfied, the user will see a button to Submit for Approval. See Event Review and Submit, on page 106.

3. **Evaluations.** This section of the event displays sections to use as tools in evaluating supplier responses.

   a. **Supplier Responses** - You will see this page when the event has Closed and is Under Evaluation. See Supplier Responses Page, on page 179 for more information.

   b. **Auto Score** - If you enabled this option for the event or event line items, you can click here to configure the Auto Score values for supplier responses. See Auto Score Values for Events and Event Line Items, on page 113 for more information.

   c. **Cost Analysis** - If you enabled this option for the event or event line items, you can click here to configure the Cost Analysis values for the supplier responses. See Cost Analysis Values for Events and Event Line Items, on page 118 for more information.

   d. **Evaluation Calculation Options** - Select what evaluation options to include. This option is most helpful when the event has multiple stages, and you would like to use certain scoring options for specific stages. See Evaluation Calculation Options, on page 122 for more information.

4. **Panel Questionnaire.** In this section you will set up the panel questionnaire to be used in evaluating supplier responses. You will configure the panelists, questions, weights and suppliers, and select to publish the questionnaire at the appropriate time. See Panel Questionnaires for Events, on page 107 and Panel Questionnaire Responses for more information.

5. **Tools.** In this section of the event, you can add Internal Notes for the event, view exports and imports from the event, manage the Q&A board, and see the approval workflow. You can also review award notifications if you have them configured for events.

   a. **Internal Notes** - Users can add internal notes to the event that are seen only by organization users, and not by suppliers.

   b. **Exports and Imports** - Any exports or imports from the Questions or Items pages will show here.

   c. **Q&A Board** - This interactive Question & Answer board is available for customers to see questions from suppliers, respond to those questions, and also to include their own questions to be answered by suppliers.
d. **Approvals** - This page shows the approval workflow the event either will enter or is in currently, depending on the event status.

e. **Award Notifications** - If your organization has award notifications enabled, you will have the option to select a template, customize the email, and send to suppliers from this page. You may also choose to add a comment to an awarded event PDF that is shown for public events.

6. **Page Details.** For the selected page, the details for the page appear (and may be edited, if applicable) here.

7. **Event Actions.** Select the Event Actions drop-down to see options depending on your permissions and the Event status. Event Owners and Evaluators are able to toggle the hiding and showing of prices from the Event Actions dropdown menu on events by selecting **Hide Event Prices**.

8. **Event History.** Select to see the audit log for the event.

9. Once an event is Released, a banner message displays with the event information, and **Workflow Actions** are available, such as to Withdraw or Amend the Event, or to Close it early.

---

**Event Types**

Sourcing allows you to create three out-of-the-box event types: **Request for Information (RFI)**, **Request for Proposal (RFP)**, **Request for Quotation (RFQ)**, as well as any additional types custom designed in Configuration to meet your business needs. The information below contains a description of each predefined type. **Note:** Not all organizations will implement all event types. Contact your System Administrator for information about which event types your organization is using.

The following are standard types of events:

**Request for Information (RFI)** - An RFI is used to gather initial information such as product brochures, specification sheets, or other details that may help your organization weigh options and develop a more detailed sourcing activity. For example, a buyer working to purchase vehicles for an organization’s fleet might request that several automobile dealerships provide general information on various models of cars they sell. Collecting this initial information might help the buyer outline detailed specifications for a formal bidding process. An RFI may not include a request for pricing on specific items, and the information collected generally is not used as the basis for a final purchasing decision.

**Request for Proposal (RFP)** - An RFP outlines a problem or need that your organization must address, and asks bidders to provide formal proposals on how they can meet the need. While an RFP may request pricing on specific items, some elements of the proposal may be left to the discretion of potential suppliers. In addition to the proposal, an RFP typically requests or requires suppliers to upload detailed information about their history, capabilities and references.
Request for Quotation (RFQ) - An RFQ is intended to gather final pricing proposals, usually based on detailed specifications that are outlined in the event details. The end goal of an RFQ is to compare quotes and award a bid. Ideally, the information in the results of the RFQ should have enough detail to transfer directly into a contract if needed. An example of an RFQ would be to ask a select group of car dealerships for final pricing based on buying 50 blue mid-sized sedans with GPS navigation, cloth seating, V6 engines, front wheel drive, and automatic transmissions.

Custom Events - You may design custom events for your organization. On the Manage Event Types page, click the link to Create New and follow the steps in the wizard to set an Event Type and appropriate configurations.

Configuring Reverse Auction Event Types

Both standard and custom event types can be configured as auction event types. Select Yes for the Configure as an Auction? option to make an event type an auction event type.

When Yes is selected, the fields available on the event type About tab will change. Select Standard English Reverse from the Auction Type dropdown.

The Auction Settings step is also added to the list of Event Creation Wizard steps.

Limit User Access to Event Types

Organizations are able to decide whether or not all event creators can use any active event types during event creation.

To activate this feature, a user with the Sourcing Configuration permission navigates to General Sourcing Settings and changes Restricted User Access to Optional. This will make a tab called User Access available on each event type. From this tab, a user is then able to activate Control Event Creation. The user can then add the specific users or groups of users that will be allowed to use the event type during event creation.

Configuring Elements in Event Types

As you create or edit Event Types, you are given the opportunity to customize which sections show for the defined Event Type.

The Event Setup page contains the basic information such as event name, type, associated work group, sealed bid and public site settings, and dates. Users are able to hide all or part of the following Setup sub-sections: Commodity Codes, Payment, Bid and Evaluation, Display and Communication, and Dates while the event is in Draft status.

All events contain the following sections:
- **Users** - The Users page allows you to configure what users will have what type of access for the event. See Event Users, on page 58.

- **Description** - The Description page contains the basic description of the event that is shown to suppliers. See Event Description, on page 62.

- **Suppliers** - This page is where you will add suppliers to the event or see what suppliers have been invited to respond to the event. See Event Suppliers, on page 99.

- **Review and Submit** - For draft events, this page shows the status of all the event detail pages and alerts the user if required information is not completed. If all required information for the event is satisfied, the user will see a button to Submit for Approval. See Event Review and Submit, on page 106.

You may configure other elements to be included for certain event types:

- **Auction Settings** - If your organization has Sourcing - Auctions and your event is an auction, the Auction Settings page is used to set basic information about your auction. See Auction Settings, on page 60.

- **Prerequisites** - The Prerequisites page contains any information and/or documents you want the supplier to review as part of responding to the event. See Event Prerequisites, on page 63.

- **Buyer Attachments** - This page is used to include attachments, such as a diagram or additional information, that would be helpful to the supplier. See Event Attachments, on page 65.

- **Supplier Attachments** - You may include this page to allow suppliers to add attachments to supplement their bid response. See Event Supplier Attachments, on page 67.

- **Questions** - You may ask specific questions related to the event. You will configure the type of response such as a Yes/No selection, text box, file upload, etc. See Event Questions, on page 67.

- **Additional Item Fields** - You may create up to 20 additional item fields to collect additional information from suppliers. You may ask specific questions regarding individual products and services being bid on by suppliers responding to the event and configure the type of response, such as a Yes/No selection, text box, file upload, etc. See Additional Item Fields, on page 89.

- **Items** - If the event is for specific products or services, you may list out the items on this page. See Event Items, on page 73.

**Event Creation**

From the Sourcing menu navigation, you can select Sourcing Events > Create New Event to open the Add Sourcing Event wizard that will guide you through the process of creating a new sourcing event. Through the event wizard you will give the event a title, select a work group, select a template (if appropriate), and select an event type.
You will then complete all the appropriate event details for that type of event. These options allow you to add or manage other elements of the event. You may configure the different elements directly for the event, or use elements that are available in Libraries to which you have access. The options displayed will depend on your permissions. Available actions on the event are:

- Enter basic event Setup information.
- Add event Users. See Event Users, on page 58.
- An event Description. See Event Description, on page 62.
- Event Prerequisites. See Event Prerequisites, on page 63.
- Add Attachments. See Event Attachments, on page 65.
- Provide a section for a supplier to include attachments. See Event Supplier Attachments, on page 67.
- Include Questions and Items, as appropriate (in the UI or via an import file). See Event Questions, on page 67.
- Add additional item fields. See Event Questions, on page 67.
- Invite suppliers. See Event Suppliers, on page 99.
• Enable and configure a panel questionnaire, auto scoring, cost analysis criteria and evaluation calculation options to use during the evaluation of responses. See Panel Questionnaires for Events, on page 107, Auto Score Values for Events and Event Line Items, on page 113, Cost Analysis Values for Events and Event Line Items, on page 118 and Evaluation Calculation Options, on page 122.

• Include Internal Notes or Attachments to the event. See Event Internal Notes, on page 133.

• View exports and imports of questions and items for the event. See Exports and Imports, on page 134.

• Monitor questions from suppliers and provide responses either privately or publicly. See Event Q and A Board, on page 135.

• See the approvals process the event and evaluation will pass or has passed through. See Event Approvals, on page 139.

• Send Award Notifications to suppliers. See Award Notifications, on page 140.

• Extend an event (if it is open or released). See Extending Events, on page 156.

• Reopen a closed event. See Reopening an Event, on page 157.

• Withdraw an event. See Withdrawing Events, on page 1.

• Archive events. See Archiving an Event, on page 158.

• Export an event, or portions of the event, as a PDF file. See Export Event Information, on page 159.

• Create a cart or requisition from an awarded event (for organizations with eProcurement). See Events and Requisitions, on page 173.

At any time before the event closes, you may make changes to the event. You also have the ability to delete the event while it is in draft status.

Required permissions

WHAT PERMISSIONS OR ACCESS DO I NEED TO CREATE AN EVENT?

In order to create an event, you must be listed as an Event Manager or an Event Creator within a work group. If you are not listed as an Event Manager or Event Creator, you will see a message upon selecting to Create New Event, indicating you must contact your Site Administrator.

You must have the permission to Create/Own Events or Manage work group Events in order to be added as an Event Creator. You must have the Manage work group Events permission to be added as an Event Manager.
WHAT PERMISSIONS OR ACCESS DO I NEED TO ONLY SEE EVENTS (NOT CREATE OR EDIT EVENTS)?

In order to have view only access to events, you must be listed as a Stakeholder to a work group or a specific event. As a Stakeholder on a work group, the user will have access to view all events associated with the work group. As a Stakeholder for a specific event, the user will have view access to that event only.

In order to be added as a Stakeholder, you must have one of the following Sourcing Permissions: View Events, Create/Own Events, Manage work group Events, Approve/Reject Sourcing Events, Finalize Award Scenarios.

Create an Event

When creating an event, the options that are present by default may differ depending on the type of event and/or work group selected.

Step-by-Step

1. You may navigate to create a new event by any of the following ways:
   a. Navigate to Sourcing > Sourcing Events > Create New Event.
   b. From the Manage Templates page, select the Edit button for a published event to which you have work group access, and select Create Event From Template. For more information on templates, see the Managing Templates, on page 293 section. In this case, many of the information will be populated with template information.

2. Enter an Event Title such as "Supply of Fleet Vehicles" or "RFI for Procurement of Safety Cameras."

3. Select a work group. You may search work groups to view selections.

4. Click Next.

5. Select an Event Type.

6. If you would like to use a template to create the sourcing event, select a Template.

7. If you have more than once currency listed in your profile, select your Currency.

8. Select any, or all, business units for which an event is being created via the Identify Related Business Units field on. The field is only exposed to users who have access to more than one business unit within an organization.
   - For users with multiple business unit access, who have a business unit assignment designated within their user profile, the Identify Related Business Units field will
be populated, by default, with that user’s profile business unit assignment. The user will then be able to add-to or change that assignment as desired.

9. Click **Create Sourcing Event** button in order to complete additional event details.
10. The Event has been created, and is in **Draft** status. Additional details may be added.

**Update an Event**

Users may edit an event in Draft Status. A user must be an Event Owner or Event Manager for the event in order to edit the event. In order to update an event that is open or released, you must select to Amend the event.

**Step-by-Step**

The goal of this task is to update a draft event.

1. Search for an Event and select the appropriate Event Number from search results.
2. Note that the Event Type, work group, and currency cannot be edited.
3. Edit values for the event as appropriate.
4. On each page, click **Save Progress** to save your changes.
5. Changes are captured in the audit log for the event, available by selecting the **History** hyperlink for the event.

**Copy an Event**

If an existing event has many of the characteristics needed for a new event, you may select to **Copy an Event** to save the manual entry of many of the event specifics.

**Step-by-Step**

The goal of this task is to copy an event.

1. Navigate select an event to **Sourcing > Sourcing Events > Search Events**.
2. Select an Event.
3. At the top right of the event, select the drop-down button **Event Actions**, and select **Copy**.
4. The Copy Sourcing Event wizard displays.
   a. Edit the Event Title for the copied event.
   b. Select a different Event Type, if appropriate.
   c. Select a work group for the event.
   d. Select the Copy button.
5. The copied event is now in Draft status.
6. Edit the Event Title, Event Number, and any other criteria for the event as appropriate. Select each section of the event to make changes.
7. Click to Save Progress, or select Next to proceed to the next page.
8. When edits are completed for the event, select Submit for Approval on the Review and Submit page.

Delete an Event

An event may be deleted if it is in a Draft status, the user has the appropriate permission, and is an Event Owner for the event.

Step-by-Step

The goal of this task is to delete a draft event.

1. Search for an Event and select the appropriate Event Number from search results.
2. From the Event Actions drop-down, select Delete.
3. A confirmation message shows with the question: Are you sure you want to delete this event. Select Yes.
4. The page is refreshed and user is returned to the Sourcing Events Home page. The event has been deleted.

Hide Event Prices

Event Owners and Evaluators are able to toggle the hiding and showing of prices from the Event Actions dropdown menu on events.

When the event prices are hidden, they are hidden for all users, and users see the words Event Prices Hidden in place of prices.
Step-by-Step

The goal of this task is to hide event prices.

1. Navigate to an event in any status.
2. When viewing an event, select Event Actions, then Hide Event Prices.
3. Prices are hidden for all users, and users see the word Event Prices Hidden in place of prices.
4. To show event prices again, select Event Actions, then Show Event Prices.

Event Setup

On the Event Setup page, you will define the basics of the event such as Event Title, Event Number, Commodity Codes, Payment Terms, Dates, and more.

Configure the Event Setup when you Create an Event, or you may edit the Event Setup page while the Event is in Draft status. Some fields, such as Estimated Value and Payment Terms, may be hidden by an administrator via Field Management. Required fields are indicated with a star (★).

Note that not all settings show or are configurable for the event, depending on the organization, event type, and work group settings.

- Event information - You may edit the Event title at any time. The event type and work group cannot be changed once the event is created, and are shown as read-only. Select to edit the event number, if appropriate. If your organization/work group is configured to allow multi-stage events, you may enter a Stage title. Whether or not the stage is internal will display as read-only. You may also select to associate Commodity Codes with the Sourcing Event by selecting the Edit button and choosing from your organization's configured commodity codes.

- Custom Data - Depending on custom field configuration for the event, additional fields may appear below the event information section on the Setup page, or as separate pages listed under the Setup page. Complete these fields as needed.

- Commodity Codes - You may associate commodity codes with the event for reporting, workflow and evaluation purposes.
  - Select Edit to enter a Reporting Commodity Code and Additional Commodity Codes, as appropriate. If any items have commodity codes associated, you will see them displayed as Item Commodity Codes.
  - Select if you would like Forced Supplier Invitation by Commodity Code enabled, which will automatically add suppliers to the event if their supplier profile commodity code matches any of the commodity codes on the event.
• If your organization does not use commodity codes or you otherwise do not want these fields to show, you can hide them via Field Management. See Field Management in the online searchable help for more information.

• **Payment information** - The selected currency will show as the currency for items. You may optionally list an estimated value for the event, and select from your organization's sourcing payment terms. If you do not utilize Estimated Value or Payment Terms, the fields may be hidden for all events via field management.

• **Bid and Evaluation settings** - Depending on the organization and work group settings, you may see some configurations as read-only. For settings that are Optional for the work group, you may select whether or not to allow the feature for the event:
  
  • **Sealed Bid**: Indicate if the event will use sealed bids.
  
  • **Respond by Proxy**: Indicate if proxy bids will be allowed for the event.
  
  • **Use Panel Questionnaire**: Indicate if a panel questionnaire should be configured for the event, as a tool for evaluating supplier responses. If enabled, a Panel Questionnaire section will show in the event navigation.
  
  • **Auto Score**: Indicate if auto scoring should be used for the event or event line items, as a tool for evaluating supplier responses. If enabled, an Auto Score subsection will show under the Evaluations section of the event navigation. You will also have the option to **Default all questions to use Auto Score** (applies to event questions) and **Apply Auto Score at the individual line level** (applies to event line items). The **Apply Auto Score at the individual line level** option allows organizations to request information about individual products and services being bid on by suppliers responding to the event. If enabled, auto score values need to be configured on Additional Item Fields.
  
  • **Cost Analysis**: Indicate if cost analysis should be used for the event and event line items, as a tool for evaluating supplier responses. If enabled, a Cost Analysis subsection will show under the Evaluations section of the event navigation. You will also have the option to **Default all questions to use Cost Analysis** (applies to event questions) and **Apply Cost Analysis at the individual line level** (applies to event line items). The **Apply Cost Analysis at the individual line level** option allows organizations to apply cost analysis to individual products and services being bid on by suppliers responding to the event. If enabled, additional fields are displayed and used to set maximum cost adjustment and bid threshold limits. If this option is selected, cost adjustments need to be configured on Additional Item Fields.
  
  • **Alternate Items**: Indicate if alternate items will be allowed. If Yes, additional configuration is available upon adding items.
  
  • **Allow Split Item Quantity in Evaluations**: Select if you would like the option to split the item quantity awarded among different suppliers on the event. See **Split Award Options**, on page 203 for additional details.
- **Enforce Minimum Price**: Indicates if minimum prices will be set for items on the event. If enabled, a Minimum Price field will appear on the Add Item pop-up to set the minimum price for the item.

- **Enforce Maximum Price**: Indicates if maximum prices will be set for items on the event. If enabled, a Maximum Price field will appear on the Add Item pop-up to set the maximum price for the item.

- **Confidential Pricing**: When Confidential Pricing is enabled on the General Sourcing Settings page, this setting displays on the Setup page of an event. If enabled, this option adds a new access group, Event Price Viewers, to the Users section of the event.

- **Display and communication settings** - If the organization is configured to use a Public Site to display sourcing events, this setting will show. Depending on the work group setting, you may see the configuration as read only, or you may have the option to select Yes or No. If enabled, the Public Event Short Description will appear, where you can enter up to 200 characters describing the event.

- **Dates** - Select from the available time zones for your organization, then select the dates and times for the event.
  - **Time Zone** - Select the appropriate time zone for the event.
  - **Release Date** - The date/time that suppliers can view some information about the event. They cannot yet view details or respond to the event.
  - **Open Date** - The date/time the suppliers can begin responding to the event.
  - **Close Date** - The date/time the event closes for responses.
  - **Sealed Bid Open Date** - If the event is configured to use Sealed Bids, select if the date/time that you may open sealed bids is the same as close date. If not, select a different date. You may also select if you want to show the sealed bid open date to the supplier.
  - **Q&A Submission Close Date** - Select the date/time that you would like to prevent suppliers from submitting questions in the Q&A section for the event. You may select the date to be the same as the event close date.

### Event Setup

**Step-by-Step**

1. An **Event Number** is listed based on your organization configuration. Click on the edit icon to modify the Event Number.
2. If events in this work group are configured to allow multiple stages, you may enter a **Stage Title**. If you are not sure if the event will require multiple stages, you may leave this field blank until the next stage is created.

3. In the **Commodity Codes** section, associate commodity codes utilized by your organization:
   
   a. Select a **Reporting Commodity Code** that is used for reporting purposes. Select the **Edit** button and choose from your organization's commodity codes. Only one reporting commodity code may be selected.
   
   b. Select **Additional Commodity Codes** to associate with the event. Select the **Edit** button and choose from the organization's commodity codes. Multiple codes may be selected.
   
   c. If any commodity codes are associated with individual items, **Item Commodity Codes** are displayed as read only in this section.
   
   d. Selected if the event should have ** Forced Supplier Invitation by Commodity Code**. If **Yes** is selected, suppliers with commodity codes in their supplier profile that match to any of the event commodity codes will automatically be sent an invitation to the event.

4. In the **Payment** section:
   
   a. The **currency** for the event is displayed. This is not editable.
   
   b. Enter an **Estimated Value** for the event (if displayed). This field is optional.
   
   c. Select from the available **Payment Terms** (if displayed) configured by your organization.

5. In the **Bid and Evaluation** section, view or edit options that are configured at the organization and/or work group level. Not all options will be configurable.
   
   a. View or edit the **Sealed Bid** option.
      
      i. If your organization and work group are configured to allow Sealed Bids as an option for specific events, you will select **Yes** or **No**. If you select **Yes**, you will configure Sealed Bid date options in the Dates section for the event.
      
      ii. If your organization or work group is configured to make all events use the Sealed Bid process, you will see a read-only value of **Yes** and this value cannot be changed for the event. You will configure Sealed Bid date options in the Dates section for the event.
      
      iii. If your organization or work group is configured to not use the Sealed Bid process on any events, you will see a read-only value of **No** and this value cannot be changed for the event.
b. Respond by Proxy

i. If your organization and work group are configured to allow Proxy Bids as an option for specific events, you will select **Yes** or **No**. If you select **Yes**, you will have the opportunity to designate the suppliers for proxy bids on the Suppliers page.

ii. If your organization or work group is configured to allow all events to use Proxy Bids, you will see a read-only value of **Yes** and this value cannot be changed for the event. You will have the opportunity to designate the suppliers for proxy bids on the Suppliers page.

iii. If your organization or work group is configured to not use Proxy Bids for any events, you will see a read-only value of **No** and this value cannot be changed for the event.

c. View or edit the **Use Panel Questionnaire** option.

i. If the work group is configured to allow Panel Questionnaires as an option for specific events, you will select **Yes** or **No**. If you select **Yes**, a Panel Questionnaire section will display in the event navigation for configuration.

ii. If the work group is configured to allow Panel Questionnaires for specific events, you will see a read-only value of **Yes** and this value cannot be changed for the event. You will have the opportunity to configure a panel questionnaire.

iii. If the work group is configured to not allow a Panel Questionnaire on any events in the work group, you will see a read-only value of **No** and this value cannot be changed for the event.

d. When set as Optional or Allowed at the work group level, an option for **Cost Per Quality Point** will display under the **Bid and Evaluation** section of Event Setup page.

i. **Yes** - If Yes is selected, the system will calculate CPQP for each supplier’s submitted response, using the Total Bid for required items and the average panel questionnaire rating for the supplier.

ii. **No** - CPQP will not be calculated for the event.

e. When set as Optional or Allowed at the work group level, an option for **Best Value** will display under the **Bid and Evaluation** section of Event Setup page:

i. **Yes** - If Yes is selected, you will choose the percentage weight for price versus quantity for the calculation, using the slider.

ii. **No** - Best Value will not be calculated for the event.
f. View or edit the **Auto Score** option.

   i. If the work group is configured to allow Auto Score as an option for specific events, you may select **Yes** or **No**. If Yes is selected, choose where to enable auto-scoring:

      - Select **Default all questions to use Auto Score** to enable auto-scoring for event questions.
      
      - Select **Apply Auto Score at the individual line level** to enable auto-scoring for event line items.

   ii. If the work group is configured to allow all events in the work group to use Auto Score, you will see a read-only value of **Yes**. This value cannot be changed for the event, but you may choose to enable auto-scoring for events or event line items as indicated above.

   iii. If the work group is configured to never use Auto Score for any events in the work group, you will see a read-only value of **No**. This value cannot be changed for the event.

   g. View or edit the **Cost Analysis** option.

   i. If the work group is configured to allow Cost Analysis as an option for specific events, you may select **Yes** or **No**. If Yes is selected, choose where to enable cost analysis:

      - Select **Default all questions to use Cost Analysis** to enable cost analysis for event questions.
      
      - Select **Apply Cost Analysis at the individual line level** to enable cost analysis for event line items. If this checkbox is selected, maximum cost adjustment and bid threshold limits can be defined:

      - **Set maximum Cost Adjustment per line item** - Enter the maximum cost adjustment allowed for product or service-type event line items.

      **Note:** If maximum limits are not defined here, no limits will be applied at either the event level (Questions) or item level (Additional Item Fields). If maximum limits are defined, they are honored at both event and additional item levels.

      - **Products** - Enter the maximum cost adjustment allowed for product-type line items, either by dollar value or percentage amounts.
      
      - **Services** - Enter the maximum cost adjustment allowed for service-type line items either by dollar value or percentage amounts.
• **Apply upper Bid threshold cost adjustment application limits** - Enter upper bid thresholds for cost adjustments in the following fields in dollar amounts. Threshold limits are applied against the total bid value of products or services, and/or against the bid value of a single item within an event:

  - **Product: Single Unit Bid threshold** - Enter the upper bid threshold allowed for a cost adjustment to a single product-type line item on an event.
  - **Product: Total award Bid threshold** - Enter the upper bid threshold allowed for the total of all product-type line items on an event.
  - **Service: Annual Item Bid threshold** - Enter the upper bid threshold allowed for a cost adjustment to a single service-type line item on an event.
  - **Service: Total award Bid threshold** - Enter the upper bid threshold allowed for the total of all service-type line items on an event.

ii. If the work group is configured to allow all events in the work group to use Cost Analysis, you will see a read-only value of Yes. This value cannot be changed for the event, but you may choose where to enable cost analysis for events or event line items as indicated above.

iii. If the work group is configured to never use Cost Analysis for any events in the work group, you will see a read-only value of No. This value cannot be changed for the event.

h. **View or edit the Alternate Items option.**

i. If your organization and work group are configured to allow Alternate Items as an option for specific events, you will select Yes or No. If you select Yes, you will select to allow Alternates for each individual item in the Items section of the event.

ii. If your organization or work group is configured to allow all events to use the Alternate Items, you will see a read-only value of Yes and this value cannot be changed for the event. You will select to allow Alternates for each individual item in the Items section of the event.

iii. If your organization or work group is configured to not allow Alternate Items, you will see a read-only value of No and this value cannot be changed for the event. You will not have the option of allowing alternates for each item.
i. View or edit the **Allow Split Item Quantity in Evaluations** option.

   i. If the work group is configured to Allow Split Item Quantity in Evaluations as an option for specific events, you will select **Yes** or **No**. If you select **Yes**, the event award may be split among multiple suppliers.

   ii. If the work group is configured to Allow Split Item Quantity in Evaluations for all events in the work group, you will see a read-only value of **Yes** and this value cannot be changed for the event. It is optional to actually split item quantities during the evaluation/award process.

   iii. If the work group is configured to not Allow Split Item Quantity in Evaluations for any events in the work group, you will see a read-only value of **No** and this value cannot be changed for the event.

j. View or edit the **Enforce Minimum Price** option.

   i. If the event type includes an items section, you will select **Yes** or **No**. If you select **Yes**, you will be able to set minimum prices for item bids.

k. View or edit the **Enforce Maximum Price** option.

   i. If the event type includes an items section, you will select **Yes** or **No**. If you select **Yes**, you will be able to set maximum prices for item bids.

l. If **Confidential Pricing** is enabled for the event:

   i. Select **Yes** or **No**. Selecting Yes adds a new access group, Event Price Viewers, to the Users section of the event. If you do not want to use Confidential Pricing for the event, select No.

6. In the **Display and Communication** section, view or edit the **Visible to Public** setting.

   a. If your organization is not configured to use the Public Site, you will not see this option.

   b. If your organization or work group is configured to make Public Site visibility optional, you will select **Yes** or **No**. If **Yes** is selected, you will be given the option to add a short description for the public event.

   c. If your organization or work group is configured to make all events visible to the public, you will see a read-only value of **Yes** and this value cannot be changed for the event. You will be given the option to enter a short description for the public event.

   d. If your organization or work group is configured to not make any events visible on the public site, you will see a read-only value of **No** and this value cannot be changed for the event.
7. In the Dates section, you may enter dates directly or select the date picker to select the appropriate date. Times are available in the dropdown next to the date:
   
a. Select the appropriate Time Zone.
   
b. If appropriate, enter a Release Date and time.
   
c. Enter an Open Date and time. The Open Date must be later than the Release Date.
   
d. Enter a Close Date and time. The Close Date must be later than the Open Date.
   
e. If Sealed Bid is being used for the event:
      
i. Select if you want the Sealed Bid Open Date to be the Same as Close Date. If not, uncheck the option and select an appropriate date from the Date picker.
      
ii. Select if you want to Show Sealed Bid Open Date to Supplier.
   
f. Select if you want the Q&A Submission Close Date to be the Same as Close Date. If not, select an appropriate date from the Date picker.

8. Click Save Progress and Next to continue event configuration.

Event Users

After the initial Event Setup, you will configure what users will have what type of access for the event. Some Event Users are inherited from the work group, but users can be added to the specific event as well. Users who are inherited from the work group cannot be removed.

To add users to the specific event, select the Add Users button for the appropriate access group, and choose from users with appropriate permissions for the role.

The access groups are:

- **Event Creator** - An Event Creator can create new events for a work group and assign users to the event. An Event Creator cannot edit or view events created by other Event Creators of the work group (unless the user is also an Event Manager). A user must have the Create Events With Templates, Create/Own Events, or Manage work group Events permission to be assigned as an Event Creator.

- **Event Owners** - An Event Owner has full control over the event. An Event Owner can be inherited as an Event Manager on a work group, or can be explicitly set for the event.

- **Contacts** - Contacts on an Event are users who a supplier may contact for additional information. The supplier will see the contact information when viewing the event.
- **Stakeholders** - A Stakeholder has view access to all events in the work group. A user must have one of the sourcing permissions related to events to be assigned as a Stakeholder: View Events, Create/Own Events, Manage work group Events, Approve/Reject Sourcing Event, or Finalize Award Scenario.

- **Notification Recipients** - If buyer notification restriction has been enabled, either at the work group level or system wide, events will include an access group called Notification Recipients. Only users added as notification recipients will be eligible to receive system-generated event notifications for events administered with this control option. The Event Creator and Event Managers are equipped to manage the Notification Recipients access group.

**Event Users**

The **Event Users** section contains user information from the inherited work group. Inherited users cannot be removed from the specific event.

**Step-by-Step**

1. The Event Creator cannot be edited. You may select to Add Users as Event Owners, Contacts, Stakeholders, or, if confidential pricing is enabled, Event Price Viewers.

   **Note:** When using confidential pricing, only users added to the Event Price Viewers access group of an event are able to view the estimated price, target price, historic prices, minimum, maximum, supplier prices, and for Reverse Auctions, the reserve price and bid decrement for that event. All other users will see the word Confidential anywhere a price would be displayed, including PDF and evaluation exports. Only users with event access such as a Stakeholder or Event Owner are eligible to be added to the Event Price Viewers access group.

2. Click the Add Users button for the type of user.

3. Search for users. Only users with the appropriate permission for the type of role on the event will show. You may select Advanced Search for additional search options.

4. Select the Add User button for each user to be added to the role.

5. When done selecting users, click the Close button.

6. To remove a selected user from a role, click the Remove icon 🗑.

7. When all users have been added or removed, select Save Progress or Next to continue modifying the event.

8. Click Save Progress and Next to continue event configuration.
Event Description

On the Event Description page, you will enter any descriptive text you want the supplier to see about the event. The Description is required, and should give good basic information about the service or products you need.
You may use the formatting tools to format your text, including images and hyperlinks. The description may contain up to 2500 characters.

If the event is a multi-stage event, you may enter a **Stage Description** for the current stage.

**Event Description**

On the **Description** page, enter a summary description of the event, or select to **Copy from Library**.

**Step-by-Step**

1. You can include the specifics of the request, budget parameters, date/time information such as opening and closing date, award date and much more. You may use the formatting bar to add special formatting and styles to your text.

2. Enter a new description using the formatting tools.

3. When selecting **Copy from Library**:
   
   a. You will be prompted to select from libraries associated with the event's work group and event type.
   
   b. Select the library and then select an appropriate description text. The selected description text is pasted into the Description text box.

4. A **Stage Description** is available if the event is one with multiple stages. This is optional for use.

5. When finished adding the **Description**, select the **Save Progress** button, and the **Next** button to continue.

**Event Prerequisites**

You may choose to add Prerequisite information to the event if it is important to you that a supplier reviews information about your company and/or the event prior to proceeding with their response. For example, you may want the supplier to certify they have reviewed your Non-Disclosure Agreement or payment terms.

You can enter text about the prerequisite and select if you want to enter the content of the prerequisite on the page or attach a file with the appropriate information. You will select if it is optional for the supplier to view the prerequisite, if it is required that the supplier certify they have reviewed it prior to viewing the entire event, or prior to submitting a bid. You can customize the provided Certification Text if needed. You may also ask that a supplier upload a file if you provide the directions to do so.
Using the **Actions** drop-down beside each prerequisite, you can choose to edit the prerequisite, download the attachment for the prerequisite, upload a new version of the attachment for the prerequisite, view version history of the attachment, or delete the prerequisite.

Once multiple versions of an attachment have been uploaded, users are able to view those versions through the **Version History** option. Suppliers will see only the latest version of the file attached. Previous versions are not visible to the supplier.

**Event Prerequisites**

**Step-by-Step**

1. On the **Prerequisites** page, click the **Add Prerequisite** button and select **Add New Prerequisite** or **Add from Library**.

2. To **Add New Prerequisite** you will enter information into the **Add Prerequisite** wizard.
   
a. Enter **Instructions to Supplier** to show on the Prerequisites page, to let the supplier know more about the prerequisite.

b. Select how you would like to display your **Prerequisite Content**:
   
i. **Enter text directly (or copy and paste)** - The supplier will see the text directly on the Prerequisites page. If this option is selected, an Edit button shows in order to enter the appropriate text.

   ii. **Attach file** - The supplier will select to open/download the attachment from the Prerequisites page. If this option is selected, a Select File button displays in order to attach the file. The maximum upload file size is 50.0MB. Enter a **Display Name** and any **Comments** for the prerequisite.

   c. Select the **Type** of Prerequisite:
      
i. **Optional** - The supplier is not required to view this prerequisite in order to view or bid on the event.

      ii. **Required to View Event** - The supplier will be required to certify they have reviewed this prerequisite in order to view the event.

      iii. **Required to Enter Bid** - The supplier will be required to certify that they have reviewed this prerequisite in order to bid on the event. They are not required to review the prerequisite simply to view the event details.

   d. Enter **Certification Text**. Default text is provided, but you may edit as appropriate for your organization.
e. Select the option for Supplier Must Also Upload a File if appropriate.
f. Click Save Changes.

3. When selecting Add from Library:
   a. You will be prompted to select from libraries associated with the event's work group and event type.
   b. Select the library and then select an appropriate prerequisite(s). When finished selecting, click Add Selected Prerequisites.
   c. The selected prerequisites are added to the event.

4. You can select to Edit or Delete prerequisites, or continue to add by selecting Add Prerequisite.

5. You can download attachments by selecting Download from the Actions drop-down beside each attachment.

6. You can select to Upload New Version of file prerequisites. This will upload a new version of the prerequisite’s file attachment but will not allow user to edit details of the prerequisite. To edit the prerequisite you have to use Edit. Suppliers will see only the latest version of the file attached, previous versions are not visible to the supplier.
   a. You will be prompted to optionally update the display name and add comments.
   b. Select the new version of the file to be uploaded using the Select File button.

7. You can select to view Version History for prerequisites with multiple versions.

8. When finished adding Prerequisites, select the Save Progress button, and the Next button to continue.

Event Buyer Attachments

You may provide attachments for the event on the Buyer Attachments page. Attachments may be an uploaded file or a URL link. Examples are a building design or layout, detailed specifications related to the event products or service, an addendum for the event, etc.

When you select to Add Attachment, you may then select to add an attachment from the library, or select to add a new attachment to the event.

When adding a new attachment, you will select if the Attachment Type is a File or a Link. If a File, enter a display name for the attachment and upload the file. If you select Link, you can provide a name for the link and enter the URL address. The file and/or link will show to suppliers viewing the event, allowing them to download the file or access URL links.
Using the Actions drop-down beside each attachment, you can choose to edit the attachment properties, download the attachment file, upload a new version of the attachment file, view version history of the attachment file, or delete the attachment.

Once multiple versions of an attachment file have been uploaded, users are able to view those versions through the Version History option. Suppliers will see only the latest version of the file attached. Previous versions are not visible to the supplier.

Buyer Attachments

Step-by-Step

1. On the Buyer Attachments page, click the Add Attachment button and select Add New Attachment or Add from Library.

2. When selecting Add New Attachment, you may select to upload a file or include a link.
   a. If selecting File as the Attachment Type:
      i. Enter a Display Name for the attachment.
      ii. Click the Select file button and select a file to attach.
      iii. Enter Comments for the attachment.
      iv. Click Save Changes.
   b. If selecting Link as the Attachment Type:
      i. Enter an optional Name for the link.
      ii. Provide the URL for the link.
   c. If more than one attachment is listed on the page, you may choose the display order for any new attachments.

3. When selecting Add from Library:
   a. You will be prompted to select from libraries associated with the event’s work group and event type.
   b. Select the library and then select an appropriate attachment(s). When finished selecting, click Add Selected Attachments.
   c. The selected attachments are added to the event.

4. You can select to Edit or Delete the attachment, or continue to add by selecting Add Attachment.
5. You can download attachments by selecting Download from the Actions drop-down beside each attachment.

6. You can select to Upload New Version of buyer attachments. Suppliers will see only the latest version of the file attached, previous versions are not visible to the supplier.
   
   a. You will be prompted to optionally update the display name and add comments.
   
   b. Select the new version of the file to be uploaded using the Select File button.

7. You can select to view Version History for prerequisites with multiple versions.

8. When finished adding Buyer Attachments, select the Save Progress button, and the Next button to continue.

Event Supplier Attachments

Customers may choose to include a section for suppliers to provide attachments to supplement their bid response. There are no requirements for a customer to enter for this section. If included for the Event Type, it is included as part of all events of that type.

There is no configuration needed for this page. It exists for suppliers to provide attachment information they believe is helpful to their bid response.

Suppliers have the option of providing a file attachment or external link with supporting information for their bid response. When viewing a supplier response, buyers may download the file or click the link.

Event Questions

In the Event Questions section, you may enter questions to which the supplier should respond. You may organize questions on pages, and in groups on each page. See a summary of the groups and pages by selecting the Questions option in the event navigation, or navigate to specific pages.

For each question you will indicate if certain information is required. If no information within a question is required, the supplier will see the question but will not be required to submit a response to it in order to respond to the event.

You may also attach a file to the question, if appropriate. If you have configured the event to use Auto Score or Cost Analysis, you will have the option to assign parameters to questions for those configurations. Depending on the response type used, you may also add conditional questions, which will be exposed based on responses to the parent question.

When adding or editing a question, you will enter:
- **Question Text** - Up to 1000 characters. This is the question to which you will expect a supplier response.

- **Response Type** - Select the type of response for the question. If you are asking for a date, select Date. If you want to provide a range of options, select if you want them to be able to select one or many, and in what format. Conditional questions are available to be added to questions using the yes/no, dropdown list (pick one), and multiple choice (pick one) response types. See the **Event Question Response Types** section below for an explanation of all the response types.

- **Supplier Response is Required** - Enable this option if you want to require the supplier to provide an answer to this question in order to submit a bid response for the event. If this is not selected, the question will still show to the supplier, but they will not be required to answer it in order to submit the bid response.

- **Use Response in Auto Score** - This option is displayed if you have configured the event to use Auto Score and if the response type is one of the following: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many), or Date. If selected, scoring values are added to each response in the Response Options section.

- **Use Response in Cost Analysis** - This option is displayed if you have configured the event to use Cost Analysis and if the response type is one of following: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many), or Date. If selected, cost adjustments are added to each response in the Response Options section.

- **Set Disqualifying Response** - This option is displayed if the response type is one of the following: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many), or Date. Enable this option if you want to configure a response that will disqualify a supplier if they select it when answering an event question. If selected, the disqualifying response(s) are selected under Response Options.

- **Response Options** - If you have selected a field type that requires **response options** to be defined, enter each response that can be selected on the field, assign auto-score and cost analysis values, and disqualifying response options.

**Note:** The fields displayed in this section will vary based on the field type. For example, you will see different fields for the Date and Yes/No field types.

You will also see different columns displayed if the Auto Score, Cost Analysis, or Set Disqualifying Response checkboxes have been selected. If the **Use Response in Auto Score** checkbox is selected, a **Score** column is displayed and can be used to assign auto score points to a response option. If the **Use Response in Cost Analysis** checkbox is selected, a **Cost Adjustment** column is displayed and can be used to assign cost adjustment values to a response option. If the **Set Disqualifying**
Event Question Response Types

An Event question may be configured to be any of the following type of responses:

- **Text (Single Line)** - The supplier response is a single line of text, up to 100 characters.

- **Text (Multi-Line)** - The supplier response is text, and is entered into a text box that can accept up to 2000 characters.

- **Numeric Text Box** - The supplier response must be a number. If configured for the event, you may select to use the response in auto scoring or cost analysis.

- **Yes/No** - The supplier response is to select Yes or No for the question. If configured for the event, you may select to use the response in auto scoring or cost analysis. Can have conditional questions added to it.

- **Dropdown List (Pick One)** - You will configure several different values for the supplier response, the supplier will access the options via a dropdown list. The supplier can select one option from the list. If configured for the event, you may select to use the response in auto scoring or cost analysis. Can have conditional questions added to it.

- **Multiple Choice (Pick One)** - You will configure several different values for the supplier response, and the supplier may select only one of the values as a response. The choices are displayed as radio buttons. If configured for the event, you may select to use the response in auto scoring or cost analysis. Can have conditional questions added to it.

- **Multiple Select (Pick Many)** - You will configure several values for the supplier response, and the supplier may select one or more of the values as a response. The choices are displayed as radio buttons. If configured for the event, you may select to use the response in auto scoring or cost analysis.

- **File Upload** - The supplier must upload a file as a response. An example may be asking for a list of references, background about the company, or other information that is in the form of a file.

- **Date** - The supplier response is a date. An example may be when they can begin work. If configured for the event, you may select to use the response in auto scoring or cost analysis.

- **Proforma Contract** - Allows the supplier to include a proforma contract with their response. If this option is selected, the event manager attaches a draft proforma
contract to the question and suppliers bidding on the event download the proforma contract, make additions and changes (redline), then upload the redlined document and send it with their response.

The actions available on the Questions page include:

- **Add or Import** - Add a question page, add a page from a library, import questions or get the import question template.

- **Export Questions** - Export the questions into a file.

The event actions available on each question page include:

- **Page indication**

- **Add or Import** - Add a question page, a question group, add from a library, import or get the import template.

- **Export Questions** - This action will export all questions, not just those on the page.

- **Group information and ability to Manage Group** - Select to add a new question to the group, add questions from library, edit or delete the group.

- **Add Question** - Add a new question or a question from the library to the group.

- **Edit questions** - The Edit dropdown is available on draft events for you to edit or delete the question information.

- **Delete Selected Questions** - A hyperlink that enables you to select and delete multiple questions.

### Exporting and Importing Questions

You may enter questions in the UI, or via an import file. A template is available to enter questions, or you may export questions out of one event to import into another event.

### Event Questions

On the **Questions** page, you may add questions to the event, organized into groups and/or pages. You may add questions, groups and pages via the UI, or via an import file.

### Step-by-Step

1. The page will initially display with a single Group for questions. Select the **Manage Group** hyperlink drop-down to:
a. **Add New Question** - To add a question to this group of questions.

b. **Add Questions from Library** - To add a question from a library associated with the work group.

c. **Edit Group** - To change the name of the Group.

d. **Delete Group** - To remove the group of questions.

2. To add a **new group** for questions, select from the following options:

   a. Select the **Add or Import** button, then select **Add Question Group**. Enter a Page Title, select the position of the page.

   b. Select the **Add or Import** button, then select **Add from Library**, then **Question Group**. Select the library associated with the work group that contains the group, the **Question Page** and **Question Group**, then select **Add Selected Group**.

3. To add a **new page** for questions, select from the following options:

   a. Select the **Add or Import** button, then select **Add Question Page**. Enter a name for the group and select the group position on the page.

   b. Select the **Add or Import** button, then select **Add from Library**, then **Question Page**. Select the library associated with the work group that contains the group, the **Question Page**, and click **Add Selected Page**.

4. You may **add a new question** to a group by selecting the **Add Question** button in the group, and select to **Add New Question**.

   a. Enter the **Question Text**. This is displayed to suppliers.

   b. Select a **Response Type** for the question (the format of the answer). See **Event Questions**, on page 67 for more details on the types of responses.

   c. Indicate if a **Supplier Response is Required**.

   d. If **Auto Response** or **Cost Analysis** is configured for the event, you will see the option to use the question for one or both features. If selected, you will have the option to enter criteria. See the Configure Auto Score Values and Configure Cost Analysis Values for details.

   e. Click the **Set Disqualifying Response** checkbox to configure a response to an event question that, if selected, will disqualify a supplier. If selected, the disqualifying response is selected under Response Options.

   f. Depending on the response type for the question, configure **Response Options** for the field.

   g. Select the **Upload** button if you would like to attach a file to the question.
h. If more than one question is provided, indicate the **Display Order** for the question.

i. Select **Save Changes** to add the question to the group/page.

5. Conditional questions can be added to questions using the yes/no, dropdown list (pick one), and multiple choice (pick one) response types. Conditional questions only appear when suppliers select the value the question is conditional upon.

   a. Click the dropdown arrow on an applicable question and select **Create Conditional Follow Up**. The Add Question overlay displays.

   b. Make a selection in the **Conditional Upon Value** field. Only suppliers who select this value on the parent question will see the conditional question.

   c. Complete the rest of the question creation as normal. Click the **Save Changes** button to save the question and close the Add Question overlay.

6. You may select to **add questions from a library** by:

   a. Select the **Add Question** button, then select **Add Questions from Library**. Select the Library, Page and Group to see a list of questions. Select the appropriate questions, choose the group to display and display order, and click to **Add Selected Questions**.

   b. Click the **Add or Import** button, then select **Add from Library**, then **Individual Questions**. Select the Library, Page and Group to see a list of questions. Select the appropriate questions, choose the group to display and display order, and click to **Add Selected Questions**.

7. You may select to **add questions from Supplier Profile Content** by:

   a. Select the **Add Question** button, then select **Add a Question with Supplier Profile Content**. Click into the **Supplier Profile Field** drop-down to see a list of questions. Select the appropriate question, edit the **Question Text** if necessary, and display order, and click to **Save Changes**.

   b. You can add grouped questions by opening the **Add or Import** drop-down at the top of the **Questions** section and selecting **Add Block Questions with Supplier Profile Content**.

      i. A pop-up box containing a pick-list of the available **Supplier Profile Field** block question choices will appear. After you select a block of questions to include, you can select the **Display Order** in which the block will appear.

      ii. The entire set of fields that are contained in the block of questions will appear onscreen. Use the **Delete Selected Questions** link to remove any irrelevant questions. You can also use the **Edit** option located beside each question to customize the **Question Text** and its required status for the event.
8. You may select to **Edit** or **Delete** individual questions. You can delete multiple questions by selecting the checkbox on the right side of each question and choosing the hyperlink **Delete Selected Question(s)**.

9. When done adding Questions, pages and groups, select the **Save Progress** button, and the **Next** button to continue.

## Event Items

On the Items page, you can add up to 2000 specific product line items and/or service line items associated with the event. Suppliers can then indicate their price for the item and other details such as when they can deliver the item.

You may choose to organize the items in different groups. For example, if you were furnishing conference rooms, you may have a group for "Furnishings" and a group for "Accessories".

### Alternate Items

If the event is configured to allow alternate items, you will select whether or not alternate items will be allowed for each product or service line item you add to the event. If enabled for an item, a supplier will have the opportunity to submit an alternate item in addition to or instead of the specific item you list in the event. The option for Allowing Alternate Items can be configured at the organization, work group, and event level. See **Alternate Items** on page 251 for more information.

## ADDING PRODUCT AND SERVICE ITEMS

**Adding Items**

Select to **Add Product Line Item** or **Add Service Line Item** to complete the information.

- **Required information is indicated with a star (•).**

- **Name:** Enter the name of the product or service. This field is required.

- **Brand:** (optional for Product Line Items only) If the Brand feature is enabled for your organization, type a brand name in the field. The system will check to see if the name matches brands in the system. If there is a match, the name is added to the Brand field. If it does not match, the message **Try Searching Again** is displayed.
- **Description**: Enter an optional description for the item, up to 2500 characters.

- If there is a specific Catalog Number for the product, you may enter it in the **Catalog Number** field.

- Enter the **Quantity** of the item, or choose to make the quantity supplier-controlled.

- Enter a **Unit of Measure** by selecting from the dropdown list. This field is required for product line items, and optional for service items.

- For **Requested Delivery**, you may indicate a specific **Date**, or a number of **Days after award**. This determines if the supplier will provide an actual date for estimated delivery, or a number of days after the award when the delivery is expected. You may enter a date/days after award as information for the supplier.

- You may choose from the following configuration **Options** for each item:
  - **Unit Price Is Required** - Select this option if you want the supplier to be required to provide a price for this item in order to submit a bid response.
  
  - **Estimated Delivery is Required** (product items only) - Select if you want to require the supplier to enter an estimated delivery date or days after the award in order to submit a bid.
  
  - **Alternate Items are Allowed** - If the event is configured to allow alternate items, you may indicate if you will accept alternates for this specific item. If enabled, suppliers will have the ability to submit alternate item information instead of or in addition to the listed item.

- **Commodity Code** - If your organization utilizes commodity codes, you may click the **Edit** button to search for and associate a commodity code with the item.

- You may choose to enter a **Target Price** for the item that can be used during the evaluation process. Suppliers will not see the **Target Price** when viewing the event information.

- You may select to **Attach a File** to provide supporting information about the item.

- **Historical Unit Price** - You may enter a historical unit price for the item. This is referenced in calculating the Cost Savings Report.

- **Ship-To-Address** - If the sourcing event has been created from a requisition, the Ship-To-Address from the requisition is displayed as a read-only field on items populated from the requisition. On additional product line items introduced to the PR-generated event, a blank Ship-To-Field allows buyer users to enter an address.

- **Minimum Price** - If you have chosen to use minimum prices, you may enter a minimum price for the item. If a supplier's bid is less than the set minimum bid amount, the error message "The submitted bid is less than the established minimum price for this item" will display.
• **Maximum Price** - If you have chosen to use maximum prices, you may enter a maximum price for the item. If a supplier's bid is greater than the set maximum bid amount, the error message "The submitted bid is more than the established maximum price for this item" will display.

• If more than one item is listed, the **Display Order** will default new items to be last. You may change the order by selecting from the dropdown list.

• **Additional Item Fields** - Additional item fields may appear as configured on the Additional Items Fields page. See **Additional Item Fields**, on page 89 for more information.

The actions available on the items pages include:

• **Add or Import** - Add an item group, add from a library, import from a previous stage (on multi-stage events), import items or get the import template.

• **Export Items** - This action will export all items.

• **Manage Group** - Select to add a new item to the group, add items from library, edit or delete the group.

• **Add Product Line Item / Add Service Line Item** - Add a new item, an item from a previous stage (on multi-stage events), or an item from the library to the group.

• **Edit items** - The Edit dropdown is available on draft events for you to edit or delete the item information.

• **Delete Selected Items** - A hyperlink that enables you to select and delete multiple items.

**Exporting and Importing Items**

You may enter items in the UI, or via an import file. A template is available to enter items, or you may export items out of one event to import into another event. Refer to **Questions and Items Import/Export**, on page 79 for more information.

**Event Items**

On the **Items** page, you may add product and/or service line items for the supplier's response. You may add items via the UI, or via an import file. **Note**: For import instructions see the Import Items task. For information on exporting items, see the Export Items task.
Step-by-Step

1. The page will initially display with a single Group for items on the Product Line Items and Service Line Items tabs. Select the Manage Group hyperlink drop-down to:
   a. Add New Item - To add an item to this group.
   b. Add Item From Library - To add an item from a library to this group.
   c. Edit Group - To change the name of the Group.
   d. Delete Group - To remove the group of line items.

2. You may also select to Add Group to create a new group for items.

3. Add a new item by selecting the Add New Item from Manager Group, or the Add Product Line Item / Add Service Line Item button.

4. When selecting to add a new item on the Product Line Items page: (Required fields are indicated with an asterisk *)
   a. Enter a Name for the item.
   b. If the Brand feature is enabled for your organization, enter a Brand for the item.
   c. Enter a Description for the item.
   d. Enter a Catalog Number for the item, if known.
   e. Enter a Quantity for the item. Alternatively, you can make the Quantity field a vendor-supplied field using the following checkbox:
      - Make Quantity a Supplier Response Field - Selecting this option allows suppliers to enter an amount in the Quantity field. You will be prevented from entering data in the Quantity field if you make Quantity a supplier response field.
   f. Select a Unit of Measure for the item from the drop-down.
   g. Choose a Requested Delivery option.
      - Select the Date radio button if you would like the supplier to provide a specific date for expected delivery of the item. You may choose to enter a requested delivery date or select a date using the date picker, for the supplier's information.
      - Select the Days after award radio button if you would like the supplier to indicate the number of days after the award that the item can be delivered. You may choose to enter a numeric Days after award value for the supplier's information.
h. Select if a **Unit Price is Required** for this item. If selected, the supplier cannot submit a bid response without entering this information.

i. Select if an **Estimated Delivery Date is Required** for this item. If selected, the supplier cannot submit a bid response without this information.

j. If the event is configured to allow Alternate Items, select if **Alternate Items are Allowed** for this specific item.

k. If you would like to associate a **Commodity Code** with the item, select the **Edit** button and choose from your organization's commodity codes. Only one commodity code may be selected for each item.

l. Enter an optional **Target Price** for the item, used for evaluation. The supplier will not see this value.

m. You may attach a file to the item by selecting **Upload**, entering a title for the file, and selecting the appropriate file to attach.

n. Enter a **Minimum Price** for your item if you are using minimum prices in your event.

o. Enter a **Maximum Price** for your item if you are using maximum prices in your event.

p. Enter a **Historical Unit Price**. This is used to calculate the Cost Savings Report.

q. Click to **Save Changes**.

5. When selecting to add a new item to the **Service Line Items** page: (Required fields are indicated with an asterisk *)

   a. Enter a **Name** for the item.

   b. Enter a **Description** for the service.

   c. Enter a **Quantity** for the service item. Alternatively, you can make the Quantity field a vendor-supplied field using the following checkbox:

      i. **Make Quantity a Supplier Response Field** - Selecting this option allows suppliers to enter an amount in the Quantity field. You will be prevented from entering data in the Quantity field if you make Quantity a supplier response field.

   d. Enter a **Unit of Measure** for the item.

   e. Select a **Requested Delivery** option.

      i. Select the **Date** radio button if you would like the supplier to provide specific start and end dates for service to be provided. You may choose to enter a **Start Date** and **End Date** for the supplier's information.
ii. Select the Days after award radio button if you would like the supplier to indicate the number of days after the award that the service can be provided. You may choose to enter a numeric Days after award value for the supplier's information.

f. Select if a Unit Price is Required for this item. If selected, the supplier cannot submit a bid response without this information.

g. If the event is configured to allow Alternate Items, select if Alternate Items are Allowed for this specific item.

h. If you would like to associate a Commodity Code with the item, select the Edit button and choose from your organization's commodity codes. Only one commodity code may be selected for each item.

i. Enter an optional Target Price for the item, used for evaluation. The supplier will not see this value.

j. You may attach a file to the item by selecting Upload, entering a title for the file, and selecting the appropriate file to attach.

k. Enter a Minimum Price for your item if you are using minimum prices in your event.

l. Enter a Maximum Price for your item if you are using maximum prices in your event.

m. Enter a Historical Unit Price. This is used to calculate the Cost Savings Report.

n. Click to Save Changes.

6. Add a group of items from a library by selecting Add from Library, then Items Group.

7. Add items from a library by selecting one of the following:
   a. Add from Library drop-down, then Individual Items.
   b. Manage Group drop-down, then Add Item from Library.
   c. Add Product/Service Line Item button, then Add Item from Library.
   d. When adding an item from a library, select the Library, then the Line Items Group the items are in. The items will display for selection. When done selecting, select which group they should display in, the display order, and click to Add Selected Items.

8. Add items from a catalog by choosing Add from Catalog in the Add Product Line Item drop-down.
a. Search for the item in the Shop overlay that appears.

b. Enter the quantity of the item to add and click **Add to Document**.

c. When finished, close the screen overlay.

d. In most cases, the supplier associated with the catalog item will also be added to the event. In cases where this does not occur, the supplier can be added manually in the event’s **Suppliers** section.

9. When done entering items, select the **Save Progress** button, and the **Next** button to continue.

**Questions and Items Import/Export**

Customers may need to add a large number of questions or items to an event, library or template. In addition to adding questions and items to the Event individually through the UI, users have the ability to bulk load questions and items into the event via an import file. Also, the questions and items may be exported for review or modification by others in the organization. Templates are available to populate questions or items, or you may use the export format to make changes and re-import. A validation process warns the user of any errors prior to importing data. The import/export feature is available for events, libraries and templates.

**Exporting Questions and Items**

Users may **Export** questions and items on an Event that is in any status. The export feature is available to any user with the ability to access the Event (owner, stakeholder, approver).

- On the **Questions** page of the Event, a button is available to **Export Questions**. On the **Items** page of the Event, a button is available to **Export Items**.

- When requesting an export, you may select to receive an email notification when the export has finished processing.

- The export files are available for download on the **Exports and Imports** page of the Event, located in the **Tools** section.

- The file is generated in .xlsx format, and can be opened in Microsoft Excel.

- The initial sheet in the file contains **instructions** for populating the template and importing responses.

The **Questions Export/Template** contains the same information as is available in the application when manually adding or editing a question:
• Group information.

• A separate worksheet for each Page.

• Question text.

• Indication if response is required.

• Response type for the question (for example, a date, number, text, drop-down list, etc.).

• You may add in criteria and values for auto score and cost analysis options, and indicate disqualifying responses.

• Optional Comments for your information only. This information is not imported into the application.

The **Items Export/Template** contains the following information.

• Group information.

• Worksheet for Product Line Item information including: Name, Brand, Description, Catalog number, Quantity, Unit of Measure, Commodity Code, Target Price, if Alternates are Allowed, Requested Delivery Option with corresponding date or days, an indication if Unit Price and/or Delivery Date is required, Historical Unit Price, and Minimum Price and Maximum Price.

• Worksheet for Service Line Item information including: Name, Description, Quantity, Unit of Measure, Commodity Code, Target Price, if Alternates are Allowed, Requested Delivery Option with corresponding date or days, an indication if Unit Price is required, Historical Unit Price, and Minimum Price and Maximum Price.

• Optional Comments for your information only. This information is not imported into the application.

**Importing Questions and Items**

The **Import** feature is available for Questions and Items if the Event is in **Draft** status, and the user must be an Event Owner. The feature is available for Events in **Pending** status to approvers who have edit access to the event.

• On the **Questions** page and the **Items** page of the Event, users may select the **Import From File** option from the **Add or Import** button. A template is available for questions and items to be populated.

• Upon import, the changes are effective for the questions and items. Any data in the import file overrides all data previously present for the questions and items.

• The user may choose to Export the Questions or Items, make modifications to the file, and re-import the export file with the updates.
• **Note** the following limitations for importing Questions and Items (these limits do not apply to entering Questions and Items in the UI).
  
  • Number of questions in an event – 500
  • Number of pages in an event – 50
  • Number of groups in a page – 25
  • Number of options allowed for drop-down or multiple choice response type questions - 100
  • Maximum number of questions in a page - 100
  • Maximum number of items in an event – 2000
  • Maximum number of groups for item – 25

The export and import features are also available for questions and items in Libraries and Templates. Exports are available for libraries and templates that are Draft or Published. Import is available for libraries and templates in Draft status only. The user must have access to the library or template for the work group. The actions and information for exports and imports are the same as for individual events.

**Export Items for an Event**

Users may export a blank template or current items associated with a Sourcing Event. This allows the user to make changes in bulk to all the items for an event.

**Step-by-Step**

The goal of this task is to export the items / items template for an event in order to make modifications.

1. Search for an Event and select the appropriate Event Number from search results.

2. Navigate to the **Items** page of the event.

3. To **Export Items**:
   
   a. Select the **Export Items** button. An **Export Items** overlay displays.
   
   b. Enter a **Description** for the export request.
   
   c. Select if you want to receive an **Email When Export Is Ready** or not. Depending on the selection for the **Sourcing - Exports** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this export request. Select the **What's This** hyperlink in the overlay for more inform-
ation.

d. Click Submit.

4. To get the **Items Template**:
   a. Select the **Add or Import** button, then select **Import from File > Get Template**. A **Get Template** overlay displays.
   b. Enter a **Description** for the requested template.
   c. Click **Submit**.

5. A confirmation displays that the request has been submitted, and the user is navigated to the **Exports and Imports** page under the **Tools** section of the event.

6. The requested file status will display. You may select to **Refresh this Page** until the status is **Completed**. Download and open the file to review. Best practice is to save the file to your computer/network.

7. Click the **Delete** link for the file if you would like to remove it from the page.

**Edit and Import Items for an Event**

Users may edit an export file or blank template for items associated with a Sourcing Event, and import the updated file to the event. This allows the user to make changes in bulk to all the items for an event. Up to 2000 items may exist for an event.

**Note:** The **Import** feature is available for Questions and Items if the Event is in **Draft** status, and the user must be an Event Owner. The feature is available for Events in **Pending** status to approvers who have edit access to the event.

**Step-by-Step**

The goal of this task is to edit the Items export or template, and import the file to the event in order to update the items associated with the event.

**Prepare the file**

1. Open the items Export file or Items Template for the event. See the Export Items task.
2. Select the **Enable Editing** button in the spreadsheet.
3. Review and follow the instructions on the **Import Instructions** page of the file.
4. Worksheets show for Product Line Items and Service Line Items.
5. Add a new group by select **Group** as the **Type** on the appropriate worksheet, and entering the group title in the **Name** column. To edit a group, simply edit the **Name**.
6. To add a new item to **Product Line Items**:
   a. On the **Product Line Items** worksheet, select the value **Item** from the options in the **Type** column.
   b. Enter a **Name** for the item.
   c. (optional) If enabled for your organization, type a **name** in the **Brand** field. This must be a brand loaded in your system.
   d. (optional) Enter a **Description** for the item, up to 2500 characters.
   e. If there is a specific **Catalog Number** for the product, you may enter it in this field.
   f. Enter the **Quantity** of the item needed.
   g. Enter a **Unit of Measure** by selecting from the dropdown list.
   h. **Commodity Code** - If your organization uses commodity codes, select the appropriate value to associate with the item from the dropdown list.
   i. You may choose to enter a **Target Price** for the item, to be used during the evaluation.
   j. **Alternates Allowed?** - If the event is configured to allow alternate items, select **Yes** if you will accept alternates for this particular item. If you do not want to accept alternates for this item, leave the value as **No**.
   k. For **Requested Delivery Option**:
      i. Choose **Date** if you would like the supplier to enter a specific Date for estimated delivery. You may enter a specific **Requested Delivery Date** value.
      ii. Choose **Days** if you would like the supplier to provide a number of days after the award when the item will be delivered. You may also enter a value for **Requested Delivery Days**. This is the number of days after the award that you would like delivery of the item.
   l. **Unit Price Required?** - If the supplier must submit a price for this item, select **Yes**.
   m. **Delivery Date Required?** - If the supplier must provide a Requested Delivery Date or Requested Delivery Days value, select **Yes**.
   n. **Historical Unit Price** - Optionally, enter a Historical Unit Price. This is used to calculate the Cost Savings Report.
   o. **Minimum Price** - If the event is using minimum item prices, enter the minimum bid price.
p. **Maximum Price** - If the event is using maximum item prices, enter the maximum bid price.

q. Enter optional **Comments** for the item. These are in the file only, and not added to the item information.

7. To add a new item to **Service Line Items**:

a. On the **Service Line Items** worksheet, select the value **Item** from the options in the **Type** column.

b. Enter a **Name** for the item.

c. Enter an optional **Description** for the item, up to 2500 characters.

d. Enter the **Quantity** of the item needed.

e. Enter a **Unit of Measure** by selecting from the dropdown list.

f. **Commodity Code** - If your organization uses commodity codes, select the appropriate value to associate with the item from the dropdown list.

g. You may choose to enter a **Target Price** for the item, to be used during the evaluation.

h. **Alternates Allowed?** - If the event is configured to allow alternate items, select **Yes** if you will accept alternates for this particular item. If you do not want to accept alternates for this item, leave the value as **No**.

i. For **Requested Delivery Option**:

   i. Choose **Date** if you would like the supplier to enter specific start and end dates for the service to be provided. You may enter specific **Requested Start Date** and **Requested End Date** values.

   ii. Choose **Days** if you would like the supplier to provide a number of days after the award when the service will be delivered. You may also enter a value for **Requested Delivery Days**. This is the number of days after the award that you would like delivery of the service item.

j. **Unit Price Required?** - If the supplier must submit a price for this item, select **Yes**.

k. **Historical Unit Price** - Optionally, enter a Historical Unit Price. This is used to calculate the Cost Savings Report.

l. **Minimum Price** - If the event is using minimum item prices, enter the minimum bid price.

m. **Maximum Price** - If the event is using maximum item prices, enter the maximum bid price.
n. Enter optional **Comments** for the item. This are in the file only, and not added to the item information.

8. When all items have been entered, save the file in **.xls** or **.xlsx** format. Note that the information in the file will completely replace any items information currently in the event.

**Validate / Import the file**

1. Search for an Event and select the appropriate Event Number from search results.

2. Navigate to the **Items** page of the event.

3. Select the **Add or Import** button, then **Import from File > Import**. An **Import Items** overlay displays.

   a. Select an **Import Action. Import** is the default action, and will import the items into the event if there are no errors in the file. You may choose to **Validate** only, which will simply check the file for errors and will not import the file.

   b. Browse and select a **File Name**.

   c. Enter an optional **Description** for the import.

   d. Select if you want to receive an **Email When Import Is Ready** or not. Depending on the selection for the **Sourcing - Imports** or **Sourcing - Validate** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this request. Select the **What's This** hyperlink in the overlay for more information.

   e. Click **Submit** to import (or validate) the file.

   f. A confirmation displays, reminding the user that the file information will replace all existing data in this section of the sourcing event. Click **Yes** to confirm.

5. A confirmation message display that the items have been submitted for import, and the user is navigated to the **Exports and Imports** page under the **Tools** section of the event.

6. The requested file status will display. You may select to **Refresh this Page** until the status is **Completed**. If there are any errors, you may download and open the file to review. If there are no errors, you will simply see the request completed.

7. Once the request completes the import process, you may view the updated items in the **Items** section of the event.

8. Event **History** captures new and edited items.
Export Questions from Event

Users may export a blank template or current questions associated with a Sourcing Event. This allows the user to make changes in bulk to all the questions for an event.

**Step-by-Step**

The goal of this task is to export the questions / questions template for an event in order to make modifications.

1. Search for an Event and select the appropriate Event Number from search results.
2. Navigate to the Questions page of the event.
3. To Export Questions:
   a. Select the Export Questions button. An Export Questions overlay displays.
   b. Enter a Description for the export request.
   c. Select if you want to receive an Email When Export Is Ready or not. Depending on the selection for the Sourcing - Exports Notification Preference in your user profile, Yes or No will be selected for you, but can be changed for this export request. Select the What's This hyperlink in the overlay for more information.
   d. Click Submit.
4. To get the Questions Template:
   a. Select the Add or Import button, then select Import from File > Get Template. A Get Template overlay displays.
   b. Enter a Description for the requested template.
   c. Click Submit.
5. A confirmation displays that the request has been submitted, and the user is navigated to the Exports and Imports page under the Tools section of the event.
6. The requested file status will display. You may select to Refresh this Page until the status is Completed. Download and open the file to review. Best practice is to save the file to your computer/network.
7. Click the Delete link for the file if you would like to remove it from the page.
Edit and Import Questions for an Event

Users may edit an export file or blank template for questions associated with a Sourcing Event, and import the updated file to the event. This allows the user to make changes in bulk to all the questions for an event.

**Note:** The Import feature is available for Questions and Items if the Event is in Draft status, and the user must be an Event Owner. The feature is available for Events in Pending status to approvers who have edit access to the event.

**Step-by-Step**

The goal of this task is to edit the Questions export or template, and import the file to the event in order to update the questions associated with the event.

**Prepare the file**

1. Open the questions Export file or Questions Template for the event.
2. Select the Enable Editing button in the spreadsheet.
3. Review and follow the instructions on the Import Instructions page of the file.
4. You may edit the Page Name. For example, instead of "Page: 1", you may enter "Page: Legal Information".
5. Add a new group by selecting Group as the Type on the appropriate page, and entering the group title in the Group Title or Question Text column.
6. To modify a group, edit the group title in the Group Title or Question Text column.
7. To add a new question:
   a. Select the value Question from the options in the Type column.
   b. Enter the question text in the Group Title or Question Text column.
   c. Indicate Yes or No for Response Required for this question. If Yes, a supplier must respond to the question in order to submit a response to the event.
   d. Select the type of response you expect for this question, such as a date, numeric value, option list, etc.
   e. If you selected a response type that involves a list (Dropdown List or Multiple Choice), configure the options below the question.
      i. Select the value Option from the selections in the Type column.
      ii. Enter the option value in the Options Suppliers Can Pick From column.
iii. Continue adding options as appropriate.

f. If the question should use Auto Score or Cost Analysis, you may configure ranges and values along with the score and cost adjustment. You also may designate an option as a disqualifying response for suppliers on appropriate response types. Enter the appropriate values for each row where Option is the Type for the row.

8. When all questions have been entered, save the file in .xls or .xlsx format. Note that the information in the file will completely replace any questions information currently in the event.

**Validate / Import the file**

1. Search for an Event and select the appropriate Event Number from search results.

2. Navigate to the Questions page of the event.

3. Select the **Add or Import** button, then **Import from File > Import**. An **Import Questions** overlay displays.

   a. Select an **Import Action**. **Import** is the default action, and will import the questions into the event if there are no errors in the file. You may choose to **Validate** only, which will simply check the file for errors and will not import the file.

   b. Browse and select a **File Name**.

   c. Enter an optional **Description** for the import.

   d. Select if you want to receive an **Email When Import Is Ready** or not. Depending on the selection for the **Sourcing - Imports** or **Sourcing - Validate** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this request. Select the **What's This** hyperlink in the overlay for more information.

   e. Click **Submit** to import (or validate) the file.

   f. A confirmation displays, reminding the user that the file information will replace all existing data in this section of the sourcing event. Click **Yes** to confirm.

   g. A confirmation message displays that the questions have been submitted for import, and the user is navigated to the **Exports and Imports** page under the **Tools** section of the event.

   h. The requested file status will display. You may select to **Refresh this Page** until the status is **Completed**. If there are any errors, you may download and open the file to review. If there are no errors, you will simply see the request completed.

   i. Once the request completes the import process, you may view the updated questions in the **Questions** section of the event.

   j. Event **History** captures new and edited questions.
Additional Item Fields

Buyers may configure additional fields for product and service items on events. An additional field may be used for internal purposes, or you may make it visible and/or required for suppliers. You can choose to apply the fields to product and/or service items.

The Additional Item Fields wizard is available under Settings and Content on events when at least one item is available for the event. On the Additional Item Fields page, you may create item fields to collect additional information from suppliers on items.

Auto-Score and Cost Analysis Settings on Additional Item Fields

If auto-score and cost analysis settings for event line items have been enabled for the work group and event, auto-score and cost analysis rules can be applied at the line item level, allowing organizations to request information about individual products and services being bid on by suppliers responding to the event. Auto-scoring and cost adjustment values (which are used for cost analysis) are enabled and assigned to response options on additional item fields. The answers provided are included in scenario calculations, so that event administrators can take them into consideration when analyzing results and awarding events.

Here is a summary of how auto score and cost analysis rules are applied to event line items:

- Options on the event Setup page are used to both activate the use of auto-score and cost analysis for event line items and to set maximum cost adjustment and bid threshold limits for cost analysis.

- Auto-scoring and cost adjustment values (which are used for cost analysis) are enabled and assigned to response options on additional item fields. Additional item fields tagged as visible to the supplier will be displayed on event line items in the supplier portal.

- Once the event is open, suppliers enter the requested information in additional item fields when they bid on an item.

- Additional item field values entered by suppliers for an item are displayed in the sourcing event on the Items page of each supplier response.

- Calculated line item auto-score and cost analysis results are displayed on the event Evaluation page, where users can view a breakdown of auto-score and cost analysis calculations. They also have the ability to disallow an applied cost adjustment.

- Libraries, templates, and multi-stage events also accommodate auto-scoring and cost analysis for event line items.
Supplier Disqualification

Administrators creating an event can configure a response to additional item field that, if selected, will disqualify a supplier when they respond to an item-level question. When suppliers participating in the event select the response, they will be automatically disqualified from award consideration when the event closes. Disqualifying response options on additional item fields in event templates and libraries are included when they are copied into an event. See Supplier Disqualification, on page 128 for more information.

Conditional Visibility on Additional Item Fields

Up to three levels of conditional visibility controls can be added to additional item fields so that organizations can define the sequence in which additional item fields are displayed on event line items, or hide fields until they are needed. See Conditional Visibility Controls, on page 98 for more information.

Ship-To-Address

If a sourcing event has been created from a requisition, a read-only Ship-To-Address additional item field is automatically created by the system and displayed on the Additional Item Field page. Clicking View next to the item displays address information from the requisition.

Field Types

An additional item field may be configured to be any of the following type of responses:

- **Text (Single Line)** - The supplier response is a single line of text, up to 100 characters.
- **Text (Multi-Line)** - The supplier response is text, and is entered into a text box that can accept up to 2000 characters.
- **Numeric Text Box** - The supplier response must be a number. If this field type is selected, you may choose to use the response in auto-scoring or cost analysis.
- **Yes/No** - The supplier response is to select Yes or No for the question. If this field type is selected, you may choose to use the response in auto-scoring or cost analysis.
- **Dropdown List (Pick One)** - You will configure several different values for the supplier response, the supplier will access the options via a dropdown list. The supplier can select one option from the list. If this field type is selected, you may choose to use the response in auto-scoring or cost analysis.
- **Multiple Choice (Pick One)** - You will configure several different values for the supplier response, and the supplier may select only one of the values as a response. The
choices are displayed as radio buttons. If this field type is selected, you may choose to use the response in auto-scoring or cost analysis.

- **Multiple Select (Pick Many)** - You will configure several values for the supplier response, and the supplier may select one or more of the values as a response. The choices are displayed as radio buttons. If this field type is selected, you may choose to use the response in auto-scoring or cost analysis.

- **Date** - The supplier response is a date.

**Configure Additional Item Fields for Sourcing Event Items**

Follow the steps below to configure additional item fields for an event. Buyers may configure additional fields for product and service items on events. An additional field may be used for internal purposes, or you may make it visible and/or required for suppliers. You can choose to apply the fields to product and/or service items and also choose to limit a field to specific item group(s). See also Additional Item Fields, on page 89.

**Step-by-Step**

1. Navigate to an event.

2. In the left menu, click **Settings and Content**, then **Additional Item Fields**. The Additional Item Fields page opens.

   **Note:** If the event has been created from a requisition, a read-only Ship-To-Address additional item field created by the system may be displayed on this page. Click **View** next to the item to display address information from the requisition. The address is visible to suppliers participating in the event as a read-only field on the Items page.

3. Choose one of the following options:
   - To **create** an additional item field, click the **Create Additional Field** button and select **Create Additional Field**.
   - To add an additional item field from the library to the event, select **Add Field From Library**.
   - To create a conditional field, click the **Create Additional Field** button and select **Create Conditional Follow Up**, then select the appropriate **additional item field**.
   - To **update** an additional item field, click **Edit** next to the additional item field you want to change.
   - For events that are not in Draft status, click **View** next to an additional item field to display field values in read only mode.
4. If you selected **Create Additional Field**, **Create Conditional Follow Up**, or **Edit**, complete the following fields:

   a. If you are creating a conditional field, select the value from the parent field that will cause the field you are creating to be displayed in the **Conditional Upon Value** field.

   **Note:** This field is only displayed when the **Additional Item Fields > Create Conditional Follow Up** option has been selected.

   b. Enter a **Name** for the field. This is the question you expect a supplier to answer by completing the field.

   c. Enter an optional **Description** for the field.

   d. In the **Applicable To** field, select if the field is applicable to product line items, service line items, or both. If you are creating a conditional field this will be a read-only field that displays what has been selected on the parent field.

   e. In the **Supplier Can Respond** field, select **Yes** or **No** to indicate whether or not suppliers are able to respond to the field. If you are creating a conditional field, choose Yes. Additional checkboxes are displayed depending on your selection:

      - **Visible to supplier** - Displayed if you select **No**. Select to allow suppliers to view the field even when response is disabled. If not selected, only internal users can view and edit the field.

      - **Supplier response is required** - Displayed if you select **Yes**. Select the checkbox to make it mandatory that suppliers complete the field before they can submit a bid.

   f. Select a **Field Type**.

   **Note:** The following field types support auto-scoring, cost analysis, and disqualifying responses: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Choice (Pick Many), Date.

   - **Text (Single Line)** - The supplier response is a single line of text, up to 100 characters.

   - **Text (Multi-Line)** - The supplier response is text, and is entered into a text box that can accept up to 2000 characters.

   - **Numeric Text Box** - The supplier response must be a number.

   - **Yes/No** - The supplier response is to select Yes or No for the question.
• **Dropdown List (Pick One)** - You will configure several different values for the supplier response, the supplier will access the options via a dropdown list. The supplier can select one option from the list.

• **Multiple Choice (Pick One)** - You will configure several different values for the supplier response, and the supplier may select only one of the values as a response. The choices are displayed as radio buttons.

• **Multiple Select (Pick Many)** - You will configure several values for the supplier response, and the supplier may select multiple values as a response. The choices are displayed as checkboxes.

• **Date** - The supplier response is a date.

g. The **Set Disqualifying Response** checkbox is displayed if **Yes** is selected for **Supplier Can Respond** and the appropriate **Field Type** is selected. Enable this option if you want to configure a response to an item-level question that, if selected, will disqualify a supplier. The disqualifying response is defined under Response Options.

h. Select the following checkboxes to configure auto-scoring or cost analysis for the field:

• **Use Response in Auto Score** - Select to use supplier responses to additional item fields for auto-scoring. If selected, scoring values are added to each response in the Response Options section.

• **Use Response in Cost Analysis** - Select to use supplier responses to additional item fields for cost analysis. If selected, cost adjustments are added to each response in the Response Options section.

| Note: These checkboxes are displayed if auto-scoring and cost analysis have been enabled for the event and set to be applied at the individual line level, and the field type chosen supports auto-scoring and cost analysis. |

i. If you have selected a field type that requires **Response Options** to be defined, enter each response that can be selected on the field, assign auto-score and cost analysis values, and identify disqualifying responses.

| Note: The fields displayed in this section will vary based on the field type. For example, you will see different fields for the Date and Yes/No field types. |

You will also see different columns displayed if the Auto Score, Cost Analysis, or Set Disqualifying Response checkboxes have been selected. If the **Use Response in Auto Score** checkbox is selected, a **Score** column is displayed and can be used to assign auto score points to a response option. If the **Use Response in Cost Analysis** checkbox is selected, a **Cost Adjustment** column
is displayed and can be used to assign cost adjustment values to a response option. If the **Set Disqualifying Response** checkbox is selected, a **Disqualify** column is displayed and can be used to select a response that will disqualify a supplier if they select it.

j. If more than one additional item field is provided, indicate the **Display Order** for the field.

k. Click **Save Changes**.

5. If you selected **Add Field From Library**:

a. Select the **library** you would like to add the additional item fields from the drop-down.

b. Click the checkbox beside each additional item field you would like to add.

c. Click the **Show Display Position Options** link and choose a display order for the selected additional item fields.

d. Click **Add Selected Item Fields**. Additional item fields are displayed.

e. (optional) To modify an additional item field, expand the **Edit** menu next to the field and select **Edit**, **Delete**, or **Create Conditional Follow Up**.

f. If the additional item field from the library has the **Use Response in Auto Score** or **Use Response in Cost Analysis** checkboxes selected, click **Edit** to assign auto-score or cost adjustment values to response options.

**Note**: Most settings on additional item fields from event libraries or templates are carried to the sourcing events they are added to; however, if an additional item field from the library has auto-scoring and cost analysis settings, scoring and cost adjustment values on response options must always be configured on the sourcing event.

ASSOCIATE ADDITIONAL LINE ITEMS TO GROUPS

You may assign additional line items to specific item groups within an event. If the additional items have been made visible to suppliers, the additional line items will only appear to suppliers within the item group(s) to which these additional line items are associated.

1. Select the option to **Restrict Item Group Item Association** from the drop-down menu that appears beside an additional line item's drop-down.
2. When this option is selected, the **Restrict Field Application to Targeted Groups** overlay appears. The overlay contains a list of all item groups available within the event.

3. If a custom field has a conditional relationship with other **Item** fields, the related children and grandchildren are automatically restricted to the same group as their parent.

4. Group associations are identified in the following ways:
   - A **Restricted to Groups** column has been added to the **Additional Item Fields** page to identify group associations.
   - Additional Item fields that are not applicable to an item are grayed-out in that item's row in event PDF export and Item export files.

   If import files contain values that is not applicable to items in the file, those values will not be imported.

Configure Conditional Visibility Controls

Conditional visibility controls can be applied to additional item fields such that organizations can make supplier exposure of one field dependent on the response the supplier provided to another field. See **Conditional Visibility Controls**, on page 98 for more information.

Follow the steps below to configure conditional visibility for additional item fields. At least one additional item field must exist before conditional visibility options are displayed.
**Step-by-Step**

1. Navigate to a sourcing event.

2. In the left menu, click **Settings and Content**, then **Additional Item Fields**. The Additional Item Fields page opens.

3. Choose one of the following options:
   - To **create** a conditional field, click the **Create Additional Field** button, select **Create Conditional Follow Up**, then select the **additional item field** whose response will dictate whether the new child field will be exposed, and that will be immediately above the field you are creating in the conditional visibility hierarchy.
   - To apply conditional visibility controls to an existing additional item field, expand the **Edit** menu next to the appropriate additional item field and select **Create Conditional Follow Up**.

   **Note:** The Create Conditional Follow Up option is not available if the field selected is at the grandchild level in a conditional visibility hierarchy.

   - To **update** a conditional field, click **Edit** next to the field you want to change.

   - For events that are not in Draft status, click **View** next to a conditional field to display field values in read only mode.

4. Complete the following fields in the **Create Conditional Field** or **Edit Conditional Field** overlay:
   - **Conditional Upon** - This field is read only and displays the name of the field that is parent to the field you are currently creating (i.e., immediately above it in the hierarchy).
   - **Conditional Upon Value** - Select the value from the parent field that will cause the field you are creating to be displayed.
   - **Name** - Enter the name of the additional item field you are creating. This is the question you expect a supplier to answer by completing the field, for example, "Do you deliver?".
   - **Description** - Enter an optional description for the field.
   - **Applicable To** - This is a read only field populated from the "Applicable To" setting on the parent field. It will display "Product", "Service" or "Both".
   - **Supplier Can Respond** - This must be set to **Yes** to indicate that suppliers are able to respond to the field.
- **Supplier response is required** (optional) - Select the checkbox to make it mandatory that suppliers complete the field before they are able to submit a bid.

- **Field Type** - Select one of the following field types: Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Choice (Pick Many).

  **Note:** The following field types support auto-scoring, cost analysis, and disqualifying responses: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Choice (Pick Many), Date.

- Enable the **Set Disqualifying Response** checkbox if you want to configure a response to an item-level question that, if selected, will disqualify a supplier. The disqualifying response is defined under Response Options.

- Select the following checkboxes to configure auto-scoring or cost analysis for the field:
  - **Use Response in Auto Score** - Select to use supplier responses to additional item fields for auto-scoring. If selected, scoring values are added to each response in the Response Options section.
  - **Use Response in Cost Analysis** - Select to use supplier responses to additional item fields for cost analysis. If selected, cost adjustments are added to each response in the Response Options section.

  **Note:** These checkboxes are displayed if auto-scoring and cost analysis have been enabled for the event and set to be applied at the individual line level, and the field type chosen supports auto-scoring and cost analysis.

- **Response Options** - If you have selected a field type that requires **Response Options** to be defined, enter each response that can be selected for the field, assign auto-score and cost analysis values, and identify disqualifying responses.

  **Note:** The fields displayed in this section will vary based on the field type. For example, you will see different fields for the Date and Yes/No field types.

  You will also see different columns displayed if the Auto Score, Cost Analysis, or Set Disqualifying Response checkboxes have been selected. If the **Use Response in Auto Score** checkbox is selected, a **Score** column is displayed and can be used to assign auto score points to a response option. If the **Use Response in Cost Analysis** checkbox is selected, a **Cost Adjustment** column is displayed and can be used to assign cost adjustment values to a response option. If the **Set Disqualifying Response** checkbox is selected, a **Disqualify** column is displayed and can be used to select a response that will disqualify a supplier if they select it.
- **Display Order** - If more than one additional item field is provided, indicate where the field you are creating appears on the page in this field. At least one additional item field must exist before the Display Order field is visible.

5. Click **Save Changes**.

Additional item fields with their conditional visibility controls will now be available for product and/or service line items, as configured.

### Conditional Visibility Controls

Conditional visibility controls can be added to additional item fields so that organizations can define the sequence in which additional item fields are displayed on event line items, or hide fields until they are needed. They assist suppliers responding to the event as they only see the fields they need to complete, in the order in which they need to complete them. For example, organizations can design a conditional visibility hierarchy where a second field is only displayed if "Yes" is selected as a response in the first field.

### Configuration

- The following types of additional item fields support conditional visibility controls. They also must have the **Supplier Can Respond** radio button set to **Yes**:  
  - Yes/No  
  - Dropdown List (Pick One)  
  - Multiple Choice (Pick One)

- The **Create Conditional Follow Up** option allows users to either create a new additional item field with conditional visibility, or apply conditional visibility settings to an existing additional item field. At least one additional item field must exist before Create Conditional Follow Up is displayed. The option is not available if the field selected is at the grandchild level in a conditional visibility hierarchy.

- A maximum of three levels of conditional visibility controls are supported in one hierarchy (i.e., parent, child, grandchild). An additional item field can only belong to one hierarchy. For example, you cannot use one additional item field for three different conditional visibility hierarchies.

- To keep track of conditional visibility controls, a **Conditional Upon** column on the Additional Item Fields page shows the name of the field that is immediately above it in a conditional visibility hierarchy.

- On a sourcing event, the values entered by suppliers in additional item fields with conditional visibility controls are displayed on the **Items** page of each supplier response.

- When additional item fields on a sourcing event are included in the **Evaluation Actions > Export All Responses** document, conditionality between fields is not included.
• If deleting conditional visibility fields, grandchild and child fields in the hierarchy must be deleted before a parent field can be deleted.

• Conditional visibility settings on additional item fields in event libraries and templates are carried into sourcing events. When adding a set of additional item fields with conditional settings from a library or template to a sourcing event, only the top-level additional item fields (parent) are displayed for selection, but all fields in the hierarchy (child and grandchild) are added to the event.

Event Suppliers

On the Suppliers page, you will search for suppliers to add to your event. In order to invite the supplier, the supplier's profile must contain a corporate or sales contact.

On the Add Suppliers to Event tab, you can search for suppliers by name or ID, contact, postal code, commodity code, or by brand (if it is enabled for your system). You can also choose to search suppliers only in your network, out of network, or all suppliers in the JAGGAER database. You may select to show advanced search options to use additional criteria to identify suppliers. From supplier search results, you will be shown if an appropriate supplier contact (Corporate or Sales) is not present. You can navigate to the supplier's profile to add the appropriate contact information for the supplier if the contact is not present in the profile. If a supplier has a valid contact, select the Add to Event button for each supplier you want to invite to the event. Suppliers added to the event show on the Event Suppliers tab. If you would like to remove a supplier from the list, click the Remove button.

If a supplier contact is not found, users with the appropriate permission may choose to add a contact from this page by clicking Add Contact. If a supplier is not found, you may select to Manually Invite Suppliers if the event is configured for this feature.

On the Add Suppliers From Group tab, you can add all or selected suppliers from groups created in Supplier Management. See the Supplier Groups topic for more information on creating supplier groups. Click the # of Suppliers link beside each group name to view a list of all suppliers in each group. Click the Add All to Event button beside each group to add all suppliers from the group to the event. Click the dropdown arrow beside the Add All to Event button and click Add Selected to Event to open a pop-up where you can select individual supplier contacts from the group. Click Add Selected to add the selected supplier contacts.

When the Event is approved and released, suppliers will receive the Sourcing Supplier Invitation email. This email, and other system emails, are managed in the System Emails menu, available at Administer > Email Management > System Emails. You may edit the email if appropriate. See Email Management for more information on managing system emails for your organization.
Resending Supplier Invitations

Up until the time the event is closed, you may re-invite suppliers who have not responded to the event. Navigate to Evaluations > Supplier Responses and select to Resend Supplier Invite to suppliers who have not responded. When selecting to resend, the invitation will be sent to each of the supplier's contacts added to the event.

Inviting Suppliers Based on Commodity Code

A configuration for Forced Supplier Invitation by Commodity Code is available at the organization, work group and event level. When enabled for an event, a tab showing Suppliers Invited by Commodity Code will display on the Suppliers page in Event Settings and Content. The tab displays suppliers in the customer's network that have a commodity code associated with the supplier profile matching any of the event commodity codes. This includes Reporting and Additional Commodity Codes listed on the Event Setup page, as well as the item level commodity codes.

- A message will display if there are no registered suppliers in your organization's network that match event commodity codes. A message will also display if you have not associated any commodity codes to the event.

- Buyers may add new contacts for the listed suppliers if appropriate.

- If a supplier has an associated Exclude from Sourcing Event supplier class associated, they will not be included automatically in the suppliers invited by commodity code.

You may search for and add other suppliers to the event on the Additional Suppliers tab. The number of unique suppliers invited to the event will show in the left navigation for the Suppliers page.

Event Suppliers

On the Suppliers page, you may add suppliers to the event individually or from supplier group.
Step-by-Step

1. To add suppliers to the event, select the Add Suppliers to Event tab:
   a. Search for the supplier by name, contact, relationship, postal code, commodity code(s), or NAICS code or Brand (if enabled for your organization).

   **Note:** Select the Show Advanced Search hyperlink to see additional search options. Click the icon in the NAICS Code search box to open a list of selectable NAICS codes to search by. If the Brand feature is enabled for your organization, select a value in the Brand supplier search filter to return a list of suppliers that have an indication within their supplier profile that they can source goods available from the identified market brand and may be potential providers of the targeted goods. Click the Search icon to display a list of brands that can be selected.

   b. A Sales or Corporate Contact must be present to invite the supplier to the event.

   c. If a supplier does not exist in the organization's database, users with appropriate permission may choose to Manually Invite Suppliers to the event. Refer to the Manually Invite Suppliers task for details.

   d. As suppliers are invited to the event, they are displayed on the Event Suppliers tab.

2. To add suppliers from group, select the Add Suppliers From Group tab:
   a. Click the Add All to Event button beside each group to add all suppliers from the group to the event.

   b. Click the dropdown arrow beside the Add All to Event button and click Add Selected to Event to open a pop-up where you can select individual suppliers from the group. Click Add Selected to add the selected supplier contacts.

3. If the event is configured to Forced Supplier Invitation by Commodity Code:
   a. Suppliers who will be invited because of a matching Commodity Code to one on the event are listed on the Suppliers Invited by Commodity Code tab.

   b. You may invite other suppliers to the event on the Add Suppliers to Event tab (see step a. above). Suppliers who are added via a user invitation are displayed on the Additional Suppliers tab.

4. On any of the tabs where invited suppliers are listed, if no contact is available or the appropriate contact is not listed:
   a. If you have the Add Supplier Contact permission, you may select to Add Contact for a supplier from the page. You may also update a current contact's information. For more information, see Add Supplier Contacts from Event Suppliers Page, on the next page.
b. If you do not have the Add Supplier Contact permission, you may navigate to the supplier’s profile by selecting the supplier name. Add the appropriate contact information on the Contact tab.

5. When finished adding suppliers, select the Save Progress button, and the Next button to continue.

Add Supplier Contacts from Event Suppliers Page

When creating a sourcing event, suppliers may be invited if a supplier contact exists for the customer. If an appropriate supplier contact is not available, the user may navigate to the supplier’s profile and add the contact. However, if a user has the Add Supplier Contact permission, a user may add a new supplier contact directly from the Suppliers page of the event.

On the Suppliers page of a Sourcing Event, when viewing a list of supplier results on the Add Suppliers to Event tab, users with the appropriate permission will see one or both of the following options:

- **Add to Event** - This button is displayed in the Action column if the supplier has a valid contact displayed. Clicking this button will add the supplier and displayed contact to the Event Suppliers tab.

- **Add Contact** - This button is displayed in the Sales and Corporate Contacts column, at the end of the list of existing contacts for each supplier. It is available for all supplier results. This is the only action available if no contact currently exists for the supplier, or if the listed contact has already been added to the event. This action is available along with the Add to Event action if there is already a contact, but you would like to invite a different supplier contact to the event.

When a user selects Add Contact from the Event Suppliers tab or the supplier results page, they can: select from other current contacts for the supplier, edit current contact information, or select the radio button The contact I am adding is not listed and enter information for the new contact. The contact information is added / updated to the Supplier Profile on the Contacts tab. History for the supplier profile indicates the contact was created/edited.

Note that when contacts are added/edited:

- A new contact is added as a Sales Contact type by default. The user has the option, when creating the new contact, to also make the contact a corporate contact type.

- When an existing contact is added to the event that is not a sales or corporate contact, the system will create a sales contact, using the same information from the existing contact. You will then see two contacts with that information in the supplier profile. One will be the original, and the other will be the newly added sales contact.
Each contact requires a unique email address. Messages will indicate when an email address is in use and direct you to pick a different contact or enter a different email address.

Manually Inviting Suppliers

Many times, customers would like to invite suppliers who are not currently in the supplier master database to participate in a sourcing event. Buyers may invite new suppliers to a sourcing event without creating a record for that supplier until the supplier responds to the invitation. If the supplier never responds, the supplier master database is not polluted with the new supplier information. Customers may add suppliers to the event through the UI, or via an import process.

The organization and the work group must be configured to allow manually inviting suppliers in order for the option to show on the Events page.

- When creating or editing a draft event, the **Manually Invite Suppliers** button shows on the **Add Suppliers to Event** tab of the Suppliers page if the work group setting is **Optional** or **Allow**.

- To add one or more suppliers through the UI, you may select the **Manually Invite Suppliers** button, and select **Add Supplier to Event**. You must provide a **Supplier Name** and **Email** address. You may optionally add a **Sales or Corporate Contact Name**.

Importing Manually Invited Suppliers

To add many suppliers in bulk, an Import template is available that includes instructions for the format and process for uploading the file. The user may select **Get Import Template** to download the file with instructions. Select **Import** to upload a file with the appropriate supplier information for the manual invitations.

- To add many suppliers in bulk, an Import template is available that includes instructions for the format and process for uploading the file. The user may select **Get Import Template** to download the file with instructions.

- The file format consists of a **Supplier Name**, **Email address**, and **Sales or Corporate Contact Name**. The **Supplier Name** and **Email address** are required to import the supplier.

- Select **Import** to upload a file with the appropriate supplier information for the manual invitations.

- The customer user may choose to validate an import file for errors prior to selecting to import. The user may also choose to receive an email when the import is ready.
- Upon import, a confirmation message is presented with the number of suppliers added.
- The import files display on the **Exports and Imports** page of the **Tools** section on the Event.
- If errors occur, a file is generated with error information. The user can make corrections to the error file and re-import.
- Each contact requires a unique email address. When importing suppliers to a sourcing event, contacts found to be duplicates will be removed so that only valid sales and corporate contacts are added to an event. The removed duplicate contacts are not flagged during validation.
- Once added, the manually invited suppliers are shown on the **Event Suppliers** tab along with any other networksuppliers.
  - Manually added suppliers will not show the supplier name as a hyperlink to navigate to the supplier profile.
  - No supplier profile record is created until the supplier responds to the invitation by registering for a portal. Once the supplier responds to the email by selecting to complete a portal registration, a supplier profile record is created and the supplier name will show as a hyperlink.
  - Suppliers who are manually invited will receive an email with instructions to register as a Supplier Portal user, in addition to information about the Sourcing Event.
  - Suppliers who are manually invited and have not responded by registering for a portal are listed with a progress of **Supplier not registered**.

**Manually Invite Suppliers**

Customers may invite suppliers who are not currently in the supplier master database to participate in a sourcing event. A supplier record is not created unless a supplier responds to the invitation. Customers may manually add suppliers to the event through the UI, or via an import process.

The organization and the work group must be configured to allow manually inviting suppliers in order for the option to show on the Events page.

**Step-by-Step**

The goal of this task is to manually invite suppliers to an event.

1. Search for an Event and select the appropriate Event Number from search results.
2. Select the **Suppliers** page of the event. Select the **Add Suppliers to Event** tab.
Adding a Supplier Via the UI:

1. Select the **Manually Invite Suppliers** button, then **Add Supplier to Event**. An overlay displays.

2. Enter a **Supplier Name** (required).

3. Enter an optional **Sales or Corporate Contact Name**.

4. Enter a valid **Email** address (required).

5. Select to **Save** to return to the **Add Suppliers to Event** page. Select **Save and Add Another** to invite additional suppliers.

6. Manually invited suppliers show on the **Event Suppliers** tab without a hyperlink to the supplier profile, since the supplier record is not created unless the supplier responds to the invitation.

Adding a Supplier Via Import:

1. To access the import template:
   
   a. Select the **Manually Invite Suppliers** button, then **Get Import Template**. Select to open or save the file.
   
   b. Click the **Enable Editing** button in the spreadsheet.
   
   c. Review the **Instructions** worksheet in the file.

2. Enter the appropriate information in the **Import Data** worksheet.
   
   a. **Supplier Name** is required.
   
   b. You may enter an optional **Sales or Corporate Contact Name**.
   
   c. A valid **Contact Email** address is required.

---

**Note:** Each contact requires a unique email address. When importing suppliers to a sourcing event, contacts found to be duplicates will be removed so that only valid sales and corporate contacts are added to an event.

3. When all suppliers to manually invite are entered, save the spreadsheet in **.xls** or **.xlsx** format.

4. On the **Add Suppliers to Event** tab of the **Suppliers** page in the event, select **Manually Invite Suppliers** button, then select **Import**. An overlay displays.

   a. Select an **Import Action. Validate** is the default action, which will simply check the file for errors and will not import the file. Select **Import** to import valid supplier rows into the event.
b. Select if you want to receive an **Email When Import Is Ready** or not. Depending on the selection for the Sourcing - Import or Sourcing - Validate Notification Preference in your user profile, Yes or No will be selected for you, but can be changed for this request. Select the **What's This** hyperlink in the overlay for more information.

c. Browse and select a **File Name**.

d. Click Submit to import (or validate) the file.

e. A confirmation message display that the suppliers have been submitted.

f. Navigate to the **Exports and Imports** page of the event under the Tools section of the event. The requested file status will display. You may select to Refresh this Page until the status is Completed. If there are any errors, you may download and open the file to review. Rows without errors are processed.

g. Once the request completes the import process, you may view the updated suppliers on the **Event Suppliers** tab on the Suppliers page. Manually invited suppliers show without a hyperlink to the supplier profile, since the supplier record is not created unless the supplier responds to the invitation.

h. Event **History** captures the suppliers added to the event.

### Event - Review and Submit

Once you have configured Event Details, you will navigate to the **Review and Submit** page to confirm all required information is present and Submit for Approval. If any required items are not completed, such as a date or description, you cannot submit the event for approval. Hyperlinks are available on the actions needed for easy navigation to the appropriate page.

Users with appropriate permissions can view the approval workflow steps based on the current configuration by expanding **View Approval Steps**.

Once you submit the event for approval, it enters Event Workflow and must be approved before it is released to suppliers.

### Event Review and Submit

**Step-by-Step**

1. On the **Review and Submit** page, note if any required items are not completed, and correct as appropriate.

2. Select **View Approval Steps** to see the steps the configured event will pass through in order to be approved for release.
3. When all required items are completed, click **Submit for Approval**.

4. A page displays confirming the event was submitted for approval.

**Panel Questionnaires for Events**

Sourcing clients can choose to incorporate a Panel Questionnaire into an event for use as a tool during the evaluation process. When enabling a panel questionnaire for an event, the event owner indicates what criteria is most important, supplier responses that are most important, and panelists who will complete the questionnaire. The panelists do not have to have permission to edit an event, and will be given a view of the supplier responses and questionnaire according to their permissions and access settings. The use of panel questionnaires is configured at the work group and event level.

When the event is configured to include a panel questionnaire, a section for **Panel Questionnaire** is available in the navigation for the event. Here, you can configure grading and weighting, panelists to add to the event, and questions you want evaluated by the panelists.

The questionnaire is made up of questions/supplier responses from the event, as well as custom questions that the buyer can set up that are only present on the questionnaire. The idea is that each panelist can rate different supplier responses to questions. For example, if the question is “How long is the warranty for this item/work?”, the panelist might rate a 1-year warranty as a 3 out of 5 and a 2-year warranty as a 5.

The Panel Questionnaire is configured in a wizard format. The following sections are available for configuration:

- **Setup** - Here you will **Configure a Rating Scale**, **Point Values**, **Weight** configurations, and a **Questionnaire Close Date**. You may choose to **Anonymize Supplier Information**, which means panelists will not see actual supplier names associated with the bid responses. You can choose to display a **Single Supplier Response** per page, instead of multiple suppliers on the same page.

  - A Rating Scale is a scale of 1 to (n) that the panelist will choose from to rate each question's answer on the panel questionnaire. The top and bottom values in the rating scale require a description. For example 1 = Bad, 5 = Excellent.

  - Point Value is the total number of points that can be earned by a supplier if they were to receive a perfect rating from all panelists.

  - You can assign weights to questions using percentages or points.

  - The Questionnaire Close Date is the date by which the panelists must have submitted their questionnaire responses.
• **Panelists** - Select **Add Panelist** and search for any user who can view an event.
  
  - Once questions are configured, you may choose to assign panelists to specific groups and/or questions. You can make the groups/questions to which they are assigned optional or required in order to submit the panel questionnaire. The panelist page shows the **Assigned Question Group(s)** for each panelist.
  
  - Once the questionnaire is in process, you will see panelist response progress.
  
  - You can also select to remove a panelist, if appropriate.

• **Panel Questions** - You may select from the event questions and include groups and pages. Once in a group, you may also add a question specifically for the panelists. You may configure specific scoring options for each question. You may also add questions from a library, if available. You may also add new questions specifically for the panel questionnaire.

• **Question Weight** - Weights are a breakdown of the how the point value is distributed across all questions. Each question is displayed so that you can enter a total page, group and individual question weight as a percentage or total points, as configured on the Setup page of the questionnaire.

  - If using percentages, questions within a group must equal 100%. If using points, the questions total should equal the total points assigned to the group containing the questions.
  
  - If using percentages, groups on a page must equal 100%. If using points, the group total point value must equal the total points assigned to the page containing the groups.
  
  - If using percentages, the weight of all **Pages** must equal 100%. If using points, the page total point value must equal the total points assigned to the questionnaire.

• **Suppliers** are added from this page, or from the **Supplier Responses** page, once they have responded to the event.

  - On the **Supplier Responses** page, select the appropriate suppliers, and from **Evaluation Actions**, choose **Add Selected to Panel Questionnaire**.
  
  - On the **Suppliers** page of the Panel Questionnaire, select the **Add Supplier** button. Only those suppliers who have submitted a response to the event and are not already present on the questionnaire will display.
  
  - As panelists complete the questionnaire for a supplier, the supplier's rating is displayed on this page. You may also select to remove a supplier from the questionnaire.

• **Review and Complete** - this section displays a summary of your panel questionnaire configurations, and alerts you to any issues that prevent you from publishing. Once
you have completed required information, you may choose to Publish Questionnaire.

After the questionnaire is published, a panel questionnaire administrator can continue to add new panelists and suppliers to the questionnaire. If questions or weights must be changed, however, the questionnaire must be withdrawn to make edits, and republished. The user may choose to extend the questionnaire date without withdrawing the event.

When selecting Withdraw Questionnaire, you will confirm that you want to withdraw the questionnaire from panelist view. Often, this is so you can make changes to the questions or scoring. This may cause some of the panelist responses to be deleted. You may also want to withdraw the questionnaire if you have decided not to utilize it for the event.

Select Close Early if you would like to close the questionnaire from panelist view prior to the configured Questionnaire Close Date. This may be because you have already received all the panelist responses, so there is no reason to leave the questionnaire open.

When selecting Extend Questionnaire, the user is allowed to enter a different close date for the questionnaires, thereby giving the panelists additional time to complete the information.

When selecting to Re-open Questionnaire, the user is allowed to re-open the panel questionnaire and extend the close date to a time appropriate for the participating panelists.

Sourcing Event Advanced Search - Panel Questionnaire

The Sourcing Event Advanced Search option includes a section for Panel Questionnaire criteria. Users may search for sourcing events based on Questionnaire status, the logged-in user’s role as a panelist or not, and for questionnaires they have started or submitted.

Configuring Question Weights

When configuring the weighting for each page, group level, or question, the value you enter depends on the Assign Weights Using option you have chosen for the questionnaire setup:

- **Percentage** - If you have chosen to assign weights using a percentage:
  - Each group of questions must equal 100%. For example, if there are 3 questions in a group, the total weight of those three questions must equal 100%.
  - The total of all groups on a page must equal 100%. This means, if there are 4 groups on a page, the total weight of all the groups must equal 100%. The group total is not a cumulative total of the question weights.
  - The total of all pages must equal 100%. This means if there are 3 pages of questions, the total weight of all pages must equal 100%. The page total is not a cumulative total of the group weights.
• **Points** - If you have chosen to assign weights using Points, then you must distribute the total number of points among all questions on the questionnaire.

  • The questions within a group must equal the total number of points allocated to the group.
  • The groups within a page must equal the total number of points allocated to the page.
  • The pages within a questionnaire must equal the total number of points allocated to the questionnaire.
  • For example, if you allocate 100 points to the questionnaire:

    • The total number of points for pages must add up to 100. For example, if there are 3 pages in the questionnaire, the total weight of those three pages must equal 100. In this example we will allocate 25 points to the first page.

    • Now that we have 25 points allocated to the first page, the total of all groups within Page One must equal 25. This means, if there are 4 groups on the page, the total weight of all the groups must equal 25. For this example we will allocate 10 points to Group One.

    • The total of all questions within a group must equal the total assigned to that group. This means if there are 5 questions in the group, and you have 10 points assigned to the group, you must allocate 10 points among the questions within that group.

Once the questionnaire is published, panelists receive an email to complete the questionnaire. A panelist can complete the questionnaire in the UI or by exporting/importing the questionnaire. A panel administrator can export questionnaires and import questionnaire responses on behalf of panelists.

### Configure Panel Questionnaire

Organizations may include a Panel Questionnaire for an event to be used as a tool during the evaluation process. The use of panel questionnaires is configured at the work group and event level. When the event is configured to include a panel questionnaire, a section for **Panel Questionnaire** is available in the navigation for the event. A best practice is to keep in mind how you will assign panelists to the questionnaire as you configure the questions and groups.

### Step-by-Step

The goal of this task is to configure a Panel Questionnaire for an event.
1. Navigate to an event for which a Panel Questionnaire has been enabled.

2. Select the Panel Questionnaire section in the event navigation. The Panel Questionnaire is configured in a wizard format. The following sections are available for configuration:

3. Configure Setup options:
   a. Enter a Point Value - The total number of points that can be earned by a supplier if they were to receive a perfect rating from all panelists.
   b. Select an option for Assign Weights Using: Points or Percentages. When configuring weights for the questions, you will use the total Point Value if Points is selected, and 100% if Percentage is selected.
   c. Enter a Questionnaire Close Date and time. This is the date by which panelists must submit their questionnaire responses.
   d. Select if you would like to Anonymize Supplier Information, so that panelists will not see actual supplier names associated with the bid responses.
   e. Select if you would like the questionnaire to display a Single Supplier Response Per Page in the UI and in the exported questionnaire file. If not enabled, up to 5 suppliers show on a page in the UI, and all suppliers will show on a single sheet in the exported questionnaire file.
   f. Enter values for the questionnaire Rating Scale, which defines each rating value. You may enter the top and bottom ratings only, if desired. For example, 1 = Bad, 5 = Excellent.

4. Configure Panelists for the event:
   a. Select Add Panelist and search from any user who can view an event in the User Search overlay:
      i. Select the Add Panelist button next to each user in search results who should serve as a panelist for the event.
      ii. When finished adding panelists, click to Close the overlay.
   b. Selected panelists will show on the page. Once the questionnaire is in process, you will see panelist response progress.
   c. Select the Action button next to a panelist to:
      i. Edit Group Assignment to assign a panelist to specific questions or groups of questions to the panelist as optional or required.

Note: Some actions cannot be performed until the event closes and suppliers have responded.
ii. **Remove Panelist** from the questionnaire.

iii. The panelist's **Assigned Question Group** is displayed on the page.

d. View all group assignments by selecting the **Group Assignment Overview** button on the panelist page.

5. Configure **Questions** to include in the questionnaire:

   a. You may select from the event questions and include groups and pages.
   
b. Once in a group, you may also add a manual question.
   
c. Configure specific scoring options for each question.
   
d. You may add questions from a library, if available.
   
e. You may add new questions specifically for the panel questionnaire (that are not included as an event question).

6. Configure **Question Weight**:

   a. Select the appropriate weight for each question. Use the total Point Value configured for the questionnaire, or 100% as a percentage.
   
b. Note that:
      
      i. You can enter weights at the page and group levels, then click the action link called **Auto Assign Question Weights** to have the system allocate individual question weights equally within each group of questions. You can adjust these weight assignments manually as needed.
      
      ii. Questions within a group must equal the total Point Value or 100%.
      
      iii. Groups on a page must equal the total Point Value or 100%.
      
      iv. Pages must equal total Point Value 100%.

7. Add **Suppliers** to be evaluated with the questionnaire. Note that suppliers cannot be added until they have responded to the event. You may add suppliers either of these ways:

   a. On the **Supplier Responses** page, select the appropriate suppliers, and from Evaluation Actions, choose **Add Selected to Panel Questionnaire**; or
   
b. On the **Suppliers** page of the Panel Questionnaire, select the **Add Supplier** button. Only those suppliers who have submitted a response to the event and are not already present on the questionnaire will display.

8. **Review and Publish** - Note any sections of the questionnaire that require attention. Once you have completed required information, you may choose to **Publish Questionnaire**.
9. After the questionnaire is published, a panel questionnaire administrator can continue to add new panelists and suppliers to the questionnaire. If questions or weights must be changed, however, the questionnaire must be withdrawn to make edits, and republished.

   a. Select Withdraw Questionnaire to make the questionnaire a draft form. You may make edits to the configuration and then select to publish.

   b. Select Close Early to close the questionnaire before the configured close date.

   c. Select Extend Questionnaire to change the close date for panelist responses.

   d. Select Reopen Questionnaire from the Event Actions drop-down menu to reopen and extend the close date of a closed panel questionnaire.

10. Manage questionnaire imports and exports as a panelist or panel administrator on the Panel Exports and Imports page.

### Extend or Re-open a Questionnaire

Event managers can re-open a panel questionnaire and extend the close date to ensure all possible input is captured.

**Step-by-Step**

1. Open the sourcing event with the closed panel questionnaire.

2. Select Panel Questionnaire > Setup in the left menu.

3. Expand the Event Actions menu and select Reopen Questionnaire.

4. Enter a new close date and time in the Questionnaire Close Date field.

5. Click Save.

The revised date is displayed in the Questionnaire Close Date field on the panel questionnaire's Setup page and notification is sent to users who have opted into the A Panel Questionnaire has been published notification.

### Auto Score Values for Events and Event Line Items

Auto Score is an additional tool that customers can use to streamline the evaluation process for events. The Auto Score option may be enabled at the work group and event level, allowing customers to assign an 'automatic score' to different supplier responses to event questions and event line items, and use when evaluating supplier responses. When an event is configured to include auto scoring, an Auto Score page is available under the Evaluations section of the event.
If auto scoring is enabled, auto score values are initially assigned to questions in the Questions section of Event Setup, and to additional item fields in the Additional Item Field section.

Questions and additional item fields with auto score enabled are displayed in the Auto Score sub-section of the Evaluations section (see below).

To see how auto score values are used in the evaluation process, see Evaluations, on page 191.

Creating Auto Score Questions

When Auto Score is enabled for an event or additional item field, you will have the option to use the Auto Score options for certain types of questions and additional item fields:

- Numeric Text Box
- Yes/No
- Dropdown List (Pick One)
- Multiple Choice (Pick One)
- Multiple Select (Pick Many)
- Date

When configuring one of these question or additional item field types, options will allow you to choose whether or not you want to include the question or additional line item response in Auto Score. If you select yes, you will define the criteria and values for the auto scoring. If you enable auto scoring for a particular question or additional item field response, you will define criteria as follows:

- **Numeric Text Box** - You will have the option of designating the score for a specific number or a range of numbers.
- **Yes / No** - Designate a score for a Yes answer versus a No answer.
- **Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many)** - Designate a score for each available response option.
- **Date** - Provide a score for specific date ranges.

Evaluating Auto Score Responses

Event questions and additional item fields with auto score enabled are displayed on the Auto Score page under the Evaluations section of the event. It allows event administrators to view or edit auto-score values for both event-level questions and line-level questions. The two types of questions are grouped under the following headings:

- Expand the **Event-Level Questions** heading to see a list of event questions that have been added to the Questions page of the event.
• Expand the **Line-Level Questions** heading to see a list of event line item questions that have been added via Additional Item Fields on the event. These are grouped into **Product** and **Services** categories.

You can expand a question to view or change auto-score assignments, or view a summary of responses to the question:

• An **Edit Question Details** button is displayed when events are in **Draft** status, allowing users with the appropriate permission to change auto-score or cost analysis assignments. The changes are saved to the original event question or additional item field.

• A **View Question Details** button is displayed when events are in any other status (e.g., **Under Evaluation**, **Closed** or **Canceled**). Users can view information about the question, but changes are not allowed.

### Changing Auto-Score Assignments

Line level auto-score assignments can be **amended** from the Evaluations page on released events so that corrections and adjustments can be made:

• If changes do affect supplier responses (such as a change to the questions), the supplier responses for the items affected are discarded.

• If the changes do not affect existing supplier responses (such as a change to the response scoring), then previously submitted supplier responses are not discarded.

• Amendments can't be made to locked items that have been added to an event from locked or protected templates.

### Configure Auto Score Values

The Auto Score option may be enabled at the work group and event level, allowing customers to assign an 'automatic score' to different supplier responses on event questions and event line items, for use in evaluating responses. When an event is configured to include auto scoring, an **Auto Score** page is available under the **Evaluations** section of the event.

If auto scoring is enabled, auto score values are initially assigned to questions in the **Questions** section of Event Setup, and to additional item fields in the **Additional Item Field** section.

Questions and additional item fields with auto score enabled are displayed in the **Auto Score** sub-section of the **Evaluations** section in the event navigation. Auto score values can be edited from this page by clicking the **Edit Question Details** button on a question or additional item. Changes are saved back to the original question or additional item field.
Step-by-Step

**CONFIGURE AUTO SCORES FOR EVENT QUESTIONS**

Follow the steps below to assign auto score values to event questions. This task assumes that questions already exist on a Sourcing Event.

1. Navigate to an event that has Auto Score enabled on the Event Setup, and for which questions exist.
2. Select the Questions page in the Settings and Content section of event navigation.
3. Click Edit next to the question you want to change. Note that Auto Score may only be configured for questions with specific response types.
4. In the Edit Question overlay, select the Use Response in Auto Score checkbox.
5. Depending on the response type for the question, you may now configure a numeric range, date range, or the specific options for suppliers to choose from and assign a score to each of those values. For example,
   a. For a numeric value, you may provide a score for "0 - 10", and a score for "11-20", etc.
   b. For a multi-select list, select each of the options you have available for suppliers and assign a score.
   c. For a date field, you may provide a range of dates with one score, and a different range of dates with another score.
   d. As you add each score, select the green checkmark to add the configuration to the question.
6. When finished adding the auto score values, click Save Changes.

**CONFIGURE AUTO SCORES FOR EVENT LINE ITEMS (ADDITIONAL ITEM FIELDS)**

Follow the steps below to assign auto score values to additional item fields. This task assumes that additional item fields already exist on a sourcing event.

1. Navigate to an event that has Auto Score enabled on the Event Setup, and for which additional item fields exist.
2. Select the Additional Item Fields page in the Settings and Content section of event navigation.
3. Click Edit next to the additional item field you want to change. Note that Auto Score may only be configured for additional item fields with specific response types.
4. In the **Edit Additional Field** overlay, select the **Use Response in Auto Score** checkbox.

5. Depending on the response type for the additional item field question, you may now configure a numeric range, date range, or the specific options for suppliers to choose from and assign a score to each of those values. For example,
   a. For a numeric value, you may provide a score for "0 - 10", and a score for "11-20", etc.
   b. For a multi-select list, select each of the options you have available for suppliers and assign a score.
   c. For a date field, you may provide a range of dates with one score, and a different range of dates with another score.
   d. As you add each score, select the green checkmark to add the configuration to the additional item field.

6. When finished adding the auto score values, click **Save Changes**.

**EDIT ASSIGNED AUTO SCORE VALUES**

**Note:** Changes can't be made to locked items that have been added to an event from locked or protected templates.

1. Navigate to an event that has Auto Score enabled on the Event Setup, and for which the auto score option is enabled for event questions or event line items.

2. Select the **Auto Score** page in the **Evaluations** section of event navigation.

3. Expand the **Event-Level Questions** heading to view event questions with auto score enabled. Expand the **Line-Level Questions** heading to view additional item fields with auto score enabled.

4. Select **Edit Question Details** under the question or additional item field you want to change.

5. Depending on the response type for the question, you may now configure a numeric range, date range, or the specific options for suppliers to choose from and assign a score to each of those values. For example,
   a. For a numeric value, you may provide a score for "0 - 10", and a score for "11-20", etc.
   b. For a multi-select list, select each of the options you have available for suppliers and assign a score.
   c. For a date field, you may provide a range of dates with one score, and a different range of dates with another score.
d. As you add each score, select the green checkmark to add the configuration to the question.

6. When finished adding the auto score values, click **Save Changes**.

If changes do affect supplier responses (such as a change to the questions), the supplier responses for the items affected are discarded. If the changes do not affect existing supplier responses (such as a change to the response scoring), then previously submitted supplier responses are not discarded.

**Cost Analysis Values for Events and Event Line Items**

Sourcing customers may configure a Cost Analysis option for work groups and events that will allow for a cost adjustment based on a supplier’s specific answers to event questions and on event line items. For example, if the supplier will allow for free shipping, the customer may adjust the cost to reflect the service. The use of cost analysis is configured at the work group and event level. When an event is configured to include cost analysis, a **Cost Analysis** page is available under the **Evaluations** section of the event.

If cost analysis is enabled, cost adjustment values are initially assigned to questions in the **Questions** section of Event Setup, and to additional item fields in the **Additional Item Field** section. See **Event Questions**, on page 67 and **Additional Item Fields**, on page 89 for more information.

Questions and additional item fields with cost analysis enabled are displayed in the **Cost Analysis** sub-section of the **Evaluations** section in the event navigation (see below).

To see how cost analysis values are used in the evaluation process, see **Evaluations**, on page 191.

**Creating Cost Analysis Questions**

When **Cost Analysis** is enabled for an event or additional item field, you will have the option to use the Cost Analysis options for certain types of questions and additional item fields:

- Numeric Text Box
- Yes/No
- Dropdown List (Pick One)
- Multiple Choice (Pick One)
- Multiple Select (Pick Many)
- Date

When configuring one of these question or additional item field types, options will allow you to choose whether or not you want to include the question or additional line item response in Cost Analysis. If you select yes, you will define the criteria and values for the
cost adjustments. If you enable cost analysis for a particular question or additional item field response, you will define criteria as follows:

- **Numeric Text Box** - You will have the option of designating the cost adjustment for a specific number or a range of numbers.

- **Yes / No** - Designate a cost adjustment for a Yes answer versus a No answer.

- **Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many)** - Designate a cost adjustment for each available response option.

- **Date** - Provide a cost adjustment for specific date ranges.

### Evaluating Cost Analysis Responses

Event questions and additional item fields with cost analysis enabled are displayed on the Cost Analysis page under the Evaluations section of the event. It allows event administrators to view or edit auto-score values for both event-level questions and line-level questions. The two types of questions are grouped under the following headings:

- Expand the **Event-Level Questions** heading to see a list of event questions that have been added to the Questions page of the event.

- Expand the **Line-Level Questions** heading to see a list of event line item questions that have been added via Additional Item Fields on the event. These are grouped into **Product** and **Services** categories.

You can expand a question to view or change cost analysis assignments, or view a summary of responses to the question:

- An **Edit Question Details** button is displayed when events are in Draft status, allowing users with the appropriate permission to change cost analysis assignments. The changes are saved to the original event question or additional item field.

- A **View Question Details** button is displayed when events are in any other status (e.g., Under Evaluation, Closed or Canceled). Users can view information about the question, but changes are not allowed.

### Changing Cost Analysis Assignments

Line level cost analysis assignments can be amended from the Evaluations page on released events so that corrections and adjustments can be made:

- If changes do affect supplier responses (such as a change to the questions), the supplier responses for the items affected are discarded.

- If the changes do not affect existing supplier responses (such as a change to the response scoring), then previously submitted supplier responses are not discarded.
• Amendments can't be made to locked items that have been added to an event from locked or protected templates.

Configure Cost Analysis Values

The Cost Analysis option may be enabled at the work group and event level, allowing customers to assign cost adjustments to different supplier responses on event questions and event line items, for use in evaluating responses. When the event is configured to include cost analysis, a Cost Analysis page is available under the Evaluations section of the event.

If cost analysis is enabled, cost adjustment values are initially assigned to questions in the Questions section of Event Setup, and additional item fields in the Additional Item Field section.

Questions and additional item fields with auto score enabled are displayed in the Cost Analysis sub-section of the Evaluations section in the event navigation. Cost adjustment values can be edited from this page by clicking the Edit Question Details button on a question or additional item. Changes are saved back to the original question or additional item field.

Step-by-Step

CONFIGURE COST ANALYSIS FOR QUESTIONS

Follow the steps below to assign cost analysis values to event questions. This task assumes that questions already exist on a Sourcing Event.

1. Navigate to an event that has Cost Analysis enabled on the Event Setup, and for which questions exist.

2. Select the Questions page in the Settings and Content section of event navigation.

3. Click Edit next to the question you want to change. Note that Cost Analysis may only be configured for questions with specific response types.

4. In the Edit Question overlay, select the Use Response in Cost Analysis checkbox.

5. Depending on the response type for the question, you may now configure a numeric range, date range, or the specific options for suppliers to choose from and assign a cost adjustment (positive or negative) to each of those values. The cost adjustment may be a dollar or percentage value. For example,

   a. For a numeric value, you may provide a cost adjustment of $100.00 or 2% for "0 - 10", and a cost adjustment of -$50.00 for "11-20", etc.

   b. For a multi-select list, select each of the options you have available for suppliers and assign a cost adjustment.
c. For a date field, you may provide a range of dates with one adjustment, and a different range of dates with another adjustment.

d. As you add each cost adjustment, select the green checkmark to add the configuration to the question.

6. When finished adding the cost analysis values, click Save Changes.

CONFIGURE COST ANALYSIS FOR ADDITIONAL ITEM FIELDS (EVENT LINE ITEMS)

Follow the steps below to assign cost analysis values to additional item fields. This task assumes that additional item fields already exist on a sourcing event.

1. Navigate to an event that has Cost Analysis enabled on the Event Setup, and for which additional item fields exist.

2. Select the Additional Item Fields page in the Settings and Content section of event navigation.

3. Click Edit next to the additional item field you want to change. Note that Cost Analysis may only be configured for additional item fields with specific response types.

4. In the Edit Additional Field overlay, select the Use Response in Cost Analysis checkbox.

5. Depending on the response type for the question, you may now configure a numeric range, date range, or the specific options for suppliers to choose from and assign a cost adjustment (positive or negative) to each of those values. For example,

   a. For a numeric value, you may provide a cost adjustment of $100.00 or 2% for "0 - 10", and a cost adjustment of -$50.00 for "11-20", etc.

   b. For a multi-select list, select each of the options you have available for suppliers and assign a cost adjustment.

   c. For a date field, you may provide a range of dates with one adjustment, and a different range of dates with another adjustment.

   d. As you add each cost adjustment, select the green checkmark to add the configuration to the question.

6. When finished adding the cost analysis values, click Save Changes.

EDIT COST ANALYSIS VALUES

Note: Changes can't be made to locked items that have been added to an event from locked or protected templates.

1. Navigate to an event that has Cost Analysis enabled on the Event Setup, and for which the cost analysis option is enabled for event questions or event line items.
2. Select the **Cost Analysis** page in the **Evaluations** section of event navigation.

3. Expand the **Event-Level Questions** heading to view event questions with cost analysis enabled. Expand the **Line-Level Questions** heading to view additional item fields with cost analysis enabled.

4. Select **Edit Question Details** under the question or additional item field you want to change.

5. Depending on the response type for the question, you may now configure a numeric range, date range, or the specific options for suppliers to choose from and assign a score to each of those values. For example,
   
   a. For a numeric value, you may provide a cost adjustment of $100.00 or 2% for "0 - 10", and a cost adjustment of -$50.00 for "11-20", etc.
   
   b. For a multi-select list, select each of the options you have available for suppliers and assign a cost adjustment.
   
   c. For a date field, you may provide a range of dates with one adjustment, and a different range of dates with another adjustment.
   
   d. As you add each cost adjustment, select the green checkmark to add the configuration to the question.

6. When finished adding the cost analysis values, click **Save Changes**.

   If changes **do** affect supplier responses (such as a change to the questions), the supplier responses for the items affected are discarded. If the changes **do not** affect existing supplier responses (such as a change to the response scoring), then previously submitted supplier responses are not discarded.

**Evaluation Calculation Options**

Evaluation Calculation Options are primarily configured for multi-stage events. This page allows for specific evaluation options to be included from all or different stages of the event. The selected options are displayed on the side-by-side evaluations page. For example, an event may have an initial stage that is a "Supplier Qualifying Round". The buyer may review the responses and simply select suppliers to proceed to the next stage, and therefore choose to not include some scores from the initial stage in the final evaluation.

The default selection is to **Include All Stages and Scoring Options** and the page displays the scoring options as read-only. Select **Let Me Pick** to edit which scoring options to use in the different stages for the event.

You can edit the **Evaluation Calculation Options** for the current stage only. Once a stage is complete (when a subsequent stage is created), you cannot edit the calculation options for the completed stage.
Changes When the Event Is Under Evaluation

If the event calculation options change after the event has saved scenarios, a notification may be sent to evaluators notifying them that a change has been made. Also, when viewing saved scenarios for an event, a message will indicate that event calculation options have changed.

Configure Evaluation Calculation Options

You may configure which scoring options to include when evaluating events with multiple stages.

Step-by-Step

The goal of this task is to configure evaluation calculation options for a multi-stage event.

1. Navigate to the current stage for an event that has multiple stages.

2. Select the Eval. Calculation Options page in the Evaluations section of event navigation.

3. By default Include All Stages and Scoring Options is selected. This will allow Auto Score, Cost Analysis, and Average Questionnaire Rating (as those options are configured for the event) will display on the side-by-side evaluations page for the event.

4. If you would like to include specific options from different stages, select the Let Me Pick radio button.
   a. For each stage, select which options you would like to include on the side-by-side evaluations page.
   b. Select Submit when finished with selections.

Designating Proxy Bid Suppliers

Organizations may choose to receive proxy bids from suppliers for Sourcing Events. The proxy bid allows the supplier to mail, email or phone in a bid to the buyer. The buyer may then access the sourcing event as a supplier would see it in their portal, thereby making it easier to complete the bid information online on the supplier's behalf. The organization may also choose to allow or not allow proxy bidding on sealed events. If enabled for an event, a user will designate the suppliers for whom a proxy bid may be submitted on the Supplier Responses page.

Once the event is Open, a user with the Create Proxy Bid permission and who is an Event Creator or Owner will designate for which suppliers a proxy bid may be provided on the Supplier Responses page. If proxy bids are allowed for sealed bid events, suppliers
cannot be designated for proxy bid until the sealed bid open date has arrived. Proxy Bids can be designated up until the Event is Awarded. Event suppliers who are available for selection are as follows:

- Event suppliers who have not yet **submitted** a bid are available.
- Manually invited suppliers who have not responded by registering for a supplier portal will not show. If a manually invited supplier has registered and has a supplier portal, they will show.
- If a proxy bid has already been started, the supplier name will show as read-only can the proxy bid designation cannot be removed.

Once designated as a proxy supplier, an icon 🔒 is displayed next to the supplier name for easy identification. A button displays for Enter Proxy Bid or Continue Proxy Bid. You can choose to deselect a supplier for proxy bid if a response has not been started. Manually invited suppliers who have not registered as a supplier cannot be selected.

**Adding Proxy Bidding for Suppliers in the Evaluation Stage of an Event**

Occasionally, supplier bids that are hand-delivered, or mailed-in, arrive after the event has already closed and is under evaluation. In these situations, if the event has been configured to allow proxy bidding, event managers can add suppliers to the event and proxy bid for these vendors.

Registered suppliers who are invited during the event evaluation period cannot respond to the event through their portal, the client user must proxy bid for suppliers invited at this stage.

**Note** – This functionality is not available for auctions. In multi-stage events, this capacity is only available for the initial stage of the multi-stage event.

**Designate Proxy Bid Suppliers**

If an event is configured to allow proxy bids, a user with Create Proxy Bid permission may designate suppliers for proxy bid once the event is open.

**Step-by-Step**

The goal of this task is to create a new event to submit to suppliers for responses.

1. Navigate to an Open sourcing event.
2. Select the **Supplier Responses** page of the **Evaluation** section on the Event.
3. From the Event Actions drop-down, select the option to **Designate Suppliers for Proxy Bidding** An overlay displays Event Suppliers to mark for proxy bidding.
4. Select from the available suppliers. Select to **Save Changes** when done.

5. The selected suppliers will be shown with the **Proxy Bid** icon. A button will be available to **Enter Proxy Bid**. Once the bid response has begun, the button will display as **Continue Proxy Bid**.

6. History for the event captures suppliers that are designated for proxy bid, and if the designation is removed.

## Cost Per Quality Point for Events

Cost Per Quality Point (CPQP) is an evaluation method that combines quality and price for an event. When configured at the event level, the Cost Per Quality Point is calculated using the Total Bid for required items and the average panel questionnaire rating.

CPQP can be configured at the organization, work group, and event level. When set as Optional or Allowed at the work group level, an option for **Cost Per Quality Point** will display under the **Bid and Evaluation** section of **Event Setup** page.

- **Yes** - If yes is selected, the system will calculate CPQP for each supplier’s submitted response, using the Total Bid for required items and the average panel questionnaire rating for the supplier.

- **No** - CPQP will not be calculated for the event.

If the work group setting is set to always use CPQP, the setting will show as Yes on the Event Setup and cannot be changed. If the work group setting is set to Off, the CPQP option will not display.

**Note:** CPQP requires the use of Panel Questionnaire on an event, as the calculations use the Average Panel Questionnaire Score. If you do not configure and have at least one completed response to a Panel Questionnaire, the CPQP score will not display.

When enabled for an event, the side-by-side evaluations page will display a row for Cost Per Quality Score for each supplier. For example, if a supplier submits a total bid for required items in the amount of $200,000, and their average questionnaire rating is 550 points, they would have a CPQP score of 364 (200,000 / 550). When evaluating this score for suppliers, a lower score is better. Buyers are able to split award scenarios by lowest (best) CPQP score.

For details about this calculation with evaluations, see **Evaluation Actions**, on page 192.

## Configure Cost Per Quality Point Setting

**Step-by-Step**

Permission(s) required: Sourcing Configuration
1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Event Evaluations section, select an option for Cost Per Quality Point Setting:
   
   a. Allow - All work groups are allowed to use Cost per Quality Point in event evaluation. You will have additional configuration options at the work group level.
   
   b. Disallow - No work groups are allowed to use the Cost Per Quality Point in event evaluation. No options are available to configure at the work group level.

3. Click to Save Changes.

4. Changes to the Cost Per Quality Point Setting are logged in history, available by selecting the History hyperlink on the page.

Best Value for Events

When Best Value is configured at the event level, buyers select a percentage of value they want placed on the average panel questionnaire rating versus the normalized required items bid price. This configuration is used along with the average panel questionnaire rating and normalized required items bid price to calculate the Best Value score.

Best Value can be configured at the organization, work group, and event level. When set as Optional or Allowed at the work group level, an option for Best Value will display under the Bid and Evaluation section of Event Setup page.

- **Yes** - If yes is selected, you will choose the percentage weight for price versus quantity for the calculation, using the slider.

- **No** - Best Value will not be calculated for the event.

If the work group setting is set to always use Best Value, the setting will show as Yes on the Event Setup and cannot be changed. The Panel Questionnaire setting will also be set to Yes. If the work group setting is set to Off, the Best Value option will not display.

**Note:** Best Value requires the use of Panel Questionnaire on an event, as the calculations use the questionnaire points. If you do not configure and have at least one completed response to a Panel Questionnaire, the CPQP score will not display.

When enabled for an event, the side-by-side evaluations page will display a row for Best Value for each supplier. When evaluating this score for suppliers, a higher score is better. Buyers are able to split award scenarios by highest (best) Best Value score.

For details about this calculation with evaluations, see Evaluation Actions, on page 192.
Example

The following is an example of how Best Value would be calculated:

1. The event is configured with a Panel Questionnaire Total Point Value of 1000, and a Best Value percentage of 20% price and 80% quality.
   - **Cost Score**: % Price * (Max Available Quality Points / % Quality)
     
     0.20 * (1000 / 0.80), or 250.

2. The supplier submitted a bid price for required items in the amount of $200,000.
3. The supplier's average questionnaire rating is 550 points.
4. Best Value is calculated using the Cost Score plus the Quality Points: 250 + 550 = **800**.

<table>
<thead>
<tr>
<th>Calculations for Best Value as follows:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Available Quality Points - Panel Questionnaire Point Value</td>
</tr>
<tr>
<td>% of Price</td>
</tr>
<tr>
<td>% of Quality</td>
</tr>
<tr>
<td>Maximum Score for Cost = % Price * (Max Available Quality Points / % Quality)</td>
</tr>
<tr>
<td>Cost Score</td>
</tr>
<tr>
<td>Quality Points (Average Questionnaire Rating)</td>
</tr>
<tr>
<td>Normalized Price = Minimum Bid / Supplier's Bid</td>
</tr>
<tr>
<td>Cost Score = Normalized Price * MaxQP</td>
</tr>
<tr>
<td>Best Value Score = Cost Score + Quality Points</td>
</tr>
<tr>
<td>Average Questionnaire Rating</td>
</tr>
</tbody>
</table>

Configure Best Value Setting

**Step-by-Step**

Permission(s) required: Sourcing Configuration

1. Navigate to **Sourcing > Sourcing Administration > General Sourcing Settings**

2. In the **Event Evaluations** section, select an option for **Best Value Setting**:
   - **Allow** - All work groups are allowed to use the Best Value calculation in event evaluation. You will have additional configuration options at the work group level.
b. **Disallow** - No work groups are allowed to use the Best Value calculation in event evaluation. No options are available to configure at the work group level.

3. Click to **Save Changes**.

4. Changes to the **Best Value Setting** are logged in history, available by selecting the **History** hyperlink on the page.

## Supplier Disqualification

Event administrators can remove (i.e., disqualify) suppliers from consideration when awarding a sourcing event. Suppliers can be disqualified automatically or manually:

- **Automatically** - Administrators creating an event can configure a response to an event question or additional item field that, if selected, will disqualify a supplier. When suppliers participating in the event select the response, they will be automatically disqualified from award consideration when the event closes.

- **Manually** - Suppliers can be manually disqualified during the evaluation process of an event. Event managers, creators and owners with access to an event can manually disqualify suppliers. Stakeholders with view only access to the event cannot disqualify suppliers.

There is no indication to suppliers that a response will disqualify them, or notification that they have been disqualified during the evaluation process.

Suppliers can interact with an event while it is open. The **Disqualified** status is only applied to suppliers once an event closes, and disqualified suppliers are not eligible for award consideration during the evaluation phase of an event.

Supplier disqualifications and re-instatements are recorded in the Event History tab of the History page. The disqualification history can also be accessed from the Supplier Responses page by clicking the information icon next to a supplier and then the **Link to Disqualification History** link.

## Automatic Disqualification

Automatic disqualification requires setup on event questions or additional item fields (for event line items) when creating an event.

Both event-level questions and item-level questions (i.e., Additional Item Fields) support disqualifying responses, but disqualifications are an event-level, all-or-nothing designation. For example, a supplier can't be disqualified from award consideration for specific items.

The following **Response Types** (for event questions) or **Field Types** (for additional item fields) support disqualifying responses:
- Numeric Text Box
- Yes/No
- Dropdown List (Pick One)
- Multiple Choice (Pick One)
- Multiple Select (Pick Many)
- Date

To make a question or additional item response one that can automatically disqualify a supplier, a **Set Disqualifying Response** checkbox is displayed on the following pages:

- Add/Edit Question
- Add/Edit Additional Item Field (if the **Supplier Can Respond** option is set to **Yes**)
- Add/Edit Conditional Field (if the **Supplier Can Respond** option is set to **Yes**)

If the **Set Disqualifying Response** checkbox is selected on an event question or additional item field, a **Disqualify** column is displayed in the **Response Options** section. This is where the disqualifying response is identified by selecting the checkbox on the response option(s) that will cause a supplier to be automatically disqualified. The checkbox is left blank on responses that do not cause a supplier disqualification.

Auto-disqualification settings on an event are transferred to event amendments, copied events, and incorporated into event question exports and imports.

Disqualifying response options on event questions and additional item fields in event templates and libraries are included when they are copied into an event.

See Configure Disqualifying Responses for more information.

**Manual Disqualification**

Manual disqualification excludes suppliers from award consideration during the evaluation process of an event. Event administrators, creators, or owners with access to an event can manually disqualify suppliers once the event is **Under Evaluation**. Suppliers can be manually disqualified from the **Supplier Responses** page or on the award scenario evaluation page.

**Disqualified Suppliers on Sourcing Events**

Suppliers are disqualified after an event closes and when it is in the **Under Evaluation** status:

- For automatic supplier disqualifications, opening the **Supplier Responses** page after an event has closed will cause the system to run an analysis to find disqualifying supplier responses. This process will take a few seconds and the Supplier Responses page will display a message indicating that a supplier disqualification check is in
progress. **Disqualified** is displayed next to disqualified suppliers when the analysis is finished.

- For **manual** supplier disqualifications, the **Disqualify** option is available on supplier responses and award scenarios after the event is closed.

A **Disqualified** status is displayed next to disqualified suppliers on the Supplier Responses page.

- The supplier is excluded from the **Evaluate All Responses** and **Export All Responses** evaluation actions.

- The **Evaluate Selected Response** checkbox on the Supplier Response page is removed for that supplier.

- **Saved scenarios** with disqualified suppliers cannot be loaded. A warning message at the top of the Load Saved Scenario page will indicate that there are scenarios with a disqualified supplier. The affected scenario will not have a Load button. Instead, an information icon is displayed, and when clicked, will show the message "This scenario has a disqualified supplier".

Suppliers cannot be disqualified from a **pending award** or a **finalized award**. They must be removed from the award before they can be disqualified.

**Reinstating Disqualified Suppliers**

Disqualified suppliers can be reinstated from the **Supplier Responses** page by clicking **View Response**, then **Re-Qualify**. Suppliers do not receive notification that they have been reinstated.

**Configure Automatic Disqualifying Responses**

Event administrators can remove (i.e., disqualify) suppliers from consideration when awarding a sourcing event. Event administrators can have this done automatically by configuring a response to an event question or additional item field that will disqualify a supplier if they select it, or the administrator can manually disqualify a supplier during the evaluation process.

Automatic disqualification requires setup when creating an event. This can be done by setting up an event question or additional item field with a disqualifying response.

The following **Response Types** (for event questions) or **Field Types** (for additional item fields) support disqualifying responses:

- Numeric Text Box
- Yes/No
- Dropdown List (Pick One)
Multiple Choice (Pick One)
Multiple Select (Pick Many)
Date

Step-by-Step

CONFIGURE DISQUALIFYING RESPONSES FOR EVENT QUESTIONS

Follow the steps below to configure disqualifying responses on event questions. These steps describe how to configure disqualifying responses only.

1. Open the event.
2. In the left menu, select Questions under Settings and Content. The Questions page opens.
3. Click Add Questions or click Edit next to the question you want to change. The Add Question or Edit Question overlay opens.
4. Select a Response Type that can be used for a disqualifying response.
5. Select the Set Disqualifying Response checkbox.
6. Under Response Options, configure a disqualifying response:
   - Select the checkbox in the Disqualify column for each response option that will disqualify suppliers, otherwise leave the checkbox blank.
   - Click Add Response. Yes is displayed in the Disqualify column to indicate that suppliers selecting that response will be automatically disqualified if they select it. No indicates that suppliers selecting that response will not be disqualified.
   - To change the Disqualify settings on a response option:
     - Open a response option row by clicking Yes or No in the Disqualify column.
     - Select or clear the checkbox on the top row (selected = disqualify), then click the green checkmark immediately to the right of the checkbox to Update the settings and save changes. Click the red Cancel icon to return to the original setting.
7. Click Save Changes.

CONFIGURE A DISQUALIFYING RESPONSES FOR EVENT LINE ITEMS (ADDITIONAL ITEM FIELDS)

Follow the steps below to configure disqualifying responses for additional item fields. These steps describe how to configure disqualifying responses only.
1. Open the event.

2. In the left menu, click **Additional Item Fields** under **Settings and Content**. The Additional Item Fields page opens.

3. Click **Create Additional Field**, or click **Edit** next to the additional item field you want to change. The Add Additional Item Field or Edit Additional Item Field opens.

4. Click **Yes** in the **Supplier Can Respond** field.

5. Select a **Field Type** that can be used for a disqualifying response.

6. Select the **Set Disqualifying Response** checkbox.

7. Under **Response Options**, configure a disqualifying response:
   - **Select the checkbox** in the **Disqualify** column for each **response option** that will disqualify suppliers, otherwise leave the checkbox **blank**.
   - Click **Add Response**. **Yes** is displayed in the Disqualify column to indicate that suppliers selecting that response will be automatically disqualified if they select it. **No** indicates that suppliers selecting that response will not be disqualified.
   - **To change** the Disqualify setting on a response option:
     - Open a response option row by clicking **Yes** or **No** in the Disqualify column.
     - Select or clear the checkbox on the top row (selected = disqualify), then click the green checkmark immediately to the right of the checkbox to **Update** the settings and save changes. Click the red Cancel icon to return to the original setting.

8. When finished configuring the disqualifying response(s), click **Save Changes**.

**Manually Disqualify or Requalify a Supplier**

Suppliers can be removed from consideration when awarding a sourcing event by manually disqualifying them after an event closes. Disqualified suppliers can be reinstated.

To manually disqualify or requalify a supplier:

- The event must be in Under Evaluation status.
- Event administrators, creators, or owners with access to an event can manually disqualify and requalify suppliers.
- Suppliers cannot be disqualified from a pending award or a finalized award. They must be removed from the award before they can be disqualified.

Comments regarding supplier disqualifications and reinstatements are displayed in the Notes column on the Events History page.
Step-By-Step

DISQUALIFY A SUPPLIER

1. Open an event that is in Under Evaluation status.
2. Expand the Evaluations section in the left menu and click Supplier Responses.
3. Choose one of the following options:
   - From the Supplier Responses page - Expand the View Response menu next to the supplier you want to remove from award consideration and select Disqualify.
   - From an Award Scenario - Click the Evaluate All Actions button and select Evaluate All Responses. Click the supplier name at the top of the column and select Disqualify.
4. Enter a Comment.
5. Click Continue.

The disqualified supplier is excluded from the Evaluate All Responses and Export All Responses evaluation actions. The Evaluate Selected Response checkbox on the Supplier Response page is removed for that supplier. Saved scenarios with disqualified suppliers cannot be loaded. Suppliers do not receive notification that they have been disqualified.

REQUALIFY A SUPPLIER

1. Open an event that is in Under Evaluation status.
2. Expand the Evaluations section in the left menu and click Supplier Responses.
3. Expand the View Response menu next to the disqualified supplier you want to return to award consideration and select Re-Qualify.
4. Enter a Comment.
5. Click Continue.

The supplier is returned to the evaluation process. Suppliers do not receive notification that they have been reinstated.

Event Internal Notes

In the Tools section of an event, a user may enter Internal Notes and Attachments to the event that are not shared with the suppliers. A user must have Create/Own Events or Manage work group Events permission in order to view, add, edit or delete internal notes on the event. The user must also have the ability to edit the event as an Event Owner or an
Event Manager. A Stakeholder or a user with View Event permission can see internal notes and attachments. Note: Users cannot edit or delete Internal Notes which were added by other users.

As internal notes are added, the count of Internal Notes is listed.

Add Internal Notes to an Event

An Event Owner or Event Manager can add Internal Notes and attachments to an event that are for the organization's use only, and not shared with suppliers.

**Step-by-Step**

The goal of this task is to manage internal notes and attachments on an event.

1. Search for an Event and select an Event you own or manage.
2. Select to expand the Tools section on the left.
3. Select the Internal Notes link.
4. Existing Notes and Attachments are listed, along with the date added and user who added the note.
5. For existing Internal Notes or attachments you have added, select the Edit button to edit or delete the note/attachment.
6. To add a new note or attachment, click the Add Note or Attachment button.
7. In the Add Note & Attachment overlay:
   a. To add an Internal Note, enter the Note text up to 1000 characters.
   b. To add an attachment, select the Upload button. Enter a name for the attachment, browse and select the file.
8. Select to Save Changes.
9. The page refreshes with the Internal Notes and Attachments as edited.

Exports and Imports

Customers can perform several different types of exports and imports within a sourcing event. The results of the export and import requests are stored on the Exports and Imports page, available under the Tools section for the event.

A message on the page indicates how long files will be stored on the page before they are deleted. This setting is managed in the General Sourcing Settings. See General Sourcing
Settings, on page 258. You may also choose to delete a file by selecting the Delete hyperlink.

Access files on this page via the various imports and exports requested in the Sourcing Event, such as:

- Validate or import a file for manually inviting suppliers
- Request an export of questions, or an export of items
- Request to validate/import questions, or validate/import items

There are several Notification preferences related to exports and imports. A user can select to be notified with the request has processed. See Notifications, on page 10 for more information.

For information about exporting an event as a PDF file, see Export Event Information, on page 159.

Note that imports and exports related to the panel questionnaire are on the Panel Imports and Exports page in the Panel Questionnaires for Events, on page 107 section of the event.

Event Q&A Board

Each event has a Question & Answer (Q&A) Board available to enhance communication between buyers and suppliers. In the Q&A Board:

- Customers can...
  - Effectively monitor, review, select and answer questions submitted by suppliers.
  - Respond publicly to all suppliers or privately to specific suppliers.
  - Submit questions directly to a supplier, or group of suppliers.
  - Define the allowable time frame for event question submissions.
  - Add an attachment to a Q & A entry to supplement information provided during the exchange.

- Suppliers can...
  - Submit questions to customers.
  - Review responses to questions that they have submitted, and review Q&A entries that have been made public to all suppliers.
  - Ask follow-up questions to customer responses.
  - Respond to customer submitted questions.
- Add an attachment to a Q & A entry to supplement information provided during the exchange.

Access the Q&A Board by selecting the Tools link on an Event, and selecting the Q&A Board. Any user with access to the Event will have access to the Q&A Board of that event. By default, administrators of an Event (Event Managers, Creators and Owners) have full access to the Q&A Board and the ability to respond to supplier-submitted questions. Other users with access to the Event (Stakeholders) must have the Manage Q&A Board permission in order to respond to questions.

Questions can be posted by suppliers until the configured Q&A Submission Close Date of the event. The customer's Q&A Board is organized into four tabs:

1. **Unanswered Questions** - Contains event questions that have not been answered by the customer. The customer can select Answer Question, Decline to Answer, or Post a Question Like This.

2. **Public Q&A** - Contains event questions/answers that have been made public by the customer. A customer can see who provided the answer to the question, edit the answer, make the Q&A private, add or remove an attachment, or post a similar question. All suppliers who have access to the event can see questions, answers and attachments that have been made public. Questions, answers and attachments that are not made public are only seen by the supplier who submitted the question. Customers responding publicly to a supplier question with an attachment have the option to both edit the content of the question (to generalize the verbiage) and remove the supplier attachment before posting publicly.

3. **Questions from Suppliers** - Lists event questions sent from suppliers.

4. **Questions sent to Suppliers** - Lists event questions sent to suppliers from the buyer.

The customer is able to search for questions from specific suppliers. They can sort Q&A entries by the date the question or answer was submitted, or the number of follow up questions. The ability to submit a new question is available to all invited suppliers until the designated Q&A Submission Close Date indicated for the event. Suppliers can, however, continue to respond to customer submitted questions beyond the designated Q&A Submission Close Date.

A customer may choose to enable the notification for Supplier has submitted an Event-related question to be alerted when a supplier submits a question. See Notifications on page 10 for details.

**Manage the Q & A Board on an Event**

All users who have access to an event can see the Q&A Board for that event. Users with edit access to the event, as well as Stakeholders with the Manage Q&A Board permission may submit responses.
Suppliers and buyers can add an attachment to Q&A entries to supplement the information provided during the exchange. There is a maximum of one attachment per question or answer.

Anyone who can view a question or answer on the Q&A Board can also view, upload, or download its attachment. When a buyer responds publicly to a supplier question that has an attachment, the buyer has the option to remove the supplier attachment before posting publicly.

Questions can be submitted until the configured Q&A Submission Close Date for the event.

**Step-by-Step**

The goal of this task is to view, respond, and submit questions on an event's Q&A Board.

1. Search for an Event and select an Event you own or manage.
2. Expand the Tools section in the left menu.
3. Select the Q & A Board link.

**To View Questions and Responses**

4. Questions are sorted into Unanswered Questions, Public Q&A, Questions from Suppliers, and Questions sent to Suppliers tabs. Select the appropriate tab to view the questions listed under it.
5. View a specific supplier's questions by entering the supplier name in the Supplier search box on any tab. Click Go.
6. On any tab, select to sort by the various options in the drop-down list.

**To Respond to a Question**

7. On the Unanswered Questions tab, unanswered questions are highlighted with the message No answer yet.
8. The question, supplier, supplier user, date and time of the question is noted.
9. To answer the question:
   a. Click Answer Question. The Answer overlay opens.
   b. Enter the Answer to the question, up to 5000 characters.
   c. (optional) Upload a file in the Attachment field. A link to the file will be displayed next to the answer on the Q&A Board.
   d. In the Post to Public Q&A field, select Yes (public response) if you want all suppliers with access to the event to see the supplier's question, along with your
answer and its attachment. Select No (private response) if you want only the supplier who asked the question to see your answer and its attachment.

e. If Yes is selected in the Post to Public Q&A field, complete the Delete Supplier's Attachment? field. Select Yes to remove the attachment submitted by the supplier. Only the supplier's question, along with your answer and its attachment will be displayed to the public. Select No to publish the attachment submitted by the supplier. The supplier's question and attachment, along with your answer and its attachment, will be displayed to the public.

   **Note:** This is a one-time option. Once Post Answer is clicked, the supplier attachment is either removed or published, but cannot be changed. The question and answer thread can be made private.

f. Click the Post Answer button. The answer time, date, and user who submitted the answer is noted.

10. To **decline to answer**:
   a. Click the drop-down arrow next to Answer Question, and select Decline to Answer.
   b. A confirmation message asks if you are sure. Click Confirm.
   c. The response is sent as a private response to the supplier who asked the question, with a message We decline to provide an answer to this question. The response may be edited later.

**To Take Action on a Response**

11. Navigate to the appropriate question/response.

12. Click the Actions dropdown button, and select from the following options:
   a. Select to Edit this Q&A Entry to update the response.
   b. For a public response, select to Make this Q&A Public. For a private response, select to Make this Q&A Private.
   c. Select to Post a Question Like This to post a similar question and provide an answer.

**To Post a Question/Answer**

13. Click the Submit Question dropdown and select Post a Question. A Post a Question overlay displays.

14. Enter a Subject for the question.

15. Enter the Question text, up to 5000 characters.
16. Enter the **Answer** text, up to 5000 characters.

17. (optional) Upload a file in the **Attachment** field. A link to the file will be displayed next to the answer on the Q&A Board.

18. Click **Post Question** button.

19. The question and answer will show in the **Public Q&A** tab and is visible to all suppliers with access to the event.

20. After the question/answer is posted, you may select from the **Actions** button on the question to choose to edit the entry, make it private, or post a similar question.

**To Ask a Question**

Buyers are able to submit questions directly to event-participating suppliers using the Q&A Board.

21. Click the **Edit** button on the **Send To** field to change the recipient from all suppliers on the event, to only selected suppliers.

22. Click the **Submit Question** dropdown and select **Ask a Question**. The **Ask a Question** overlay displays.

23. Enter a **Subject** for the question.

24. Enter the **Question** text, up to 5000 characters.

25. (optional) Upload a file in the **Attachment** field. A link to the file will be displayed next to the answer on the Q&A Board.

26. Click **Submit Question** button.

27. After the question is posted, you may select from the **Actions** button on the question to choose to edit the entry, make it private, or post a similar question.

**Event Approvals**

Events will go through two types of approvals:

- **Event Approval**: The event will be approved by someone in your organization so that it can be released to suppliers.

- **Evaluation Approval**: Once suppliers have submitted responses and the close date has passed, the event will enter Evaluation workflow in order to award a supplier the business for the event.

Users can access the current or future approvals process for an event or evaluation by selecting the **Tools** link on an Event, and selecting the **Approvals** page. A user must have permission to view the event.
When selecting the **Approvals** page, the user can see the process flow for the event and evaluation.

---

**Award Notifications**

Customers can configure the option to send award notifications to suppliers after an event has been awarded. When enabled, an **Award Notifications** page shows in the **Tools** section of the event's navigation. The customer can view the email by clicking **Preview Email**, and then select to send the default system notification, customize the email before sending, or select another template from the organization's Sourcing Email Templates.

Additionally, an **Award Comment** is available for public events by default. If configured and published, this message will display in the PDF available to suppliers when accessing a public event.

The actions available for **Award Notifications** depend on the status of the event:

**Event has not yet been awarded:**

- If the event has not yet been awarded, the **Award Notifications** page will display the enabled notifications, with a link to **Select New Template**. A user may select a different template from the organization's **Sourcing Email Templates** for the award notification, but cannot customize the Default template email or send to any suppliers.
When choosing to **Select New Template**, an overlay displays the current template, with an option to select a different template. At this status, the actual text of the email may not be edited. However, if the underlying template should be edited, the user may navigate to **System Emails** for the default template, or to **Sourcing Email Templates** for organization sourcing templates.

**Event has been awarded:**

- Once the event is in Awarded status, a user can choose to **Select New Template** to simply select a different template for the email, or choose to **Preview and Send** the email to make additional changes.
- When **Preview and Send** is selected, an overlay will display for the selected template, allowing the user to:
  - Change the template to another organization configured sourcing email template or the system Default for the type of notification
  - Modify the subject line
  - Add attachments
  - Edit the text of the email

- Note that any changes to the email text, subject and attachments from this page do not change the underlying template. The changes are effective for the specific award notification only. Changes to templates are done through managing the **Sourcing Email Templates** or **Default System Emails**.
Sending the Award Notification

When you have selected the appropriate template and/or made edits to the email, you may select to **Send Email**. When an award email notification is sent, the status is updated on the **Award Notifications** page.

- Options are available to **View Email Message** and **View Recipients** for the notification.
- An audit log of emails and recipients is available by selecting the **History** hyperlink for the event, and select the **Email History** tab.

![Award Notifications](image)

**Publish Attachments with Award Notifications to the Public Site**

Attachments can be published with notifications to the public site. With this feature, buyers can publish intent to bid documents prior to awarding an event, and publish any required award notice attachments after the award has occurred.

Events must be public, closed, and in the Under Evaluation status in order for attachments to be uploaded and published.

- To upload attachments, navigate to **Tools > Award Notifications** on a public event in Under Evaluation status. Click the **Add Attachment** button.
under the Public Site Award Attachments heading, the Add Attachment pop-up will open. Choose File or Link as the attachment type.

- **File attachment** - Drag and drop the files you would like to add as attachments to the Files field, or click the Select files button and select the attachments to be uploaded. Click Save Changes.

- **Link attachment** - Add a URL, and optionally name and description for your link. If at least one attachment has already been added, you will need to select the Display Order for the attachment. Click Save Changes.

- Click the dropdown beside an attachment and click Publish to publish it to the public site.

**Send Award Notifications**

Customers can configure the option to send award notifications to suppliers after an event has been awarded. Notifications are enabled at the organization and work group level. When enabled, an Award Notifications page shows in the Tools section of the event’s navigation.

**Step-by-Step**

The goal of this task is to configure and send award notifications to suppliers for an awarded event.

1. Navigate to an Event.

2. Navigate to the Award Notifications page in the Tools section of the event navigation.

3. If the event **has not yet been awarded**:
   a. You may choose to Select New Template, and select a different template from the organization’s Sourcing Email Templates.
   b. If the event is a Public Event, you may edit the Award Comment to be published within the public site Event PDF.

4. If the event is in **Awarded** status
   a. You may choose to Select New Template to select a different template for the email.
   b. To send an email, choose Preview and Send the email to make additional changes. An overlay displays with the current selected template. You may:
i. Change the template to another organization configured sourcing email template or the system Default for the type of notification.

ii. Modify the subject line.

iii. Add attachments.

iv. Edit the text of the email.

c. Note that any changes to the email text, subject and attachments from this page do not change the underlying template. The changes are effective for the specific award notification only. Changes to templates are done through managing the Sourcing Email Templates or Default System Emails.

5. When the appropriate template has been selected and all edits made, select to Send Email. The status for the notification is updated.

6. Options are available to View Email Message and View Recipients for the notifications.

7. If your event is public, closed, and in the Under Evaluation status, attachments can be published with notifications to the public site.

   a. Click the Add Attachment button under the Public Site Award Attachments heading, the Add Attachment pop-up will open.

   b. Choose File or Link as the attachment type.

      - **File attachment** - Drag and drop the files you would like to add as attachments to the Files field, or click the Select files button and select the attachments to be uploaded. Click Save Changes.

      - **Link attachment** - Add a URL, and optionally name and description for your link. If at least one attachment has already been added, you will need to select the Display Order for the attachment. Click Save Changes.

   c. Click the dropdown beside an attachment and click Publish to publish it to the public site.

Multi-Stage Events

The multi-stage event functionality allows customers more options in the supplier selection process. If the work group for the event is configured to allow multi-stage events, buyers can initiate a new stage for an event before it is awarded. Most event content is carried to the next stage. Questions, prerequisites, and attachments are not copied. Panel Questionnaire questions can be optionally carried over.
Buyers can choose which suppliers are included for subsequent stages. If an event contains multiple stages, a View Event Stages hyperlink displays in the left event navigation. You may not award the event from the previous stage once you create a new stage. However, if you cancel a current stage (before it is approved to be released to suppliers), you may award from the previous stage.

The buyer has the ability to choose analysis options (questionnaire, auto score, and cost analysis) from the different event stages that they want to use in the evaluation using the Evaluation Calculation Options in Event Navigation. See Evaluation Calculation Options, on page 122 and Evaluation Actions, on page 192 for more information.

Suppliers will have visibility into the multiple event stages only if they are invited to participate in those stages. On a customer public site, previous stages of events will show as Closed, but the initial event stage PDF will continue to be available. Suppliers will have the ability to respond only to the current stage of an event if they are selected to advance and bid on it. Previous stages will display for suppliers as read only.

Creating a New External Event Stage

When you create a new stage, you may tag suppliers for the next stage on the Supplier Responses page. You may also choose to refine the supplier list after the next event stage is created.

When you create a new stage, the Create New Stage overlay opens with the following options:

- **Stage Title** - If the initial stage title was left blank, you will be prompted to add a stage title for the previous stage. Note that once saved, the initial stage title cannot be changed.

- **Internal Stage** - Default is No. If you would like the new stage to be an internal stage, select Yes. You are able to incorporate an internal evaluation / review stage into the course of a multi-stage event, so that an event round can be conducted that requires no direct input from eligible suppliers.

- **Event Type** - An event type is crafted with varying content and collateral sections, and is constructed based on the set of objectives for which the event type is being created. Collateral sections that can be optionally integrated into an Event Type are prerequisites, attachments, questions and items.

- **Create from Template** - Templates are used to efficiently create events of the same construct, so you don't have to manually enter common information for each such event created.

- **Transfer PQ Questions to New Stage?** - Select whether or not to transfer panel questionnaire questions to the next stage of the event.
Once you confirm the action to create a new stage, you are navigated to the setup page of the new stage. Here are some details regarding what is populated and what may be edited for the new event stage:

- **Event number** remains the same as the original event.

- **Stage Title** is now required.

- View and navigate to all the event stages from the View Event Stages hyperlink in the left navigation pane.

- **Commodity Codes** - The Reporting and Additional Commodity codes may not be edited in subsequent stages. However, the item level commodity codes may be edited.

- **Bid and Evaluation** - The settings for responding by proxy, sealed bid, alternate items, panel questionnaire, auto score and cost analysis use, and allowing partial quantity awards may not be changed.

- A **Stage Description** may be entered on the Description page, providing additional information about the new, specific stage. You may choose to alter the Description for the original event as well.

- **Event users** may be altered for the current stage. Users from the initial stage may be removed and new users may be added; however, inherited users from the work group may not be removed.

- **Prerequisites** and **Buyer Attachments** are not copied to the next stage, but new prerequisites and attachments may be added to those sections as appropriate.

- **Questions** are not copied to the new stage. You may enter new questions appropriate for the stage.

- **Additional Item Fields** are copied to the next stage. You may add, edit or delete additional item fields for the current stage.

- **Items** are copied to the next stage. You may edit the specifics for an item, delete items, or add new items for the current stage.

- The **Suppliers** page shows a tab to Add Suppliers to Stage, in order to add new suppliers specific to this event stage. You may only select from suppliers who submitted a bid in the previous stage. You may also remove suppliers/contacts that were tagged from the previous event stage.

**Creating an Internal Review Stage**

You are able to incorporate an internal evaluation / review stage into the course of a multi-stage event, so that an event round can be conducted with no direct input from eligible suppliers. An internal stage can be used to determine event award recipients, or to simply eliminate suppliers from award consideration.
The initial stage of an event is excluded from being designated an internal stage. Additionally, the following differences appear on an internal stage:

- **On the Setup page:**
  - The Stage Title field is required.
  - The Open and Close date fields are displayed with non-editable dashes as these settings are not required for an internal stage.
  - The sealed bid option is set as read-only, with the value set to No.
  - The Q&A Submission Close Date is still required. The Same as Close Date option is removed.
- **On the Description page,** the event description is maintained from the previous stage, and stage description is required.
- Fields on the Questions, Items, and Additional Items pages are maintained and displayed as read only.
- Identified Suppliers are still a requirement for an internal stage. Only previous stage suppliers (suppliers that submitted a bid) are available for inclusion within these stages.
- As an internal stage does not need any supplier responses or bids, the status and progress on the Supplier Responses page is replaced by the text "N/A" for all suppliers. The only formal content taken into account for evaluation during an internal stage is responses gathered from panelists via the Panel Questionnaire.
- Event Copy and Copy As Template workflow actions are not available.
- Since an internal stage does not require any direct supplier input, there is no need to flow through all of the usual event states. After the draft version of an internal stage has been approved, the event immediately enters the Under Evaluation state.
- **On the supplier portal,** all the sourcing event sections are hidden even if the sections were populated in the previous stage, except Summary, Q&A Board, and My Exports and Imports.
- When a supplier chooses to export an internal stage event, the only content that is included in the generated PDF is the Summary page information and the Q&A Board activity content.

**Notifications Related to Multi-Stage Events**

You may choose to configure notifications for suppliers related to multi-stage events, and also enable notification preferences for users/roles.
• In **General Sourcing Settings**, you may enable **Multi-Stage Notification Emails**. Select the option for **Supplier does not Advance Notifications** if you want suppliers who are not selected for a subsequent stage to be notified. You can manage the text of this email in the **Administer > Email Management > System Emails** page.

• A system email is automatically sent for **Sourcing Supplier Advancing to Next Stage** for any supplier who is invited to a subsequent stage of an event. The text of the email is managed in the **Administer > Email Management > System Emails** page.

• A system email is automatically sent for **Internal Evaluation Event Stage Available for Review** for any supplier who is invited to an internal stage of an event. The text of the email is managed in the **Administer > Email Management > System Emails** page.

• A user may choose to enable the notification preference in their user profile (or a user administrator may enable it for a role) for **Evaluation Calculation Options Change**, which may occur for multi-stage events.

**Multi-Stage Workflow Options**

When viewing the workflow approvals for an event, the workflow steps will show for the current stage. Therefore, you may see some steps are 'skipped' because they do not apply to the current stage.

**Advanced Dynamic Workflow** options are available for both Sourcing Approval workflow and Sourcing Evaluation workflow:

• You may configure workflow based on whether an event is multi-stage or not.

• You may configure workflow based on the event stage number.

• While an administrator may configure ADW rules for use in their workflow process, new workflow rules are **NOT ENABLED** by default, and you must contact JAGGAER to update your workflow to include any new workflow rules.

**Add an Event Stage**

Once an event is under evaluation, organizations may choose to create another event stage to continue the sourcing process.

**Step-by-Step**

The goal of this task is to create a new stage for an event.
1. Search for an event that is not closed, and navigate to the Supplier Responses page.

2. To select suppliers to proceed to the next stage, select check boxes for the appropriate suppliers and choose Tag Suppliers for Next Stage (x) from the Evaluation Actions dropdown.

   a. You may also do this after the next stage has already been created. Only suppliers from the previous stage may be added to subsequent stages.

   b. You may choose to Show Tagged Suppliers Only on the Supplier Responses page for a view of only those suppliers.

3. Select Create New Stage from the Workflow Actions dropdown.

   a. If a Stage Title has not been entered for the initial stage, you will be prompted to enter an initial stage name before proceeding to subsequent stages. Stage Title is required for each stage in the event.

   b. Select Yes or No for Internal Stage. The default is No.

   c. Select the Event Type for the stage. By default, the previous event type is selected, but the type can be changed by searching for and selecting another event type. This field is hidden if you have chosen to create an internal stage.

      • If you use an event type that includes items, and then change the event type in a following round to one that does not include an items section, the items will not be brought forward.

      • If a follow-on stage of the event then allows items again, the original items being sought by the multi-stage event can be reintroduced to the latest stage using options available on the Items page of the event:

         • Select the Add Item from Previous Stage option from the Add Product Line Item drop-down selection list.

         • Select the Import from Previous Stage option from the Add or Import drop-down selection list.

   d. Optionally, select a template for the stage using the Create from Template field. This field is hidden if you have chosen to create an internal stage.

   e. Select whether or not to transfer panel questionnaire questions to the new stage using the Transfer PQ Questions to the New Stage? field.

   f. Once you have selected to save the stage, you will be navigated to the new event stage.

4. Complete the Event configuration for the next stage. The following information may be edited for a new external stage:
a. **Stage Title** is required.

b. Enter an optional **Stage Description** on the **Description** page, providing additional information about the new, specific stage. You may choose to alter the **Description** for the original event as well.

c. **Event users** may be altered for the current stage. Users from the initial stage may be removed and new users may be added; however, inherited users from the work group may not be removed.

d. Add **Prerequisites** and **Buyer Attachments** for the new event stage. Prerequisites and attachments from the previous stage(s) are not copied.

e. Enter **Questions** for the current stage.

f. Edit the **Additional Item Fields** for the current stage. You may edit additional item field settings that were copied from the previous stage, remove additional item field, or add new additional item fields.

g. Edit the **Items** for the current stage. You may edit item settings that were copied from the previous stage, remove items, or add new items.

- You can import items from previous stages of the event by clicking the **Add or Import** dropdown and selecting **Items Group** or **Individual Items** from **Import From Previous** stage, or by clicking an **Add Product Line Item** dropdown and selecting **Add Item from Previous Stage**.

h. The **Suppliers** page shows a tab to **Add Suppliers to Stage**, in order to add new suppliers specific to this event stage. You may only select from suppliers who submitted a bid in the previous stage. You may also remove suppliers/contacts that were tagged from the previous event stage.

5. View and navigate to all the event stages from **View Event Stages** in the left menu.

---

**Event Amendments**

Once an event has been approved and has been Opened or Released, any changes to the event must be made by **Amending** the event. Examples may be to add or remove a user to an event, or add an item to the products or services list. A user must have Create/Own Events or Manage work group Events permission in order to have the ability to Amend the event. The user must also have the ability to edit the event as an Event Owner or an Event Manager.

When the Event is in an appropriate status and the user has the appropriate permission, an **Amend** option is available from the **Workflow Actions** drop-down. Selecting Amend also prompts users to add an amendment reason in a text box. Once you confirm to Amend the event:

- The event is placed in **Draft** status. A message shows at the top of an Amended Event indicating the event is being amended.
• If changes to any event prerequisites, questions, items, or additional item fields have been made, supplier responses to the modified fields are removed. Changes to other fields do not affect supplier responses.

• Emails are sent to suppliers, notifying them that the event is being amended.

• The audit log for the event captures the configurations for the amendment from the original event.

• *Note:* If the only change to an amended event is the Target Price for one or more items, the event is not placed in Draft status, emails are not sent to suppliers, and the audit log for the event indicates that an amendment was completed.

Once the amended event is created, you will see it in search results with an Amended icon 📝. You can also continue to access the original event. Once the amended event is approved and reconciled with the original event, you will only see one (the updated)
instance of the event in search results. Since it has been approved and reconciled, it is no longer considered an Amended event.

You may select to enable the notification when an event has completed the Amendment approval process. See Notifications, on page 10 for details. If enabled, suppliers associated with the event will receive an Amendment Completion email and the amendment reason will be included in the Email Template for this email, so long as the amendment reason placeholder field has been added to the amendment email template.

Amend an Event

An event may be amended if it has been approved and is Opened or Released. A user must be an Event Owner or Event Manager for the event in order to see the Amend action.

Step-by-Step

The goal of this task is to amend an event.

1. Search for an Event and select the appropriate Event Number from search results.
2. Select the Amend action from the Workflow Actions drop-down.
3. The Confirm Amendment pop-up window displays. Users may enter up to 500 characters explaining the amendment reason.

   Note: Once the amendment is completed, suppliers associated with the event will receive an Amendment Completion email and the reason will be included in the Email Template for this email, so long as the amendment reason placeholder field has been added to the amendment email template.

4. Click Submit.
5. The page is refreshed with a banner message that the event is being amended and is in Draft Status.
6. Make changes to the event as appropriate.
7. As changes are made to items that require a supplier response, you will see a confirmation message that supplier responses to the edited item will be discarded. Select Yes to continue with the edit.
8. When all changes have been made, navigate to Review and Submit page.
9. Select the button Submit for Approval to submit the amended event for reconciliation.
10. You will see a confirmation that your amended event has been submitted for approval.
11. Once approved, you will see a banner message on the event that the event has been amended and have the ability to view amendment changes.

Canceling an Event

If an event has been approved but has not yet reached the Open or Release date, you may **Cancel** the event before it becomes visible to suppliers. A user must have permission to approve events in order to see the **Cancel Event** option in the **Workflow Actions** dropdown.

Once the event is visible to suppliers, the **Cancel Event** action is no longer available. At that point, the user can choose to Withdraw the event instead (with the appropriate permission).

**Note:** For multi-stage events, if an event stage is canceled before it is released, the previous stage becomes active.

Cancel an Event

An event may be canceled if it has been approved but has not yet reached the Open or Release date (is not visible to suppliers). A user must have the permission to approve events in order to see the Cancel action.

**Step-by-Step**

The goal of this task is to cancel an event not yet visible to suppliers.

1. Search for an Event with a status of Approved; one that is not yet visible to suppliers.
2. Select the **Workflow Actions** drop-down, then select **Cancel Event**.
3. The event is canceled. The action is captured in the audit log and is available by selecting the **History** hyperlink.
4. The event will not be made available to suppliers. You may choose to Archive the event so it will not be visible in event search results by default.

Withdrawing Events

Once an event is Open or has been Released and is visible to suppliers, you may choose **Withdraw Event** from the **Workflow Actions** drop-down if the event if it is no longer valid. A user must have **Withdraw Events** permission in order to have the ability to withdraw the event.

When the event is **Withdrawn**, the supplier will see the event has been canceled and cannot respond.
Withdraw an Event

An event may be withdrawn if it has been approved and is Opened or Released (visible to suppliers). A user must have the Withdraw Events permission to see the Withdraw action.

Step-by-Step

1. Search for an Event and select the appropriate Event Number from search results.

2. From the Workflow Actions button dropdown, select Withdraw Event.

3. A message displays asking you to confirm that you would like to withdraw the event. Click Yes to confirm.

4. The event is now withdrawn and suppliers do not have access to respond.

5. Changes are captured in the audit log for the event, and can be viewed by selecting the History hyperlink.

Closing Events Early

Once an event is Open, you may choose Close Early from the Workflow Actions drop-down if the event is no longer valid. A user must have Close Events Early permission in order to have the ability to close the event.

When the event is Closed Early, the supplier will see the event has been canceled and cannot respond.

Step-by-Step

1. Search for the Event and select the appropriate Event Number from search results.

2. From the Workflow Actions button dropdown, select Close Event Early.

3. A message displays asking you to confirm that you would like to close the event. A textbox is available for documenting the reason for the early closure. Note: It is recommended that you document the reason.

4. Click Yes to confirm.

5. The event is now closed. Suppliers receive an email alerting them to the event status change. Suppliers may view the event, but they do not have access to respond.

6. Changes are captured in the audit log for the event, and can be viewed by selecting the History hyperlink.
Extending Events

Once an event has been approved and has been Opened or Released, you may edit some of the event dates by selecting to Extend the Event. A user must have Create/Own Events or Manage work group Events permission in order to have the ability to Extend the event. The user must also have the ability to edit the event as an Event Owner or an Event Manager.

When the Event is in an appropriate status and the user has the appropriate permission, Extend Event is an option in the Event Actions drop-down. Once selected, an Extend Event overlay shows with the ability to edit the following:

- Close Date
- Sealed Bid Open Date (if sealed bid process is being used on the event)
- Q&A Submission Close Date

Upon selection of the new dates, they are reflected in the event. You may select to enable the notification when event dates have been extended. See Notifications, on page 10 for details.

Note that you cannot extend an amended event. The event must first complete the amendment before Extend Event is available.

Extend an Event

An event may be extended if it has been approved and is Opened or Released. A user must be an Event Owner or an Event Manager for the event in order to see the Extend Event action.

Step-by-Step

The goal of this task is to Extend dates for an event.

1. Search for an Event and select the appropriate Event Number from search results.
2. From the Event Actions hyperlink, select Extend Event.
3. An Extend Event overlay displays with the option to change the following:
   a. Close Date - You may select a different close date and time.
   b. Sealed Bid Open Date - This option is available if your event is configured to use Sealed Bids. Select to edit the date and time, or to be the same as close date for the event.
c. **Q&A Submission Close Date** - Select a different date and time, or to be the same as the close date for the event.

4. Click **Save Changes**.

5. The updated dates are reflected on the event.

6. Changes are captured in the audit log for the event, and can be viewed by selecting the **History** hyperlink.

### Reopening an Event

Once an event is closed or under evaluation, you may choose to modify the close date by selecting to **Reopen Event**. A user must have the Reopen Events permission in order to have the ability to Extend the event. The user must also have the ability to edit the event as an Event Owner, Event Manager or Event Awarder.

When the Event is in an appropriate status and the user has the appropriate permission, the **Reopen** option shows in the **Workflow Actions** drop-down on the event. Once selected, an **Extend Event** overlay shows with the ability to edit the following:

- Close Date
- Sealed Bid Open Date (if sealed bid process is being used on the event)
- Q&A Submission Close Date

Upon selection of the new dates, they are reflected in the event. You may select to enable the notification when events have been reopened. See **Notifications**, on page 10 for details. Suppliers and users associated with the event are sent notifications that the event has been reopened.

### Reopen an Event

An event may be reopened if it is Closed or Under Evaluation. A user must be the Event Owner in order to see the Reopen action.

### Step-by-Step

The goal of this task is to delete a draft event.

1. Search for an Event and select the appropriate Event Number from search results. The Event must have a status of Closed or Under Evaluation.

2. From the **Workflow Actions** drop-down, select **Reopen**.
3. An **Extend Event** overlay displays with the option to change the following:
   a. **Close Date** - You may select a different close date and time.
   b. **Sealed Bid Open Date** - This option is available if your event is configured to use Sealed Bids. Select to edit the date and time, or to be the same as close date for the event.
   c. **Q&A Submission Close Date** - Select a different date and time, or to be the same as the close date for the event.

4. Click **Save Changes**.

5. The updated dates are reflected on the event.

6. Changes are captured in the audit log for the event, and can be viewed by selecting the **History** hyperlink.

7. Notifications are sent to Event users and affected suppliers as appropriate.

**Archiving an Event**

Archiving an event makes the event not visible by default when searching for events. The Archive action is available to users with the Archive Events permission. You can Archive events that have a status of:

- Awarded
- Canceled
- Withdrawn
- Closed Without Awarding (when an event is rejected in Evaluation Workflow)

Select to **Archive** from the **Workflow Actions** drop-down.

You can view archived events by selecting to **Include Archived Events** in advanced search of sourcing events. You can select to **Restore from Archive** if you want the event to be visible by default to users.

**Archive an Event**

An event may be archived if you do not want it to show in search results by default. An event that has been Canceled, Withdrawn, or Awarded may be archived. A user must have the Archive Events permission in order to see the Archive button on an event.

**Step-by-Step**

The goal of this task is to archive an event.
1. Search for an Event that has been withdrawn, canceled, or awarded.

2. Select the Event to view details.

3. Select the Workflow Actions drop-down and select Archive.

4. The page refreshes and the event is now archived. The archive action is captured in the audit log and available by selecting the History hyperlink.

5. To remove the event from archive, click the Restore from Archive button on the event.

Export Event Information

Users with access to view an event have the ability to export event information into a PDF file. The user may select to export all or only parts of the event. Any user with access to view or edit an event will see an option to Export Event as PDF. The option is available:

- from Event search results, the Manage Events dropdown
- when viewing an Event, in the Event Actions dropdown

Note that if Confidential Pricing is enabled for an event and you are not included in the Event Price Viewers access group for the event, you will see the word Confidential anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

When selecting to Export Event as PDF, an overlay displays with the following:

- Confirmation of the Event to Export. The Event name is listed as read-only to ensure you are exporting the desired event.

  - File Name. A default value is provided that is the event number and date requested, but you may enter any file name. This information is required.

  - Export Description. Enter an optional description for the export.

  - Content to Export. Select from these options:

    - All event sections, responses and attachments - With this option, all information in the event will be exported.

    - Let me pick – When selecting this option, the user can choose to export specific parts of the event information. Only sections pertinent to the particular event being exported will be shown.

    - Email when Export is Ready. You may select to receive an email when the export is ready. The checkbox will be enabled (or not) according to your selection for the Sourcing - Exports Notification Preference in your user profile, but can be changed
for this export request. Select the What's This hyperlink in the overlay for more information.

Once the user has submitted the export, a confirmation displays with a link to navigate to the export page. The Event information is exported into a zipped file format, with individual folders and files.

Exports for Multi-Stage Events

If you select to export an event that is part of multi-stage event, you are given the following options in the overlay for Content to Export:

- **Current Stage: All Sections, Responses, and Attachments** - With this option, all information in the event will be exported for only the current stage.

- **Event: All Stages, Sections, Responses and Attachments** - This option will export all information for all stages associated with this event stage.

- **Customize Export** - This option allows you to choose specific stages to export, and the specific content within those stages to export:
  
  - **Event Stages(s)** - Select from your named event stages.
  
  - **Stage Content** - Select from the same options as for a single event:
    
    - **All event sections, responses and attachments** - With this option, all information in the event will be exported.
    
    - **Let me pick** - When selecting this option, the user can choose to export specific parts of the event information. Only sections pertinent to the particular event being exported will be shown.

The Exports Page

Exports are provided on the Events tab of the View Exports page located at: Sourcing > Sourcing Events > View Exports > Events. A user with access to view events can navigate to this page, but will only see exports for those events to which they have access.

Information on the View Exports > Events page includes:

- **Status**: The status of the export request displays. If it has not completed, the user may select the Refresh this Page button to see an updated status.

- **File Name**: Click on the file to open or download the zipped file.

- **Description**: If a description was entered for the export request, it will display here.

- **Event Number**: The Event Number that was exported, along with a link to view the event.
- **Export Date and Time.** The date and time the export was requested. This can let you know if the most recent information for the event was exported.

- **Exported by.** The user who requested the export.

- A message displays indicating the number of days before the file will be deleted from the page. The default value is 7 days, but your organization may configure a different value in the General Sourcing Configuration settings.

- You may also select to manually delete an export by selecting the row and clicking **Delete Selected Exports** link.

### The Export File Format

The file is exported in zip format, with folders for the various sections of the event, as was requested in the export.

- **Event** folder contains the PDF file with the event information except for attachment and supplier response details. This folder also contains the audit history file for the event.

- **Attachments** folder contains the attachments for the event, organized by the page on which they are included.

- **Supplier Responses** folder contains the details for each supplier that has submitted a response.

If the request is for multiple stages, the zip file will contain a folder for each of the stages.

### Export Event PDF

Users with access to view an event may export all or part of the event information into a PDF file.

### Step-by-Step

The goal of this task is to export event information in PDF format.

Note that if **Confidential Pricing** is enabled for an event and you are **not** included in the **Event Price Viewers** access group for the event, you will see the word **Confidential** anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

1. Navigate to an event in any status.
   a. From Event search results, select the **Manage Events** dropdown, and the **Export Event as PDF** option.
b. When viewing an event, select **Event Actions**, then **Export Event as PDF**.

2. An **Export Event** overlay displays:
   a. The **Event to Export** is listed as read-only for your confirmation.
   b. The **File Name** is provided based on the event number and date of the request. You may edit the **File Name**.
   c. You may provide an optional **Export Description**.
   d. For single stage events, Select the **Content to Export**:
      i. **All Event Sections, Responses and Attachments**.
      ii. **Let me pick**. If you select this option, you will be presented with sections of the event. Select which sections you want to be exported.
   e. For multi-stage events, select the **Content** to export:
      i. **Current Stage: All Sections, Responses and Attachments**. With this option, only the current stage information will be exported.
      ii. **Event: All Stages, Sections, Responses, and Attachments**. With this option, all of the event stages will be exported. The information for each stage will display in separate folders in the zip output file.
      iii. **Customize Export**. Choose this option to select specific stages and/or specific event sections to include in the export request. Additional options will display as listed in step 2d.
   f. You may select to receive an email when the export is ready. The checkbox will be enabled (or not) according to your selection for the **Sourcing - Exports Notification Preference** in your user profile, but can be changed for this export request. Select the **What's This** hyperlink in the overlay for more information.
   g. Click **Submit** to request the export.

3. An overlay displays with confirmation that your export was requested. You can select to **Go to Page: Download Export Files** or **Close** the overlay.

4. To access the export files, navigate to **Sourcing > Sourcing Events > View Exports**, and select the **Events** tab. You will only see exports for events to which you have view or edit access.
   a. The status of the export request displays. If it has not completed, the user may select the **Refresh this Page** option to see an updated status.
   b. When available, select to download or open the file.
   c. You may select to manually delete an export by selecting the row and clicking **Delete Selected Exports** link.
Event History

Event history is accessed by selecting the History hyperlink at top right when viewing the event.

The history is displayed in a pop-up, organized into the following tabs:

- **Event History** - The log of changes to event configurations and values.
- **Email History** - The log of emails sent related to the event. If more than one person received the email, a hyperlink to *Multiple Recipients* generates an Excel file where you can view all email addresses for recipients of the email.
- **Supplier History** - The log of response actions by a supplier user for the event. Actions related to *Prerequisites*, *Intent to Bid*, and *Submitting the Response* are logged. You may filter the results by searching by start date, end date, action, section, or supplier. You may also select the *Export CSV* link to export the history on this page.

**Event History**

When viewing an event in Draft status, history for the *current* section shows by default. When viewing an event not in Draft status, history for *all sections* of the event shows by default. The information logged includes:

- **Date** - The date and time the edit was made.
- **User** - The user who made the change. For some actions, the system actually made the change.
- **Action** - The action that was done as part of the edit.
- **Section** - The section of the event that the edit was made.
- **Subsection** - The subsection of the event where the edit was made.
- **Context** - Additional information of where the action occurred, such as a workflow step.
- **Field** - The field that changed.
- **Old Value** - If applicable, the previous value for the field.
- **New Value** - The changed value for the field, as a result of the action.
- **Note** - If there was an opportunity to include a note for the action, it will display here.

To filter the results by specific criteria, select the *Filter History* hyperlink. You have the option to filter by:
• **Start Date** and/or **End Date** - To see history before or after a certain date.

• **Action** - Filter to see entries for specific actions, such as created, deleted, etc.

• **Section** - Filter to see only entries for a specific section of the event.

You may also **sort** the history results by selecting the column heading. You may sort by **Date**, **User**, **Action**, **Section**, **Subsection**, or **Context**.

The **Event History** may be **exported** as a single file. On the **Event History** tab, select the **Export CSV** link. The file may be opened or saved immediately.

**Email History**

**Email History** includes the following information:

• **Email Display Name** - The name of the email that was sent. You can refer to these emails in the Email Management section of your application.

• **From**- Who the email originated from. System emails will show as being sent by the organization.

• **Recipient**- The email address for the recipient of the email. If there was more than one, a link for **Multiple Recipients** will show. When selecting the link, you will be given the opportunity to view or save an Excel file containing the recipient email address and date/time the email was sent.

• **Date**- The date the email was sent.

To filter the results by specific criteria, select the **Filter History** hyperlink. You have the option to filter by:

• **Start Date** and/or **End Date** - To see history before or after a certain date.

• **Email Display Name**- Filter to see entries for a specific email.

You may also **sort** the history results by selecting any of the column headings.

**Supplier History**

**Supplier History** includes the following information:

• **Date** - The date and time the edit was made.

• **Supplier** - The supplier for which the edit was made.

• **User** - The supplier user who made the change.

• **Action** - The action that was done as part of the edit.
• **Section** - The section of the event that the edit was made. Only **Intent to Bid** and **Prerequisite** sections are logged. A **Response Submitted** action is considered part of the Intent to Bid section.

• **Subsection** - The subsection of the event where the edit was made.

• **Context** - Additional information of where the action occurred, such as a workflow step.

• **Field** - The field that changed.

• **Old Value** - If applicable, the previous value for the field.

• **New Value** - The changed value for the field, as a result of the action.

To filter the results by specific criteria, select the **Filter History** hyperlink. You have the option to filter by:

• **Start Date** and/or **End Date** - To see history before or after a certain date.

• **Action** - The action that was performed by the supplier.

• **Section** - The section of the event in which the action was performed.

• **Supplier** - Enter a search term for the suppliers on the event to filter entries for a specific supplier.

You may also **sort** the history results by selecting the column heading. You may sort by **Date, Supplier, User, Action, Section, Subsection, or Context**.

**Sealed Events**: The Supplier History tab is not available for sealed events until the sealed bid open date has been reached.

**View and Export Event History**

A user may view the changes to an event by selecting the History hyperlink in the Event. By default, changes for the current page will show. You may also choose to export the history log.

**Step-by-Step**

The goal of this task is to view and export the history of changes for an Event.

1. You may navigate to search for and select an event by any of the following ways:

   a. Navigate to **Sourcing** > **Sourcing Events** > **Search Events**. Enter search criteria and select an event from the result set.
b. From the **Sourcing Events Home**, select the type of event (i.e. Active, Draft, Pending, etc.) to view those event results. Select an event from the result set.

c. From the **Sourcing Events Home**, select an event number from the list of events in **Upcoming Key Events Dates**.

2. Select the **History** hyperlink on the event. The history overlay opens.

3. View the **Event History** tab to see changes related to the Event.
   a. Select the **Filter History** hyperlink above the history log to see filter criteria.
      i. Enter a **Start Date** to see history after a specific date.
      ii. Enter an **End Date** to see history before a specific date.
      iii. Select from the **Actions** drop-down to see history for a specific type of event action.
      iv. Select from the **Sections** drop-down to see history for a specific section in the event.
   b. **Sort** the history results based on result values. You may sort by Date, User, Action, Section, Subsection or Context.
   c. Select a different Result per page from the drop-down, if appropriate.
   d. Select to paginate through results by selecting the left or right arrow buttons for Page x of x.
   e. Select the **Export CSV** hyperlink to open an Excel file of the history log. View the file.

4. View the **Email History** tab to see an audit log of emails sent to the supplier for this event.
   a. Select the **Filter History** hyperlink above the history log to see filter criteria.
      i. Enter a **Start Date** to see emails sent after a specific date.
      ii. Enter an **End Date** to see emails sent before a specific date.
      iii. Select from the **Email Display Name** drop-down to see a specific email sent.
   b. **Sort** the history results based on result values. Click on any column heading to sort by that value.
   c. Select a different Result per page from the drop-down, if appropriate.
   d. Select to paginate through results by selecting the left or right arrow buttons for Page x of x.
5. View the **Supplier History** tab to see changes made by supplier users for the Event.  
   *(Note: The Supplier History tab is not available for sealed events until the sealed bid open date has been reached.)*

   a. Select the **Filter History** hyperlink above the history log to see filter criteria.
      
      i. Enter a **Start Date** to see history after a specific date.
      
      ii. Enter an **End Date** to see history before a specific date.
      
      iii. Select an **Action** to limit results to a particular type of action performed by the supplier.
      
      iv. Select a **Section** to see history related to a particular section of the event.
      
      v. Enter a search term in the **Supplier** field to see changes by a specific supplier.

   b. **Sort** the history results based on result values. You may sort by Date, Supplier, User, Action, Section, Subsection or Context.

   c. Select a different Result per page from the drop-down, if appropriate.

   d. Select to paginate through results by selecting the left or right arrow buttons for Page x of x.

   e. Select the **Export CSV** hyperlink to open an Excel file of the history log. View the file.

**Event Search**

Navigate to **Sourcing > Sourcing Events > Search Events** to use simple or advanced search for sourcing events. When searching for events, you are only shown events to which you have access to view or edit.

When searching with **Supplier Name** as a criteria, the search results will include manually invited suppliers. **Note:** Manually invited suppliers must be entered in the Supplier Name filter. They will not be found using autocomplete or the search functionality.

**Simple Search**

Navigate to **Sourcing > Sourcing Events > Search Events** to use the **Simple Search** to find events by an Event Number, Event Title, or supplier on the event. You may also select a date criteria in simple search from the drop-down. You may also use **Quick Search** by selecting the search icon in the upper right navigation and select to search for Sourcing Event.
Advanced Search

Select the advanced search options to see additional criteria for finding a sourcing event:

- **Sourcing Event Identification** - Search by event number, event title or stage title.
- **Sourcing Event Information** - Search by Event Type, a specific date type and criteria, Supplier Name, commodity codes, event status and more.
- **Custom Fields** - Enter your search criteria for any custom fields that have been enabled for advanced search.
- **Workflow** - Search by an event approval workflow step or evaluation workflow step.
- **Panel Questionnaire** - Search by the Questionnaire Status, the user's role on the questionnaire, or for your particular questionnaires in a specific status.

Event Search Results

Once you have entered your search criteria, search results for events you have access to see/edit will display. Included on the search results page:

- **Back to Edit search / Start New Search** - Select these hyperlinks to either add to your current search criteria or start with a new search.
- **Filtered By** panel - Indicates the criteria you used for the search results.
- **Refine Search Results** filters - Various filters are available to further refine your results, including Date Range, Supplier, Bid Strategy, Event Type, Event Status, Work Groups, and Amend Status. Select a value to see results meeting the desired filter criteria. Select the [more] hyperlink to see additional filter criteria where not all values are displayed.
- **Save Search** - You can save a search that you will execute on a repeated basis. For example, if you routinely search for events of a certain status, you could save that search and access it from your saved searches page instead of having to enter the criteria again.
- **Export Search** - Select to export your search results to a **Summary** report or **Supplier Participation** report. See **Event Search Exports**, on page 171 for additional information.
- **Search results** - Event search results show with basic information about the event. You can select an Event Number to see the event details.
  - **Results per page** - Set the number of event results you want to see per page.
  - **Sort by** - The default sort is **Event Status in Ascending** order. Choose from other options to sort the results differently.
- **Pagination** - Select a page number or click the left/right arrows to move to the next/previous page.

- **Event Information** - the following summary information is displayed for each event:
  - Event Status - an Icon will indicate if the event uses Sealed Bid, is an Amended event, a Draft, or is Public Event.
  - Event Details, including the Event Name as well as:
    - Event number
    - Event type
    - Key dates (displayed in the user's time zone, if configured)
    - Bid response information
  - Click on the Event Name to view the event details, or select **Manage Event**.

**Viewing an Event within Search Results**

When you click on an Event Number from search results, you are taken to the event details. A banner across the top provides a hyperlink **Back to Search results** to return to your results list. You may also click through the result list, or select from the Event Number drop-down to navigate to another event in the result set.

**Search for an Event**

You may search for events to which you have access. To have access to an event, you must be assigned as an Event Owner, Event Creator, Event Manager or Stakeholder for the event.

**Step-by-Step**

The goal of this task is to search for events. A user may search for events from the Sourcing Events Home page (depending on its configuration) or by the Search Events page.

**From the Sourcing Events Home:**

1. Navigate to the Sourcing Events Home: **Sourcing > Sourcing Events > Sourcing Events Home**.

2. In the Search Events widget enter an **Event Number** or a term from the Event Title.
3. Click the **Search** button.

4. Results display according to your criteria.

**From the Sourcing Events Search:**

1. Navigate to **Sourcing > Sourcing Events > Search Events.**

2. Use the simple search to search by the Event Number of a term from the Event Title. You may select a date criteria to see events created in a specific date range.

3. Click the **advanced search** hyperlink to see advanced search options and enter criteria in any of the appropriate fields:

   a. **Sourcing Event Identification**: Enter a specific Event Number, Event Title or Stage Title.

   b. **Sourcing Event Information**:
      
      i. Begin entering an **Event Type** and select from available options; or, select the search icon and choose one or more event types.

      ii. **Date**: Select the type of date and corresponding date criteria.

      iii. **Work Groups**: Search by work group(s).

      iv. **Event Creator**: Search by event creator(s).

      v. **Stakeholder**: Search by stakeholder(s).

      vi. **Supplier Name**: Enter all or part of a supplier name.

      vii. Select to search for events using your organization **Commodity Codes**. Results will be returned with commodity codes associated to the event or items.

     viii. Select to see events with one or more **Participants**. Enter a user's name, username, or email.

     ix. Select one or more **Event Status** options. Events in any of the selected status will be returned.

     x. Select to see events by **Public Visibility**. If your organization uses the Public Site, select to see events that are Public only, Private only, or either.

     xi. Select to see events by **Bid Strategy**: Both Sealed and Non-sealed Bids, Sealed Bids Only, or Non-sealed Bids Only.

     xii. Select from **Auction Events** to see all, live, or mock auction events.

     xiii. Select if you would like to **Include Archived Events** in the search results.
c. **Custom Fields** - Enter your search criteria for any custom fields that have been enabled for advanced search.

d. **Workflow:**
   
i. Begin entering a **Current Workflow Step - Approve Event** or select the search icon to see all options.
   
   ii. Begin entering a **Current Workflow Step - Evaluation** or select the search icon to see all options.

  
e. **Panel Questionnaire** - Search by the Questionnaire Status, the user's role on the questionnaire, or for your particular questionnaires in a specific status.

f. When done entering criteria, click **Go** to search.

g. Search results display according to your criteria.

**From Quick Search in Top Right Navigation:**

1. Select the search icon \( \text{Search Button} \) in the top right navigation.

2. Select **Sourcing Event** from the left drop-down. In the search box, enter your sourcing event criteria such as name or number.

3. Click the search icon.

4. Sourcing Event results display with the event number and name. Select the appropriate result to navigate to that event.

**Event Search Exports**

Once you have entered your search criteria, search results for events you have access to see/edit will display. Included on the search results page:

- When viewing sourcing event search results, an **Export Search** button is available. When selected, you may choose from the following Request Export Templates:

  - **Summary** - A summary of information about the events in search result, including event title, type, dates, items, and other basic configuration settings.

  - **Supplier Participation** - Information about the supplier responses for the events in search results, including basic event information, progress in responding to each event, and supplier contact information. **Note** that all events will not be included in this report:

    - Only those events to which suppliers have the ability to respond will be included. For example, draft events would not be included in this report, even
if it was displayed in the event search results.

- Sealed events cannot be exported until the sealed bid open date.
- Reports are provided in Excel format.
- To view and download the export files, navigate to Sourcing > Sourcing Events > View Exports - Searches. This page lists all the requested search result exports. A user will see only those exports that they have requested.

Export Event Search Results

Users with access to view events may choose to export event information into a Summary Report or a Supplier Participation Report.

**Step-by-Step**

The goal of this task is to export event search results.

1. Search for sourcing events and view results.
2. Select the Export Search button in the left panel. A Document Search Export overlay displays.
3. Enter a File Name for the export. This field is required.
4. Enter an optional description for the export, such as "Events Under Evaluation".
5. Choose a Request Export Template:
   a. Summary - A summary of information about the events in search result, including event title, type, dates, items, and other basic configuration settings.
   b. Supplier Participation - Information about the supplier responses for the events in search results, including basic event information, progress in responding to each event, and supplier contact information. Note that not all events will be included in this report:
      - Only those events to which suppliers have the ability to respond will be included. For example, draft events would not be included in this report, even if draft events are displayed in the event search results.
      - Sealed events cannot be exported until the sealed bid open date.
6. Optionally choose to include custom field data on the export be selecting the Include Custom Fields checkbox.
7. Click Submit.
8. A confirmation message displays that the request has been submitted, with directions for navigating to the page where the file may be accessed. You may close the message, or select the button to navigate to download the export.

9. On the Sourcing > Sourcing Events > View Exports - Searches page, all search exports the user has requested are listed. When the status indicates the request has completed, a file link is available for download.

Events and Requisitions

Customers with Sourcing and eProcurement can initiate a sourcing event from a purchase requisition, and can create a requisition or cart from an awarded sourcing event. The organization’s workflow must support creating an event from a requisition. The ability to create a requisition or cart from an awarded event does not require special configuration.

Create Cart/Requisition From Sourcing Event

Customers with Sourcing and eProcurement have the ability to create a shopping cart or purchase requisition from an awarded event within Sourcing. The options available are dependent on if the event originated from a requisition line item in eProcurement, or from within Sourcing. Organization settings are available to allow for carts and/or requisitions being created from sourcing events, as well as the use of procurement forms.

Configuration

The eProcurement section of General Sourcing Settings contains two configuration options for sourcing events with requisitions:

- The Awarded Event Creation Setting controls the options a user will have when selecting to initiate an eProcurement process from an awarded event.
  - Carts and Requisitions - The default selection, which will allow users to create either a Cart or Requisition from an awarded sourcing event.
  - Carts Only - Will give the user the option to create a cart from a Sourcing Event, and no option to create a requisition.

- The Default Procurement Form allow special handling of the created Requisition. Items will be mapped from the sourcing event to the new requisition via the form, and appear as a line item within the requisition.
  - If a Default form is not used, you may choose one of your own organization forms as the form that will be populated with the appropriate sourcing event item information (including product description, unit of measure, quantity and unit price). Forms available for selection include your organization forms that:
- are active
- do not have Limit Supplier Selection enabled
- are not multi-line

- You do not have to select a form. If you do not select a default form, all of the referenced items will show in the requisition as non-catalog items.

**Initiating the Procurement Process**

When a Sourcing Event has been awarded to one or more suppliers, a user may select from Event Actions to Initiate Procurement Process.

If the sourcing event originated from a purchase requisition, the user may have the option of creating a purchase requisition OR a shopping cart, depending on the organization's Award Event Creation Setting. If the event originated from Sourcing, the user can create a shopping cart, without the option of creating a purchase requisition. You will also be given the opportunity to designate a different Prepared by/For user.

The appropriate document will be created in eProcurement with details from the sourcing event such as item information, awarded supplier, and delivery dates, according to the configured Default Procurement Form. The Sourcing Event will display, within the event navigation panel, appropriate identification information for carts or requisitions created in eProcurement.

Event-awarded items that are part of a requisition will display an icon 🎨 to visually indicate that the items were awarded from a sourcing event.

When a requisition has line items that require sourcing and items that do not, then all non-sourced items are included in the created Purchase Order, and all sourced items will continue through the fulfillment process.

- A purchase order will be created that includes only the non-sourced items, and the original Requisition will be marked as Complete.
- The sourced items will be managed through the assigned sourcing event, and ultimately be procured through a new requisition.

You may search for requisitions and events based on their relationship to each other and where the document originated.

User may want to enable the notification preference for PR created from an Awarded Sourcing Event in order to receive an email and/or in-application notification when a PR is created from an awarded event.

**Create Sourcing Event from Purchase Requisition**

Customers with eProcurement may initiate sourcing events from a Purchase Requisition. When the event has been awarded, the results are directed back into the eProcurement
Requisition workflow for order fulfillment. From a requisition in workflow, users have the option to indicate a line item Requires Sourcing. The item will be flagged with an icon.

With the appropriate workflow in place, a user will have the ability to Initiate a Sourcing Event for the items flagged as requiring sourcing.

Upon initiating the event creation process, the user enters basic event information such as the Event Title, Event type, and associated work group.

- The sourced Item Description and Quantity are included from the requisition information. There is also an option to import the Ship-To-Address from the requisition to the sourcing event. Basic product information is transferred from the requisition, and can be edited within the sourcing event. Form data may also be transferred to the sourcing event.

- The requisition displays high level details about the on-going sourcing event, so that users can monitor the event's progress from within eProcurement.

- The requisition displays a link to the created sourcing event, allowing users with appropriate permissions to easily navigate to the event for more detailed information.

- The sourcing event displays the associated requisition information.

- Users may choose the option to Create & Go to Event, which leaves the event-originating PR in Incomplete status in the Workflow folder from which the event was generated. Alternately, users with Approve/Reject Requisitions or Approve/Reject Requests permission can choose to Approve PR Workflow Step on the Create Event overlay to automatically approve the source PR out of the current workflow step when the event creation process is launched.

After the sourcing event has been awarded, the results can then be directed back to the requisition workflow for order fulfillment.

Icons display in the requisition search results, indicating requisitions that have:

- Awarded line items from a sourcing event.

- Line items out for sourcing.

Users may want to enable the notification preference for Sourcing Event created from Requisition, sent when a sourcing event is created from a requisition the user has created or approved.

Create Cart / Requisition from Sourcing Event

Customers with Sourcing and eProcurement may create a cart or requisition from an awarded sourcing event. Some options vary depending on if the request is being made from an event that originated in Sourcing or an event that originated form a requisition in eProcurement.
Step-by-Step

The goal of this task is to create a cart or requisition from a Sourcing Event. You must select an event that is in **Awarded** status.

**For a sourcing event that originated from Sourcing**

1. Access the awarded event, and navigate to the **Supplier Responses** page.

2. From the **Event Actions** drop-down, select to **Initiate Procurement Process**.
   a. An overlay displays confirming you will be creating a shopping cart.
   b. If appropriate, select a different user for whom the cart will be created, and click **Continue**.

3. The page refreshes, indicating the created document number in the event information.

4. You may navigate to the cart in eProcurement and note the Sourcing Event reference.

5. Finish adding any appropriate details to the cart and submit for approval.

**For a sourcing event that originated from an eProcurement Requisition**

1. Access the awarded event, and navigate to the **Supplier Responses** page.

2. From the **Event Actions** drop-down, select to **Initiate Procurement Process**.
   a. An overlay displays, allowing you to choose to create a shopping cart or requisition (if your organization allows either document).
   b. If your organization only allows the creation of shopping cart, you will not see an option to choose.

3. The page refreshes, indicating the created document number in the event information.

4. You may navigate to the document in eProcurement and note the Sourcing Event reference.

5. Finish adding any appropriate details to the cart and submit for approval.

Create Sourcing Event from Requisition Line Items

Organizations with the appropriate workflow in place may initiate a sourcing event from flagged requisition line items.

Step-by-Step

The goal of this task is to create a sourcing event from requisition line items.
1. Navigate to a cart or requisition that requires a line item to be sourced.

2. Select the line item, and from the **For Selected Items** drop-down, select **Requires Sourcing**. The line item is flagged as Requiring Sourcing.

3. Depending on the organization workflow, the appropriate user may access the requisition and see the item that is flagged for sourcing. Approval steps may be required.

4. The user may now select the item requiring sourcing, and select **Initiate Sourcing Event** from the **For Selected Items** drop-down options.

5. An overlay displays where the user may enter event information:
   a. Enter an **Event Title**.
   b. Select a **work group** for the event.
   c. Select an **Event Type**.
   d. Select a **template** for the event, if appropriate.
   e. Select a **currency**.
   f. Click **Yes** next to **Export Ship-To-Address to Event?** to add the Ship-To-Address from the requisition to the event. Yes is the initial default setting. The address is automatically added as a read-only additional item field on the event and is displayed on line items populated from the purchase requisition. The address is visible to suppliers participating in the event, but cannot be edited by them.

   **Note:** This field has been set so that an applied selection is persistent on a per user basis. This ensures that the option to either include or exclude the Ship-to-Address is effectively defaulted based on the goals of each system user empowered to initiate a sourcing event from an eProcurement document.

   g. Click **Create Sourcing Event**.

6. A confirmation message displays that the event was created.
   a. The line item indicates it is Out for Sourcing.
   b. The requisition indicates the Sourcing Event number, and that the item is Out for Bid.

7. Select the **Sourcing Event number** to navigate to the sourcing event:
   a. To verify and complete event information, including setup configurations, dates, item information, suppliers.
   b. To submit the event for approval so it can be sent to suppliers.
   c. Follow the directions for Creating an Event.
Supplier Response and Evaluations

Supplier Responses and Event Evaluations

Suppliers may begin responding to an event upon the event Released date. As a user with permission to see the event, you may review supplier responses at any time. Once the Close date for the event passes (or it is closed early), the event enters Evaluation workflow. You may then evaluate responses in comparison to each other using evaluation tools, and a response may be awarded.

Updating Supplier Profiles Through Event Responses

If suppliers amend retrieved response data in select fields, users with the Edit Company Profile permission have the option to commit these changes to their Supplier Profile directly from within the event.

Step-By-Step

1. When a supplier clicks the Yes I Intend to Participate option, questions that are linked to Supplier Profile fields will automatically be populated on the event form with the data contained in the associated fields within that vendor's Profile. If there are attachment questions, the attachments are copied from the Supplier Profile in real time.

   a. The questions associated with any empty fields in a supplier's Profile will remain blank. The supplier can manually enter data to answer these questions. If the empty field has an associated drop-down list in the Supplier Profile, suppliers will choose their answer from this drop-down list. Suppliers can also edit any of the data on the event form that has been populated from their Supplier Profile.

   b. When grouped insurance fields are included, the platform selects the first match it encounters for the Group name when auto-populating the associated event questions for a participating supplier. If there is more than one group with the same name in a supplier's organization, a link labeled Change Group will appear beside the grouped field header. Clicking this link will allow users to select the proper group whose data should be used for the associated event question responses.

   c. The following field information can be updated from within the event:
      i. Number of Employees
      ii. DUNS Number
d. Users with the **Edit Company Profile** permission will see an **Update Profile** button located directly beneath the fields that can be updated from within the **Questions** section of a Sourcing event. When they click this button, their data changes are sent to their Supplier Profile.

## Supplier Responses Page

Once an event is released to suppliers, they can begin responding. A **Supplier Responses** page will display in the Event Navigation under the **Evaluations** section.

Note that if **Confidential Pricing** is enabled for an event and you are **not** included in the **Event Price Viewers** access group for the event, you will see the word **Confidential** anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

Additionally, Event Owners and Evaluators are able to toggle the hiding and showing of prices from the **Event Actions** dropdown menu on events. When the event prices are hidden, they are hidden for all users, and users see the words **Event Prices Hidden** in place of prices.

All invited suppliers are shown on the page with information about the supplier's response status:

- **Progress** - An indication if the supplier has viewed the event, declared an intent to bid, in the process of responding or has submitted a response. You may select to sort responses on this field.

  The status of a manually added supplier shows as "Invitation Unaccepted". Once the supplier has registered the status will update to "Event Not Viewed".

- **Response % Complete** - Displays how much of the **required** information for the event the supplier has completed. A number displays once a supplier has viewed the event. Click the number to see details of the required information completed. A value is **NOT** shown if the event is sealed and still in the Open status. The sealed date must have passed to see a value. The pop-up also displays with a count of viewed attachments on the Buyer Attachments, Prerequisites, Items, and Questions pages of a sourcing event.

  - Indetermining the required information:
    - Required Prerequisites are marked as either required to view the event or required to bid on the event.
    - Required Questions are those event questions that have Supplier Response is Required enabled.
• Required Product and Service Items are those items that have Unit Price Is Required enabled. A product item is not considered required if only a delivery date is required without requiring a unit price.

• **Supplier Name** - The supplier who submitted the response. Clicking on the name will allow you to navigate to the supplier's profile.
  
  - Select the icon next to the Supplier Name so see the invited contact names and email addresses.
  
  - Icons indicate if the supplier responded via the public site: 📦, and if the supplier is included on the Panel Questionnaire (if configured) 📌

• **Total Bid** - The total bid from the supplier for the event (if applicable). Some event responses do not include bids. If the event has both required and optional items for bid, two columns are displayed: **Required Items Total Bid** and **Optional Items Total Bid**, with the appropriate values showing for each.

• **View Response** - Click on this button to view the details of the supplier's response. For more information about the information displayed on each page, see **Specific Supplier Response Pages**, on the next page. If the event is in Under Evaluation status, a **Disqualify** option on the drop down menu can be used to disqualify suppliers.

• **Evaluate Selected Responses** - If you do not want to evaluate all responses from the Evaluations Actions drop-down, you can select specific supplier responses and click this hyperlink to include only those suppliers in the evaluation.

• **Resend Supplier Invite** - If the supplier has not responded to the invitation, you may select to resend it to the appropriate supplier contacts.

Once an event closes and it is in Under Evaluation status, a drop-down of **Evaluation Actions** is available that allows you to configure the suppliers to include in your evaluation. Disqualified suppliers are excluded from evaluation action results.

• **Evaluate All Responses**- To navigate to a summary page of all responses and take further actions on each response, make recommendations, or select to award.

• **Evaluate Selected Responses** - This option shows only if you have selected one or more responses on the page. Selecting this option after selecting specific supplier responses will take you to the side-by-side navigation with only the selected suppliers.

• **Export All Responses** - To export the information to an Excel file for further analysis.

• **Add Selected to Panel Questionnaire** - This option is only available if you have selected one or more of the supplier responses and you have a panel questionnaire configured for the event. Select to add the suppliers to the panel questionnaire.

• **Tag Supplier(s) for next stage** - If you are creating another stage for the event, you may select suppliers that will be added to the next stage.
• **Untag supplier(s) for next stage** - If you have tagged suppliers for the next stage of an event, you may select suppliers to untag so they will not be moved to the new stage.

If you have saved any evaluation scenarios, a **Load Saved Scenario** button displays. Select and choose which scenario you would like to view. You can also delete scenarios from this page unless they are Finalized.

**Note:** Saved scenarios with disqualified suppliers cannot be loaded. A warning message at the top of the Load Saved Scenario page will indicate that there are scenarios with a disqualified supplier. The affected scenario will not have a Load button. Instead, an information icon is displayed and when clicked, will show the message "This scenario has a disqualified supplier".

**Event Actions** are available to copy or export the event. If the event is configured to allow proxy bids, you will also see the option to **Designate Suppliers for Proxy Bidding** in the **Event Actions** drop-down.

Event Owners and Evaluators are able to toggle the hiding and showing of prices from the Event Actions dropdown menu on events by selecting **Hide Event Prices**.

If you are an approver, you will see a drop-down for **Workflow Actions** where you may choose from options appropriate for your user permissions and status of the event. See **Evaluation Workflow**, on page 206 for additional information.

**Specific Supplier Response Pages**

When you have selected the **View Response** button from the **Supplier Responses** page, you may see the responses provided by the specific supplier. Select any of the pages to see details for the supplier’s response. You may view and download attachments provided by the supplier.
On the **Items** page, select the View Details hyperlink to see additional information for the item. If alternate items were submitted, they are indicated with **ALT** numbering under the original item. The item considered for evaluations by default is indicated with an icon.

**Panel Questionnaire Responses**

**Responding to a Panel Questionnaire**

Once an event is closed and the questionnaire has been configured and published, panelists will receive an email and an in-application notification indicating they have a questionnaire.
to complete. Panelists may navigate to the event from the email or within the application, and begin completing the requested information. The Panel Questionnaire page will be available to any user who has been designated as a panelist, even if that user is not specifically assigned to the work group or event. A user with only view event permissions will see a limited view of the event, allowing them to only respond to the questionnaire. Those users will only see the Panel Questionnaire page when accessing the event. The panelist must complete their response by the Questionnaire Close Date.

On the Panel Questionnaire page, a panelist may select View Questionnaire to be taken to the first supplier response, or go to a specific supplier by selecting Go to Supplier on Questionnaire. The panelist may also choose to Export or Import the questionnaire. This is helpful if the panelist would like to edit the questionnaire in an Excel file format, and then import the responses back into the application.

- If a panelist is assigned to a group of questions, the panelist will see what questions are optional or required.
- If a panelist is not assigned to specific groups/questions, the panelist is only required to complete one group of panel questions for each supplier before submitting their panel response. However, all questions within a single group must be completed.

**Note:** A validation process checks for unrated questions and shows a list of required questions that have not been rated and which require a response rating. Panelists can click on a question link to navigate directly to the question for the express purpose of completing the missing assessment. Once such a question has received the panelist's response rating, it is removed from the list.

- Panelists enter a score for the supplier's responses to the questions according to the rating scale.
- Once the panelist has submitted their response, the panel questionnaire administrator can see the average rating for all the suppliers from the panelist. Note that average ratings will only appear after at least one complete questionnaire has been submitted.
- A panel administrator can choose to export/import a panelist questionnaire on their behalf.
- The Average Questionnaire Response score shows when evaluating event responses.

Email a panelist receives when a questionnaire is published
Dear Sam Stakeholder,

A new panel questionnaire is available for the following event:

**Project:** Office Remodeling  
**Event Number:** TT-ORM-33  
**Event Title:** New Cubicles for Expansion  
**Questionnaire Close Date:** 10/16/2014 at 12:00:00 AM EDT

You can access the panel questionnaire here:

**Please click the link to view the panel questionnaire**

Thank You,

---

**View to a user who only has Panelist access to event**

---

**When select to View Questionnaire - see all the responses at once**
When select to View a specific supplier - Option to page through other responses

Panel Questionnaire Completed - Ready to Submit

Viewing Panel Questionnaire Responses

Once panelists begin entering their scores and comments, an evaluator may view the panelist responses.
The panelist response you are viewing is confirmed in a message at the top of the screen. You can paginate through the results and see all the responses in a read-only view.

When the questionnaire closes, the Suppliers page of the Panel Questionnaire will show the average rating from the submitted panelists.

At this point, the average questionnaire rating will also show on the side-by-side evaluation page.

Complete a Panel Questionnaire

A panelist provides input regarding a supplier's responses to an event. The panelist can review the supplier responses and provide their own responses to be considered by evaluators of the sourcing event.

**Step-by-Step**

The goal of this task is to provide responses on a Panel Questionnaire for a sourcing event. You must be identified as a Panelist for an event.

1. Navigate to an event for which you are designated as a Panelist:
   a. Respond via the link in an email you received as a Panelist for an event.
   b. Search for an Event using Advanced Search, with the criteria being your role as a Panelist in the Panel Questionnaire section of Advanced Search. Select the appropriate event.

2. Select the **My Response** page from the Panel Questionnaire section of event navigation.

3. To view the questionnaire **for all suppliers** at once, select the View Questionnaire button. Proceed to step 5.

4. To view the questionnaire **for a single supplier**, select Go to Supplier on Questionnaire for the appropriate supplier. You may navigate to other supplier questionnaires by selecting the Next and Previous buttons when viewing a single supplier questionnaire. Proceed to nextstep.

5. Review the supplier's responses to the questions.
   a. From the drop-down below the supplier's answer, select your score for the supplier's response, based on the organization's configured rating scale for the event.
   b. Enter an optional comment about your score or the supplier's response.
   c. You do not have to provide a score to all questions in the questionnaire, but you must answer all questions within the same group of questions, or within your assigned group of questions.
6. Click **Save** to save your responses.

7. To return to the event, select **Back to Event**.

8. When finished providing scores for all supplier responses, a confirmation shows that All Suppliers have been rated, and you may submit the panel questionnaire or continue editing. Select **Submit**.

9. You may select to **Withdraw** your panel questionnaire response if you would like to make changes prior to the questionnaire close date.

---

**Export / Import My Questionnaire**

A panelist can complete questionnaire responses in the UI, or they may choose to export the questionnaire for completion offline. The panelist can then import the completed questionnaire into the application.

**Step-by-Step**

The goal of this task is to export a questionnaire as a panelist, complete information, and import the questionnaire into the application.

**Export the Questionnaire**

1. Navigate to an event for which you are designated as a Panelist:
   a. Respond via the link in an email you received as a Panelist for an event.
   b. Search for an Event using Advanced Search, with the criteria being your role as a Panelist in the Panel Questionnaire section of Advanced Search. Select the appropriate event.

2. Select the **My Response** page from the **Panel Questionnaire** section of event navigation.

3. Select to Export Questionnaire from any of the following locations:
   a. From **My Response** page, select **Export or Import**, then **Export Questionnaire**.
   b. From **My Response** page, select **View Questionnaire** to view the questionnaire in the UI. You may select the **Export Questionnaire** button on that page.

---

**Note:** A validation process checks for unrated questions and shows a list of required questions that have not been rated and which require a response rating. Panelists can click on a question link to navigate directly to the question for the express purpose of completing the missing assessment. Once such a question has received the panelist's response rating, it is removed from the list.
c. From My Response page, select a specific supplier and click Go to Supplier on Questionnaire. Click Export Questionnaire on the page.

4. An overlay displays for Export Questionnaire.
   a. A default Description is provided. Edit the description of the file, if needed.
   b. Click Submit.
   c. A confirmation message displays indicating the export request has been submitted. You may select the message hyperlink to navigate to the Panel Imports and Exports page, or select to close the overlay.

5. On the Panel Imports and Exports page, note the status of your requested file.
   a. Select the button to Refresh this Page until the status for your export request shows as Completed.
   b. Click the File name to open the file in Excel.

Editing the Questionnaire File

6. Click the Enable Editing button in Excel to allow editing of the file.

7. Note the instructions for completion on the first worksheet of the file.

8. If the questionnaire is configured to show a single supplier response per page, you will see each supplier listed on a separate tab. If the questionnaire is configured to show all suppliers at once, you will see a tab with your panelist name that contains all suppliers for the questionnaire.

9. Select the appropriate supplier or the panelist name to begin completing the questionnaire responses.

10. Select a rating from the dropdown for each required question/group. You must complete questions/groups according to your group assignment. If a panelist is not assigned to a group, then the questions within a single group must be completed.

11. When finished entering responses, save the file.

Import the Questionnaire Responses

12. Navigate to the event, and the My Response page from the Panel Questionnaire section.

13. Select the Export or Import button, then Import Questionnaire Responses.
   a. Select Browse / Choose File, and select the file to import.
   b. A default File Description is provided. Edit if appropriate.
Select if you would like to **Submit questionnaire response when import completes?**

**Note:** If you select **Yes** but not all required elements of the questionnaire are in the file, the responses are imported but the file is not submitted. The panelist will receive an email indicating the questionnaire could not be submitted.

A validation process checks for unrated questions, allowing the system to show a list of any required questions that have not been rated and which require a response rating. On the **View Questionnaire or Go to Supplier on Questionnaire** page, panelists can click on a question link to navigate directly to the question and complete the missing assessment. Once such a question has received the panelist's response rating, it is removed from the list.

c. **Click Submit.**

de. A confirmation message displays indicating the import request has been submitted. You may select the message hyperlink to navigate to the **Panel Imports and Exports** page, or select to close the overlay.

d. **On the Panel Imports and Exports** page, note the status of your imported file. Select the button to **Refresh this Page** until the status for your import request shows as **Completed.**

### Export / Import A Questionnaire on a Panelist Behalf

A panel questionnaire administrator can export and import questionnaire responses on behalf of another panelist. This may be helpful if the panelist is unable to access the application. A panel administrator can export the file on their behalf, email the file to the panelist, have the panelist return to the administrator, and the administrator import the panelist responses on their behalf.

**Step-by-Step**

The goal of this task is to export a questionnaire for another panelist, complete information, and import the questionnaire into the application.

**Export the Questionnaire**

1. Navigate to an event for which you are a panel questionnaire administrator.
2. Select the **Panelists** page from the **Panel Questionnaire** section.
3. Select **Export or Import**, then **Export Questionnaire for Panelist.**
4. An overlay displays for Export Questionnaire for Panelist.
   a. A default File Description is provided. Edit the description of the file, if needed.
   b. Choose the Panelist for whom you want to export their questionnaire. You may sort panelists by name or by progress.
   c. Click Submit.
   d. A confirmation message displays indicating the export request has been submitted. You may select the message hyperlink to navigate to the Panel Imports and Exports page, or select to close the overlay.

5. On the Panel Imports and Exports page, note the status of your requested file.
   a. Note that the requested file will have the panel questionnaire administrator as the Requested By column, and the panelist selected in the Requested For column.
   b. Select the button to Refresh this Page until the status for the export request shows as Completed.
   c. Click the File name to open the file in Excel.

Editing the Questionnaire File

6. Send the file to the panelist for editing, or enter the responses as appropriate for the panelist.

7. When you receive the completed file back from the panelist, save it for importing. If you have completed the panelist responses, save the file.

Import the Questionnaire Responses

8. Navigate to the event, and select the Panelists page from the Panel Questionnaire section.

9. Select the Export or Import button, then Import Questionnaire Responses for Panelist.
   a. Select Browse / Choose File, and select the file to import.
   b. A default File Description is provided. Edit if appropriate.
   c. Choose the Panelist for whom you want to import their questionnaire responses. You may sort panelists by name or by progress.
   d. Click Submit.
   e. A message displays indicating that all current questionnaire responses for the selected panelist will be replaced with the import file information. Select to confirm.
f. A confirmation message displays indicating that the import request has been submitted. You may select the message hyperlink to navigate to the Panel Imports and Exports page, or select to close the overlay.

g. If the imported file contains all of the required information for the questionnaire, it is automatically submitted.

10. On the Panel Imports and Exports page, note the status of your imported file. Select the button to Refresh this Page until the status for your import request shows as Completed.

Event Evaluations

Once you have supplier responses and any scoring and panel questionnaire responses to consider, you may begin evaluating suppliers.

Evaluations Overview

From the supplier responses page, you will select specific or all suppliers to be included in an evaluation. You are then navigated to a summary page of all the selected responses, also referred to as the Side by Side Evaluations page.

Note that if Confidential Pricing is enabled for an event and you are not included in the Event Price Viewers access group for the event, you will see the word Confidential anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

Additionally, Event Owners and Evaluators are able to toggle the hiding and showing of prices from the Event Actions dropdown menu on events. When the event prices are hidden, they are hidden for all users, and users see the words Event Prices Hidden in place of prices.

When evaluating supplier responses, customers have the ability to:

- View responses side-by-side.
- Sort responses by various criteria.
- Choose the evaluation options to use from different event stages, if the event is multi-stage.
- Choose alternate items, if configured, to evaluate as part of the response.
- If configured for the event, use cost per quality point score, best value score, panel questionnaires, auto scoring and cost analysis as tools for evaluating responses.
- If configured for event line items, the calculated line item, auto-score, and cost analysis results are displayed, and users can view a breakdown of auto-score and cost analysis calculations. They also have the ability to disallow an applied cost adjustment.

- Load and run different award scenarios.

- Add comments to the supplier responses.

- Rank responses.

- Disqualify suppliers.

- Export evaluation information to an Excel file for more complex analysis.

Evaluation Actions

Once you have selected to evaluate all or selected responses from the Supplier Response page on an event, you are navigated to a summary page of all the responses, the Award Scenario page, also referred to as the Side by Side Evaluations page. The page displays up to 5 responses by default on the first page of results. If more than 5 responses are being evaluated, the user will have the ability to transition to the next page of responses. At the top right of the page, the user can specify how many results to display 3 to 5 results per page.

Users with the Create Award Scenarios permission have the ability to run scenarios and save them. Whatever awards are made in a scenario become the "recommendations" for that scenario. Users with the Finalize Award Scenarios permission review the scenarios and can select to Finalize Award for the appropriate scenario.

The follow tabs display on the Award Scenario page:

- You are on the Scenario Navigator tab when you are evaluating and running scenarios. When a scenario is run or saved, an Awarded Scenario column will show the supplier selected for the award for each line item.

- The Scenario Breakdown tab shows where you can "preview" what the awarded scenario will look like.

- The Scenario Savings tab allows evaluators to view cost savings data (relevant to historical price points) for defined award scenarios. With this information, users can perform event-level cost savings assessments and comparisons between award scenarios.

The Scenario Savings tab displays a tabled line-by-line summary of an award scenario, including columns for historical prices, bids, extended spend, and savings vs. historical. Users can customize this Scenario Savings report by selecting fields from the
**Additional Item Fields** section to ensure that the report contains all of the relevant information needed to evaluate the savings impact of each considered award option.

- The **Panel Questionnaire Details** tab provides a detailed view of panel questionnaire ratings and results. The tab is only exposed after the panel questionnaire questions have closed and associated values are calculated. Clicking the Export button also provides access to an Excel spreadsheet export of the questionnaire results to allow further analysis of the data outside of the system.

The Award Scenario page includes the following button options:

- **View Scenario** - Run common scenarios (selections vary depending on the event configuration), including:
  - Lowest Bid Price (SingleSupplier)
  - Best Questionnaire Rating (SingleSupplier)
  - Lowest Bid (SplitAward)
  - Best Auto Score
  - Lowest Cost
  - Lowest Cost per Quality Point
  - Highest Best Value Score
  - Load Saved Scenario - Allows you to select from scenarios you have saved.

- **Save As** - When you have designated awards to suppliers or individual items, click Save As to save the scenario.

- **Reset** - Reset the page so that no scenarios are loaded.

- **Export** - Export all responses, or export the loaded scenario.

- **Finalize Award** - This button displays when you are reviewing a saved scenario to users with the Finalize Award Scenario permission. Selecting this button will award the event to the suppliers/items as indicated in the loaded scenario. The scenario name is now listed with a Finalized button.

To sort responses, choose the sort criteria, and then selecting Ascending or Descending. **Show Supplier Response Notes** is on by default, and allows for displaying/entering comments in the Response Notes field for each supplier displayed on the page. When this checkbox is disabled, the Response Notes field will not show. The available sort criteria are:

- Total Bid

- Product Line Items
• Service Line Items
• Supplier Name
• Supplier Response Completeness
• Auto Score
• Cost Analysis
• Cost Per Quality Point
• Best Value Score
• Average Questionnaire Rating

View the details for product and service line items by clicking the item. An overlay displays with additional item information.

When viewing product line items and service line item information, you will see a Choose Alternate indication if the item is configured to accept alternates and the supplier has submitted an alternate item.

• Select the button to view information about the alternate item. You may choose to base your evaluation/award on the alternate item or the original item.

• See Evaluation Actions, on page 196. for additional information.

Use the Scenario Award Actions after you have selected items and choose from the following options:

• An option exists to Award To [Supplier Name] for each supplier contained in the Evaluation.

• An option exists for No Award.

• When you have items selected and choose one of the options from the drop-down, the item(s) is marked accordingly and the appropriate supplier is displayed for the item in the Awarded Scenario column. The supplier column shows as Pending Award for any suppliers that were awarded any of the line items for the scenario.

**Add a response rank on scenarios:** You choose to Rank Awarded Responses for any suppliers Pending Award in the scenario. This allows users to add a preferred supplier, which is especially helpful in situations where more than one supplier has been marked for awarding. When selected:

• From the Scenario AwardActions, choose Rank Awarded Responses.

• An overlay for Response Ranking displays, and users may enter a rank for the suppliers. Ranks cannot be skipped or contain duplicates. You may choose to sort the ranked suppliers in ascending/descending order in the overlay.
• When the ranking is saved, the suppliers are displayed on the page according to your rank. The Rank is indicated beside each supplier name.

• The rank is saved and displayed on the Scenario Breakdown page.

Remove award from supplier on scenarios: An action for Remove Award From Supplier is available for each supplier on the Scenario Navigation page when viewing a scenario that has suppliers marked as Pending Award. Select the drop-down next to the supplier name to see the option.

• When selecting Remove Award From Supplier, you will be asked to confirm if you want to remove all awards from the supplier on the scenario. If you do, the scenario updates with the supplier no longer being marked as Pending Award.

• Any items that were awarded to the supplier in the scenario will now be marked as Unawarded. If multiple suppliers were awarded the item, the supplier who was selected to have the awards removed will no longer be listed as an awarded supplier for those items.

When a scenario is finalized, a Finalized button shows next to the scenario name. When viewing all saved scenarios for the event, a Finalized button shows for the scenario that has been finalized, and it cannot be deleted from the Load Saved Scenario page. A finalized scenario can only be removed when viewing the scenario.

The Cost Per Quality Point row shows if configured for the event. The supplier must have an average questionnaire rating for this value to show. See Cost Per Quality Point on page 125. for additional information on this evaluation tool.

The Best Value Score row shows if configured for the event. For additional information on this calculation, see Best Value, on page 126.

The Average Questionnaire Rating shows for each supplier if configured for the event. The rating will show as Pending until the Questionnaire Close Date has passed, at which point the average rating will show for each supplier.

An Auto Score row is displayed if auto-scoring is configured for event questions or additional line items. To view auto-scores:

• Each supplier's total Auto Score for the bid is shown in bold under the appropriate supplier column.

• Expand the Questions row to view Auto Score Points assigned to suppliers based on responses to event questions.

• Expand the Questions: Line Items row to view Auto Score Points assigned to suppliers based on responses to line item questions.

• Expand the Product Line Items or Service Line Items rows to view auto scores for all product items or all service items.
If **Cost Analysis** is configured for event questions or event line items, you may view a summary of cost adjustments based on cost analysis configurations.

- Each supplier's **Total Adjusted Bid** is shown in bold under the appropriate supplier column. It shows the sum of the supplier bid with cost adjustments from event questions and line level questions applied.

- Expand the **Questions** row to view cost adjustments assigned to suppliers based on responses to event questions.

- Expand the **Questions: Line Items** row to view cost adjustments assigned to suppliers based on responses to line item questions.

- Expand the **Product Line Items - Adjusted Bid** row to view the sum of all product line items with cost adjustments applied.

- Expand the **Service Line Items - Adjusted Bid** row to view the sum of all service line items with cost adjustments applied.

- A **Disallow/Reapply** option, next to cost adjusted values, works as a toggle switch to allow event evaluators to override cost adjustments. Changes to the setting cascade down to all related values affected by the change:
  - Click **Disallow** next to a cost adjusted value to remove a cost adjustment from an item. **Disallowed** will be displayed on all related items instead of the cost adjusted value.
  - Click **Reapply** next to a cost adjusted value to reapply a cost adjustment to an item. Cost adjustments will be recalculated and displayed.
  - **Comments** entered when a cost adjustment is disallowed or reapplied are recorded in the history.

- An information icon 📌 will display next to an item when maximum values or bid thresholds have been exceeded and an expected cost adjustment has not been applied. Click the information icon 📌 next to an item to view details.

**For Multi-Stage Events**

Options are selected on the Evaluation Calculation Options page to designate which scoring options are available to be evaluated for the different stages. The configured options are then displayed on the Scenario Navigator page.

**Alternate Items**

If alternate items are allowed for the event, a **Choose Alternate** indication displays for the configured items when the item information is expanded.
When the **Choose Alternate** button is selected, you may choose which item to use in the evaluation. Any Auto Score and Cost Analysis results are recalculated.

If an alternate item is selected in a scenario and is the item being evaluated, an **ALT** indication appears next to the item. Also note that the item numbering indicates it is an alternate item.

**Supplier Response Actions**

The action to **Pin** or **Remove Response** from the Evaluation view is available by selecting the drop-down next to the supplier name. The actual award action is done through the **Actions for Selected Items** drop-down:

- **Tag Supplier** - This action is available if the event is configured to allow multiple stages. Selecting this option will tag the supplier to move to the next stage of the event, when created. Tagged suppliers show with an icon 📍.

- **Untag Supplier** - This action removes tag on a supplier that would place them on the next stage of an event, when created.

- **Pin** - This action moves the response to the beginning of the responses behind any Recommended or Awarded responses. The response location will not move through pagination of additional responses. This essentially "locks" the response into a column location.

- **Unpin** - This action removes the response from a designated column and the normal sorting for the evaluation responses applies.

- **Remove Response** - This will remove a response from the current evaluation view. This does not remove the response from the event - it only removes it from this particular analysis of the evaluation responses.

- **Remove Award From Supplier** - This action will remove the award indication for each item marked for the supplier as **Pending Award**. Upon confirming this action, any items marked as awarded to the supplier in the scenario will be marked as **Unawarded**.

- **Disqualify** - A supplier can be manually disqualified from an award scenario by expanding the supplier name at the top of the column and selecting **Disqualify**. The supplier is removed from the award scenario, and they are excluded from the **Evaluate All Responses** and **Export All Responses** evaluation actions.

Once an action is chosen, you will be asked to **Save the Evaluation** if has not been previously saved. Any actions such as award or recommend that are placed on a supplier response are available for the approver to see as the evaluation moves through workflow.
Split Awards

Awards can be split by products or items among several different suppliers. Organizations may also configure work groups or events to allow split item quantities in evaluations. For more information, see Split Award Options, on page 203.

Note: The split-item award feature is disabled for an item when its Quantity field is supplier-controlled, as each vendor's submission is a stand-alone option for the buyer's consideration.

Evaluate Supplier Responses

You may select run different scenarios on supplier responses to an event and save those scenarios for review by others before a final decision is made.

Note that if Confidential Pricing is enabled for an event and you are not included in the Event Price Viewers access group for the event, you will see the word Confidential anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

Step-by-Step

The goal of this task is to perform different actions in evaluating responses on an event. You must have the Finalize Award Scenarios or Create Award Scenarios permission in order to navigate to evaluations.


2. Select the appropriate event number you would like to evaluate to open the event details.

3. From the Supplier Responses page, select the Evaluation Actions dropdown, and select to Evaluate All Responses. Or, you may select specific suppliers on the page, and select the link to Evaluate Selected Responses.

4. Click the View Scenario drop-down, and select from one of the common scenarios. View results.

5. Click to Reset the page to have no scenarios.

6. Select to Sort Bids by various selections.

7. If Cost Per Quality Point (CPQP) was configured for the event, note the Cost Per Quality Point score for each supplier. You may choose to sort the responses by lowest Cost Per Quality Point score, or view a scenario for Lowest Cost Per Quality Point Score.
8. If Best Value scoring was configured for the event, note the **Best Value Score** for each supplier. You may sort the responses by highest Best Value Score, or view a scenario for Highest Best Value Score.

9. If a Panel Questionnaire was configured and the Questionnaire Close Date has passed, note the **Average Questionnaire Rating** for each supplier.

10. Note the **Auto Score** and **Cost Analysis** information, if configured for event or event line items. You may see the individual question score and cost adjustments when expanding the question or item information.

11. Pick one of the suppliers and in the drop-down next to the supplier name, select to **Pin** it to move it to the beginning of the table. You can select to **Unpin** if desired.

12. Expand the product or service line items and evaluate responses on individual items. Select the link for an item to view additional item details.

13. Expand question information and evaluate responses.

14. Select one or more product and/or service line items, select the **Actions for Selected Items** drop-down, and select one of the options.
   a. The page refreshes with Pending Award noted for the supplier you selected for the items.
   b. The **Award Scenario** column displays the name of the supplier awarded for the items.
   c. The **Scenario Breakdown** tab now shows, where you can see the results of this scenario.

15. Click the **Save As...** button, and enter a name for the Scenario you just created.

16. You may select to **Export** the Scenario, or All Responses.

17. When satisfied with a scenario, click **Finalize Award**.

**Review Panel Questionnaire Responses**

An evaluator may review panelist responses at the point the panelists begin entering those responses. Once the panel questionnaire closes, the evaluator can view average score information as well as the individual panelist responses.

Additionally, the **Panel Questionnaire Details** tab provides a detailed view of panel questionnaire ratings and results. The tab is only exposed after the panel questionnaire questions have closed and associated values are calculated. Clicking the Export button also provides access to an Excel spreadsheet export of the questionnaire results to allow further analysis of the data outside of the system.
**Step-by-Step**

The goal of this task is to provide review panelist responses to a Panel Questionnaire for a sourcing event. It is assumed the user is an evaluator for the event and the panel questionnaire has closed.

1. Navigate to an event that is **Under Evaluation** and for which the **Questionnaire Close Date** has passed.

2. Select the **Panelists** page from the **Panel Questionnaire** section of event navigation.
   
   a. Select the button to **View Panelist Response** for each panelist response you want to review.
      
   b. Scroll through the panelist score and comments for each question. Use the pagination within the questionnaire pages to see all suppliers and questions rated. Expand and collapse questions, pages and groups as needed.

   c. Select **Back to Event** to return to the **Panelists** page and select another panelist response to review.

3. Select the **Suppliers** page from the **Panel Questionnaire** section of event navigation. Note the **Average Rating from Submitted Panelists**.

4. Select the **Supplier Responses** page of the **Evaluation** section of event navigation.

**View Evaluations Page**

When an event is closed, you may begin the evaluations process.

**Step-by-Step**

The goal of this task is to review information on the Evaluations page for an event. You must have the Finalize Award Scenarios or Create Award Scenarios permission in order to navigate to evaluations.

Note that if **Confidential Pricing** is enabled for an event and you are not included in the **Event Price Viewers** access group for the event, you will see the word **Confidential** anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

1. Search for an Event with a status of **Under Evaluation**.

2. Select the appropriate **event number** you would like to evaluate to open the event details.

3. Select the **Supplier Responses** page for the event.
4. From the **Evaluations Actions** drop-down, select **Evaluate All Responses**. Or, select specific supplier responses, and select **Evaluate Selected Responses** from the **Evaluations Actions** drop-down.

5. Click the **View Scenario** drop-down, and select from one of the common scenarios. View results.

6. Select to **Sort Bids** by various selections.

7. Expand the product or service line items to see individual items.

8. If comments are present, select **See full comment** hyperlink to see the complete text.

9. If you would like to return to the event to see other details of the supplier's response, select **Back to Event** hyperlink.

## Export All Responses for an Event

When evaluating responses, you may choose to export all responses to an Excel file for further analysis.

Note that if **Confidential Pricing** is enabled for an event and you are **not** included in the **Event Price Viewers** access group for the event, you will see the word **Confidential** anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

When additional item fields on a sourcing event are included in the **Evaluation Actions > Export All Responses** document, **conditionality between fields is not included**.

### Step-by-Step

The goal of this task is to export all the submitted supplier responses for an event. You must have the Finalize Award Scenarios or Create Award Scenarios permission in order to navigate to evaluations.

1. Search for an event with a status of **Under Evaluation**.

2. Select the appropriate **event number** you would like to evaluate to open the event details.

3. Select the **Supplier Responses** page for the event.

4. To export from the **Supplier Responses** page, select **Export All Responses** from the **Evaluations Actions** drop-down. Proceed to step 6.

5. To export from the Evaluations page, select **Evaluate All Responses** from the **Evaluations Actions** drop-down. Then, select the **Export** button, and **Export All Responses**.
6. Enter a **Description** for the Export file, and click **Submit**.

7. A confirmation indicates your export request has been submitted. Click the hyperlink message to navigate to the **Sourcing > Sourcing Events > View Exports > Evaluations** page.

8. Select the file name to open in Excel.

---

**Export a Saved Scenario for an Event**

When evaluating responses, you may choose to export a particular scenario view to share with others or for further analysis.

Note that if **Confidential Pricing** is enabled for an event and you are **not** included in the **Event Price Viewers** access group for the event, you will see the word **Confidential** anywhere a price would be displayed. This includes PDF and evaluation exports you perform.

**Step-by-Step**

The goal of this task is to export the responses for a particular evaluation view for an event. You must have the Finalize Award Scenarios or Create Award Scenarios permission in order to navigate to evaluations.

1. Search for an event with a status of **Under Evaluation**.

2. Select the appropriate **event number** you would like to evaluate to open the event details.

3. Select the **Supplier Responses** page for the event.

4. Select the **Load Saved Scenario** button. From the list of Saved Evaluations, select the **Load** button for the desired scenario view.

5. Once viewing the evaluation, click the Evaluation Actions drop-down and select **Export this Evaluation**.

6. **Name** the Export file, and click **Submit**.

7. A confirmation indicates your export request has been submitted. Click the hyperlink message to navigate to the **Sourcing > Sourcing Events > View Exports** page.

8. Select the file name to open in Excel.
Return to Evaluator

If enabled for your system, the Return to Evaluator workflow action allows approvers of an event's recommended award scenario to return that scenario back to the evaluator. The evaluator can re-examine the event and submit a different award scenario for approval.

Step-by-Step

The Return to Evaluator feature must be configured for your system. The Approve/Close Without Awarding Sourcing Events permission is required to perform this action.

1. Open the sourcing event with the award scenario to be returned.

   **Note:** The event must be in the Under Evaluation status, have a finalized award scenario, and be in a folder assigned to the appropriate approver. The action cannot be performed if contracts have been created from the award scenario.

2. Click the Workflow Actions and select Return to Evaluator.

3. Enter a comment in the open field and click Return to Evaluator.

The recommended award scenario is returned to the evaluator. A notification is sent to the evaluator if they have opted into the Sourcing Event - Returned to Evaluation notification.

The finalized status of the original recommended scenario is removed, but all previously created award scenarios are retained. The evaluator can then re-evaluate the scenario and submit a different recommendation for approval.

Split Award Options

**Note:** The split-item award feature is disabled for an item when its Quantity field is supplier-controlled, as each vendor's submission is a stand-alone option for the buyer's consideration.

Split Awards Among Different Suppliers

Awards can be split by products or items among several different suppliers. Split Award is available on all events, but it is optional for a user to award across supplier responses or to a single supplier. Users may select item types, item groups or individual items for award to a supplier.
• When an event is under evaluation and a user is evaluating supplier responses, an action is available to Award to [Supplier Name], with an option available for each supplier being evaluated.

• The evaluator will have the ability to select product line items and service line items for the award option. For example, Product Line Item 1 may be selected to be awarded to Supplier ABC, while Product Line Item 2 may be selected to be awarded to Supplier FGH.

• No Award may be selected for one or more items. Line items that are not selected for an award will be shown with a status of Unawarded. The evaluator must select No Award or Award to [Supplier Name] for each item in order to complete the event evaluation process.

• $0 Award - When the event does not have items to award the user may select Award to [Supplier Name] which will award the event to the supplier in that scenario. If the event has items, the user has the option to Award to [Supplier Name] without selecting any items. This action will prompt the user to convert the scenario into a No Item Award scenario. This scenario when awarded will award the supplier(s) the event but not any items.

• From the View Scenario drop-down, the user can select to run the Lowest Bid Price Split Award scenario, or the Lowest Cost Per Quality Point or Highest Best Value Score Split Award scenarios if those features are in use for the event.

• This will automatically mark individual items as being awarded to the supplier with the lowest bid, lowest cost per quality point, or highest best value score on that item.

• If you have not included all suppliers in the current evaluation scenario, you will be prompted to confirm if you want to run the scenario on all suppliers or only on the selected suppliers in the evaluation. If you select to Run on All, the remaining suppliers will be added to the evaluation scenario.

• When the award is split among different suppliers, each line item will show the supplier who has been awarded the event in the Awarded Scenario column on the Evaluations page.

Split Item Quantity Among Multiple Suppliers

The configuration to allow split item quantity awards is available at the work group and event levels. For events that allow split awards, the side-by-side evaluation page will include the option to Split Between Suppliers. An overlay then allows the user to indicate the quantity of the selected item(s) to award to each supplier being evaluated.

• Work Group configuration - Split Item Quantity Setting under the WorkGroups Event Setup tab, in the Bid and Evaluation section.
- **Optional** - Allow split item quantity is optional for all events in this work group. Selection may be made at the event level. This is the default selection.

- **All** - Allow split item quantity will be enabled for all events in the work group. All events in the work group will have the option enabled, but it is still optional for use in the actual award process.

- **Off** - Allow split item quantity will be disabled for all events in this work group. No events in this work group will have the option enabled, and the setting cannot be changed on the event.

- **Events** configuration - **Allow Split Item Quantity in Evaluations** setting under **Bid and Evaluation** section of **Event Setup** page:
  - If the work group setting is **Optional**, the event may be configured as **Yes** or **No**. If **Yes** is selected, split item quantities may be awarded for the event.
  - If the work group setting is **Yes**, the event will display a read-only setting of **Yes**. It is optional for use in an award scenario.
  - If the work group setting is **No**, the event will display a read-only setting of **No**. You will not have the option to split item quantities among suppliers.

When the event is configured to allow split items, an option to **Split Between Suppliers** is available in the **Scenario Award Actions** dropdown list on the Scenario Navigator tab.

- When **Split Between Suppliers** is selected, a **Split Item** overlay displays. In this overlay, you may assign a quantity for each supplier in the scenario. Once you save the assigned quantities, the page displays the number of suppliers awarded for the item in the **Awarded Scenario** column. You may click on the number of suppliers indication to see the details of which suppliers were awarded specific quantities.

- You do not have to award the exact quantity of the item listed. You may award more or less. The quantity awarded displays as you enter values.

**Award a single item to multiple suppliers**

This option is available on the side-by-side evaluation page for all events. No configuration is required to have this option.

Once an item has been awarded to a supplier and the item is selected to be awarded to a different supplier, an overlay indicates **Item(s) have already been awarded**. You then have the option of confirming the item award to the additional supplier or changing the award to only the newly selected supplier.
Evaluation Workflow

After an event has closed, it moves into Evaluation workflow, and the status of the event is **Under Evaluation**. The customer will then evaluate the supplier responses to the event to see which one best fits their needs. Typically, a customer will be evaluating the best price along with other factors important for the event. A user must have certain permissions to perform different workflow approval actions. See [Permissions](#), on page 4, for details.

When a user has selected to Finalize Award Scenario for a particular event, that information is passed along to approvers reviewing the evaluation in Evaluation Workflow. Evaluation approvers will review evaluations to ensure the award was made to the appropriate supplier response.

Once an event is in a state of **Under Evaluation**, any user with access to take action on supplier responses will see an option to Approve or Assign to Myself. Once the Evaluation is assigned to you, you have different options depending on your user permissions and the state of the event.

- **Approve** - This approves the event with the designated awarded supplier.
- **Close Without Awarding** - This closes the event without awarding it to any supplier.
- **Forward to** - Select another approver to forward the evaluation for review.
- **Put on Hold** - This keeps the evaluation assigned to the current user and cannot be modified by any other approver.
- **Return to Shared Folder** - This returns the evaluation to the appropriate shared folder where another user can assign it or take action. It will no longer show in your My Approvals folder.
- **Return to evaluator** - For organizations with this feature configured, this option will return the recommended award scenario to the evaluator. The finalized status of the original recommended scenario is removed, but all previously created award scenarios are retained. The evaluator can then re-evaluate the scenario and submit a different award scenario recommendation for approval. The action cannot be performed if contracts have been created from the previously submitted award scenario.
- **Reopen** - This reopens the event so that suppliers can respond.

An event remains Under Evaluation until it completes workflow by an approver selecting to approve a finalized award, to close without awarding or reopening the event.

The last step in evaluation workflow must be the automated step to perform the awarding to the selected supplier. Without the automated step, the event will not be awarded.

**Finalized Award Pending Workflow Approval**
An Event Under Evaluation showing Approval Actions available

A User's My Approvals page Showing Pending Evaluations
Proxy Bid Responses

Once a supplier has been designated for a proxy bid (see Designating Proxy Bid Suppliers, on page 123), a user with appropriate permission may access the event information on the Supplier Responses page by selecting Enter Proxy Bid or Continue Proxy Bid. In order to submit a proxy bid on behalf of the supplier, the user must be an Event Owner with either the Create/Own Events permission or Manage work group Events permission, as well as the Create Proxy Bid permission. The supplier will receive an email indicating that the customer has started a proxy bid for the supplier's response to the event.

Upon selecting to enter or continue a proxy bid, the user is navigated to a view of the event in the same format as a supplier would enter information. A banner message displays, notifying the user they are entering a proxy bid on behalf of the supplier:

- The customer user must accept prerequisites and declare the intent to bid depending on the event requirements.
- The response status shows as Draft (by Proxy).
- The customer may navigate back to the supplier responses page at any time by selecting Back to Supplier Responses.
- Customer responses are reflected in the Event History. A supplier may continue to respond to the event via the customer portal. A supplier will see an audit log of responses provided by the customer.
- Upon completing all required information, the customer can submit the bid response on behalf of the supplier. The response is evaluated with all other supplier responses.

For information on configuring Proxy Bid functionality for the organization, see Proxy Bids, on page 257.

Respond to an Event via Proxy Bid

If the event is configured to allow Proxy Bids, a customer user with the Create Proxy Bid permission may enter bid response information on behalf of the supplier.

Step-by-Step

The goal of this task is to enter a proxy bid response on behalf of a supplier for an event. It assumes the supplier has been designated as a proxy supplier.

1. Search for an Event with a status of Open or Under Evaluation that allows Proxy Bids and has suppliers designated for proxy bids.
2. Navigate to the **Supplier Responses** page under the **Evaluations** section of the event navigation.

3. Select the **Enter Proxy Bid** or **Continue Proxy Bid** button for the appropriate supplier.

4. If the intent to bid has not been set, declare your **Intent To Bid**. You can do this either of two ways:
   1. Click the button in the banner, **Yes I Intend to Bid** or **No Bid**.
   2. In the left navigation for the event, click the edit icon next to the Intent to Bid, and choose **I intend to bid on this event** or **No Bid**.
   3. If you choose No Bid, then no further action is needed.

5. If **Prerequisites** are required to view or respond to the event:
   a. Click the **Proceed to Prerequisites** button, or click on the **Prerequisites** link in the left navigation panel for the event. You are navigated to the Prerequisites page for the event.
   b. Follow the instructions on the page. This may include selecting a checkbox to confirm you have read and agreed to the terms, and/or uploading a file.
   c. When finished completing the requirements on the page, click the button to **Save Progress**.

6. View **Buyer Attachments**, if provided.
   a. Click on the **Attachments** link in the left navigation for the event.
   b. While on the Prerequisites page, click the **Next** button.
   c. Download and view attachments as needed.

7. View the **Supplier Attachments** section, if provided. If additional information should be included to support the bid response, select Add New Attachment and provide a file or URL link.
   - If a File, name the attachment and upload the file. If you select Link, you can provide a name for the link and enter the URL address.

8. Answer **Questions** as provided. Note that questions may be on multiple pages and grouped on each page.
   a. Navigate by selecting **Questions** in the left panel for the event, or by selecting the Next button when on the Attachments page.
   b. Required questions are indicated with a star, and must be answered in order to submit your response.
c. Answer other questions as appropriate to give the customer complete information. For information on providing responses via import, refer to the guide in the application by selecting the **Import Options** drop-down button, and select **Get Import Instructions**.

d. Navigate to each page by selecting the page hyperlink under the Questions section in the left navigation panel for the event.

e. On each page, click to **Save Progress** or click the **Next** button to save and proceed to the next page.

9. Provide **Item** data, if appropriate.
   a. Navigate by selecting the **Items** in the left panel for the event, or by selecting the Next button when on the last Questions.

   **Note:** Items are listed on the **Product Line Items** page and/or **Service Line Items** page. Items may be grouped within the same page.

   **Note:** You may choose to import item responses by using the export/import feature. Download the **Bid Response Import/Export Guide** by selecting the **Import Options** drop-down button, and **Get Import Instructions**. Follow the instructions in the document to submit item responses via import.

b. For product line items and service line items, enter a **unit price**. If a unit price is required for an item, the field will be noted with a star, and a price must be provided in order to submit the bid response.

c. For Product Line Items, enter an **estimated delivery date** or days after award when delivery is expected. If an estimated delivery date is required, the field will be noted with a star, and a date / days must be provided in order to submit a response.

d. For Service Line Items, enter estimated service start/end dates or days after award when the service will be delivered. Entering this information is optional.

e. Enter a comment for each item, if appropriate.

f. Click **Respond to Item** and complete questions or enter information requested by the buyer. Required fields are indicated with a star and must be completed in order to submit a response. Click **Save Changes** when done.

g. If an item is configured to allow alternates, select the **Add Alternate Item** if you would like to provide a similar item in your bid response. This may be in addition to or instead of the response to the original item. You may enter up to five alternates per item.
i. Provide a **Name** for the item. This field is required.

ii. Enter an optional **Description** for the item.

iii. Enter an optional **Catalog Number** for the item.

iv. The **Quantity**, **Unit of Measure**, and **Requested Delivery** information must be the same as the original item, and therefore is read-only.

v. Enter a **Unit Price** for the item. This field may be required.

vi. Enter an **Estimated Delivery** (date or days after the award). This field may be required.

vii. Enter optional **Comments** about the alternate item.

viii. When finished, click **Save Changes**.

ix. The page will refresh, indicating the **ALT** item below the original item.

h. On each page, click to **Save Progress** or click the **Next** button to save and proceed to the next page.

10. **Review and Submit** your response for the event.

    a. Select the **Review & Submit** hyperlink in the left navigation for the event.

    b. Any incomplete items are indicated with a warning message, with a hyperlink to navigate to the appropriate area.

    c. You do not have the option to certify or submit a response if you have not completed all required items.

    d. Once required items are completed:

        i. Select the checkbox **certifying** the statements you've made to be true.

        ii. Click **Submit Response**.

11. The page refreshes with a confirmation that your response was submitted.

**Responding to an Event via ProxyBid**

Once you have designated proxy bid suppliers, you may select to **Enter Proxy Bid**, even if the supplier has begun responding. Note that if the event is using sealed bids, you cannot enter a proxy bid until the sealed bid open date has passed.
Once you select to **Enter Proxy Bid**, you will see all event information just as a supplier sees the event in the portal, and must meet the same requirements for completing the response information. To navigate away from the supplier response view and back to the event, select the hyperlink **Back to Supplier Responses**.

### Event Navigation

#### Summary

You are initially navigated to the **Summary** page of the event, which lists basic details about the event, including key dates and the event description. A banner message displays indicating you are responding on behalf of the supplier. If the event requires that the supplier reviews prerequisites or declares a bid intent, you cannot navigate past this page until you complete those options.
Intent to Bid

You will be prompted to declare your intent to bid. This may be after you have reviewed prerequisites, depending on the event’s configuration. Declare the Intent to Bid by clicking the appropriate button in the banner message, or by selecting the edit icon next to the Intent to Bid status in the left panel. If you do not intend to bid on the event, select No Bid and there is no further action required. You or the supplier can change the intent as long as the event is open.

Prerequisites

Reviewing the Prerequisite page information may be required before allowing you to either 1) see the event details, or 2) respond to the event. If a prerequisite is required, you will see a message indicating that you must review the prerequisites page (and possibly provide information) in order to view or respond to the event. Once you select Proceed to Prerequisites button or click on the Prerequisites navigation page on the left, follow the prompts to confirm your acceptance of the prerequisite information.

After you have completed the required actions on the Prerequisites page, the message is removed. You will now have access to view the remainder of the event or to begin responding to the event, depending on the requirement criteria.

Buyer Attachments

Customers may provide attachments as a file or URL link for the supplier’s review and consideration when responding to the event. Examples may include:

- An area diagram or photograph if the event is for landscaping services.
- An office layout for placement of new carpet or flooring.
- Detailed specifications for an event.
- Additional company information.
- A link to the company website or other information helpful in responding to the event.

To open or save the attachment, simply click on the link.

**Supplier Attachments**

Customers may include a section for suppliers to provide attachments for consideration in the bid response. Examples may include:

- A list of references.
- Details on how work will be performed.
- Details on third party suppliers or contractors.

Select to **Add New Attachment** and upload the file you want to include.

**Questions**

Customers include questions for suppliers to answer related to the event. Responses may be in the form of yes/no answers, multiple selections, free-form text, a date, require a file upload, and other options. Required questions are indicated with an asterisk (*), and must be answered in order to submit the bid response for consideration.

Note that questions may be organized in groups on multiple pages. The questions do not have to be answered in order. You may save progress if you need to come back to the page later to provide additional answers. You may also select to export and import question responses. For more information on exporting and importing question responses, select the **Import Options** drop-down button, and select **Get Import Instructions**.
Items

If the event includes providing specific products and/or services, the details are listed on the Items pages. Separate pages are available for Product Line Items and Service Line Items. If unit price is required for an item, it will be indicated with an asterisk (*). If the estimated delivery date or days after award is required for a product line item, it is indicated with a clock icon 🕒.

If the event has any items configured to allow alternates, you will see the option to Add Alternate Item in addition to or instead of submitting a bid for the original item. If you provide alternates, you will see an indication Σ next to the item that will be used by default in the total bid calculations. Select the View Details... hyperlink to see details such as a
customer's commodity code for the item, a complete item description, and any attachments associated with the item. You may enter in your price to the customer for the item, estimated delivery information, and optional comments. As you enter prices, you will see your bid total calculated at the bottom.

You may also select to export and import item responses. For more information on exporting and importing item responses, select the **Import Options** drop-down button, and select **Get Import Instructions**.

---

**Review and Submit**

The **Review and Submit** page contains a summary of all the sections of the events, and highlights any missing information that is required to submit the event response. You will
not have the ability to click **Submit Response** until required information is completed.

**Note that the certification statement indicates you are submitting this response on behalf of the supplier.**

Once all items are completed, click the certification statement and the button to **Submit Response**.

The page will refresh with a confirmation that your response was submitted, and you can navigate to the **Supplier Responses** page of the event or the Sourcing Events Home page.

**History**

An audit log is captured for event responses. Click the **History** hyperlink for the event to
view the log of changes to the event responses. You can sort entries by date, user, action, section, subsection or context. Click on the Filter History hyperlink to see audit entries based on dates, type of action, or section for the event. You will see an audit history for changes made by your organization users only. You will not see a history of changes made by the supplier in the supplier portal.

Editing your Responses

You may edit your responses at any time while the event is still open. From the Supplier Responses page, select to Continue Proxy Bid to make changes. You may also click the Withdraw Bid button if you would like to withdraw your bid before the event closes. You may then edit responses and submit your bid again, if desired.

Initiating Contracts For Awarded Events

Organizations can take advantage of an integration between the Sourcing and Contract Director solutions that allows users to initiate contracts in Contract Director from within a sourcing event. When this integration is in place, Sourcing users with the Initiate Contract Process permission can initiate a contract from a sourcing event, and monitor contract details from within the sourcing event as it moves through the Contract Director workflow. Users may choose to enable the Notification Preference for An Event-initiated CD Contract status has changed in order to be notified when changes occur with a contract associated with one of their sourcing events.

Once an event has reached an Under Evaluation status, and a finalized Award Scenario exists, users with the permission will see a link to Initiate Contract Process on the Scenario Breakdown page for each supplier awarded in the scenario.

- Upon selecting the link, the user enters a Contract Title, chooses a template or contract option, confirms the assigned Contract Manager, verifies the second party (the supplier), and selects the event items to be included in the contract. If the event items are irrelevant to the contract, you can select None instead of selecting items.

- All items to be delivered by a specific supplier can be associated on a single contract, or items can be distributed across multiple contracts. Each item can be associated with only one contract.

- Once the parameters for the contract creation are chosen, the user selects the Add Contract button. This initiates a contract within the Contract Director application.

A new column for Contract Number & Status shows on the Scenario Breakdown page. The status will show as Pending until the contract has been created in Contract Director.

Once the contract has been created, the user can see the status of the contract as it moves through the Contract Director workflow.
• Contract numbers show as links on the Scenario Breakdown page. Selecting a link allows the user to see the status and basic information about the related contract from within the event. Information displayed includes: Contract Number, Title, Type, Contract Manager, 2nd Party/Supplier ID, Contract Status, and Start/End Dates.

• Users with the appropriate permission will also see a link in the overlay to Go to Contract within Contract Director. When selected, the user is navigated to the contract in the Contract Director application.

The following line item information is passed from the sourcing event to the contract: Item Name, Description, Catalog Number, quantity, unit of measure, commodity code, unit price, total price, customer requested delivery date, supplier’s estimated delivery date, and start/end dates for service items. In addition to item information, some supplier attachments provided to the event are passed to the contract as attachments within Contract Director.

Initiate Contract Process on the Scenario Breakdown Page

Once the basic contract information is added, a new column displays on the Scenario Breakdown tab, indicating Contract Number & Status.

Once the contract has been initiated in Contract Director, a contract number is displayed on the page. Select the contract number to see an overlay with basic contract information, including status in Contract Director. Users with the appropriate permission will see a link in the overlay to Go to Contract within Contract Director to navigate to the Contract Director application.

If errors occur during the contract initiation process, users can navigate to Find and Fix Errors > Contract Director Contract Initiation Exports. This page allows users to monitor and respond to issues related to the creation of Contract Director contracts that are initiated from Sourcing.

Contract Status

The following contract status indicators will display on the Scenario Breakdown page for a contract initiated from Sourcing:

• **Pending** - The contract has been initiated, but has not yet been created within Contract Director.

• **In Process** - The contract has been successfully created in Contract Director, and is currently being managed through the Contract Director workflow process.

• **Fully Executed** - The contract has successfully completed the Contract Director workflow process.

• **Canceled** - The contract negotiation process either failed, or was terminated within Contract Director.
- **Error** - The contract has been initiated from Sourcing, but the contract creation process failed within Contract Director.

The **Contract Status** displayed on the Scenario Breakdown page is different from the client-defined contract status in the Contract Director application. The client-defined status is displayed in the **Detailed Contract Status** field when viewing the basic contract information from Sourcing.

**Initiate Contract Director Contract from Sourcing**

If your organization has the Contract Director solution, then you may choose to initiate a contract from an event. This task assumes you have a saved Scenario for the event.

**Step-by-Step**

The goal of this task is to initiate a contract from an event in Sourcing. You must have the Initiate Contract Process permission to perform this task.

1. Search for an event with a status of **Under Evaluation**.
2. Select the appropriate **event number**.
3. Select the **Supplier Responses** page for the event.
4. View a scenario breakdown by either of these methods:
   a. If the banner message indicates **You may view the scenario breakdown**, select the **scenario breakdown** hyperlink to navigate directly to the scenario breakdown page.
   b. Click **Load Saved Scenario**, and select the appropriate Scenario to view. Once you are viewing the appropriate Award Scenario, select the **Scenario Breakdown** page.
5. When the selected Award Scenario has been finalized, link to **Initiate Contract Process** is listed for each supplier with an award in the scenario. Select the hyperlink.
   a. Enter a **Contract Title**.
   b. Select the appropriate **Contract Option**.
   c. Note the default Contract Manager to be assigned to administer the contract within Contract Director. If this default assignment is inappropriate, select a different contract manager to replace the default option.
   d. Verify the **2nd Party** (supplier) for the contract. This information is read only.
e. Select the **Items to Include in Contract**

   i. Select **All Items to be Awarded to this Supplier** if you want to include all the items in the contract.

   ii. Select **Let Me Pick** if specific items from the award should be on the contract. You will then have the option to select from the list of items to be awarded to the supplier.

   iii. Select **None** if the contract to be generated has no relevance to items being sourced.

6. Select **Add Contract**.

7. The page refreshes, exposing the new **Contract Number & Status** column. Once a contract number is generated in Contract Director, a contract number and status will display in the column.

8. Click the **Contract Number** to see a summary of the contract information and status.

### Initiating Contracts+ Contracts For Awarded Events

If your system is integrated with the JAGGAER ONE Contracts+ solution, you can create contracts from a Sourcing event. Once the contract creation process is initiated in Sourcing, a contract will be automatically created in Contracts+. Contracts include event attachments submitted by the buyer and supplier from Sourcing (in the file format), and line items that are part of the event negotiation.

When this integration is in place, Sourcing users can initiate a contract from a sourcing event, and monitor contract details from within the sourcing event as it moves through the Contracts+ workflow. Users require the Initiate Contract Process permission, appropriate Contracts permissions, and to be added as users on the Contract Users tab of the appropriate Sourcing Work Group.

You can create a contract that contains all items from an event, multiple contracts for an event (each contract containing one or more items), or contracts with no items. As items are added to a contract, they are removed from selection, so that an item from an event can only be included once on a contract.

In Sourcing, contract creation must be initiated when an event is in **Under Evaluation** status. Click the **Finalize Award** button on an Under Evaluation contract and the **Create Contract** link will appear. Click the **Create Contract** link next to the Supplier Total field on the right side of the screen to open the Create Contract wizard.
Sourcing Reports

In addition to exporting event search results into a Summary or Supplier Participation report format, customers can also view a Supplier Award Summary via the Sourcing > Reports menu. Information is displayed by supplier, indicating the number of bids the supplier has submitted, events awarded and amount awarded.

Supplier Award Summary

A Reports sub-menu is available by navigating to Sourcing > Reports. From this menu, a Supplier Award Summary report may be selected.

The following criteria are available (you may select Hide Options / More Options to toggle criteria):

- **Awarded Within** - The date range for the supplier awards you want to see.
- **Suppliers** - You may select specific suppliers to view the award summary. Begin entering a supplier name to see potential matches, or select the list icon to search for suppliers. You may select multiple suppliers for the report.
  
  - The supplier search returns both organizational suppliers as well as manually invited suppliers who did not respond to the event, so a best practice is to use the "starts with" search to ensure you are searching manually invited suppliers as well.
  
  - Up to 20 organizational suppliers plus manually invited suppliers are presented in the search results for this field.
Here are the key points:

- **Work Groups** - Begin entering a work group name or select the list icon to search and view the work group tree in order to select the work group(s) you wish to include in the results. The work group tree displays both the work groups where you have work group level permission as well as those you have been granted explicitly through sourcing event access. If you have access to a child work group but not a parent, you will see the parent level is not selectable, but can be expanded in order to select child work groups to which you have access.

Results display by supplier, sorted by number of bids submitted. Only results for events the user has access to will be returned.

The following information is displayed:

- Supplier Name, DBA and Aliases.
- Total Events. This includes the sourcing events where the supplier was sent an invitation, as well as public events for which the supplier submitted a response. Click on the number to navigate to detailed information about the supplier’s events.
- Number of Bids Submitted by the supplier.
- Number of Events Awarded to the supplier.
- The Awarded Total to the supplier.
- The information may be sorted by any column.

**Note:** If a supplier was manually invited to the event and did not respond, the supplier name does not show as a hyperlink and cannot be selected.

More detailed information is provided when selecting the **Total Events** hyperlink for a supplier in the report.

**Exporting Results**

You may choose to export the **Supplier Award Summary Report** information by selecting the **Export** hyperlink at the top of the page. When selected, you will be prompted to enter a file name. Files are available for download on the **Sourcing > Sourcing Events > View Exports > Reports** tab. You can filter results on the page by date.

**View the Supplier Award Summary Report**

You may view a supplier award summary report and details.
Step-by-Step

1. Navigate to Sourcing > Reports > Supplier Award Summary.

2. Select a date range for the report from the drop down Awarded Within field.

3. To filter by Supplier, choose one or more Suppliers for the report. Begin entering a supplier name to see potential matches, and select the supplier. If this field is left blank, the report will return all suppliers.

4. To filter by work group, begin entering a work group name, or select the list icon to select from or search the work group tree. You may only select from work groups to which you have access. If this field is left blank, the report will return all work groups you have access to view.

5. Click Run Report.

6. Results display. If you would like to see the details for a particular supplier/row, select the hyperlink for Total Events.
   a. View the details for the selected supplier.
   b. Sort information as appropriate.
   c. To return to the Supplier Award Summary, click Back to Supplier Award Summary Report.

7. To export the results into an Excel file, select the Export hyperlink on the Supplier Award Summary page.
   a. When prompted, enter a File Name for the export request.
   b. If desired, edit the Description for the file.
   c. Click Submit.
   d. A confirmation message displays, with a link to navigate to the file for download.

8. Navigate to the Sourcing > Sourcing Events > View Exports > Reports tab.
   a. For your requested export, note the status. If it has not completed, select the Refresh This Page hyperlink.
   b. Once the Status is Completed, select the File Name to save the file or open in Excel.
   c. The Filter tab of the file displays any criteria provided for the report.
   d. The Report tab of the file displays the data from the Supplier Award Summary Report.
Benchmarking via SmartProcure

JAGGAER has partnered with SmartProcure to give customers access to benchmarking data. An add-on license is available that will allow users with the appropriate permission to access the SmartProcure website to view Benchmarking data.

A user must have the View Benchmarking via SmartProcure permission to access the SmartProcure site. The permission is available in the Administration > System Administration section of the user profile and user roles. When the permission is enabled, a Benchmarking hyperlink is available on the Sourcing Events Home in the Quick Links Section. Upon selecting the link, users are navigated to the SmartProcure website.

Cost Savings Reports

Customers use the concept of cost savings or cost avoidance to show that they were able to reduce the amount they would have paid without the event.

The Cost Savings Summary report shows a graph and displays a summary of events’ cost savings/avoidance on required items. Cost savings and cost avoidance calculations are based on target/benchmark price, historical price, or average bid price. Users have the ability to view report information by various criteria, including dates, work group, event types, commodity codes, buyer, and more. If you have the Auctions module, information related to auction events will also display. For Reverse auctions, cost savings/avoidance are determined by First Bid minus Last Bid, Reserve Price and Historical Price.

You are able to select an event from the Cost Savings Summary report and drill down to the Cost Savings Detail report. This provides additional details specifically related to the event, such as the average, target, and historical bid amounts for each item.

A Reports sub-menu is available by navigating to Sourcing > Reports. From this menu, the Cost Savings Summary report may be selected. Users must have the View Sourcing Cost Savings Report permission to access this report.

By default, the Cost Savings Summary report displays cost savings within the fiscal year-to-date date with a graph of cost savings by average bid and awarded amount and a report.

The following criteria are available (you may select Hide Options / More Options to toggle criteria):

- **Awarded Within** - The date range for the supplier awards you want to see.
- **Work Groups** - Begin entering a work group name or select the list icon to search and view the work group tree in order to select the work group(s) you wish to include in the results.
• **Sourcing Event Type** - The event type for each event.

• **Reporting Commodity Codes** - If your organization uses commodity codes, enter or search for a code or description that has been associated with an event.

• **Sourcing Event Creator** - The creator of each event.

You can select what data to show in the report in the Show Columns section of the filter criteria. Select/Deselect the options you want to see on the report:

• **Sourcing Event Type**
  • **work group Code**
  • **work group Name**
  • **Sourcing Event Creator**
  • **Reporting Commodity Code**
  • **Awarded Amount** - Selected by default.
  • **Average Bid** - Selected by default. Provides cost avoidance measurement for the event.
    • Average Bid = (((Sum of required item bids submitted) / (total number of bids)) - (Line Item Awarded Price)) * (Awarded Quantity)
  • **Target** - Selected by default. Shows cost savings for the event by summing the awarded required items' target price calculations on the total line.
    • Target = ((Line Item Target Price) - (Line Item Awarded Price)) * (Awarded Quantity). Once the application has calculated all target savings values, it sums those values to get the total target savings seen on the Totals bar at the top of the results grid.
  • **Historical** - Selected by default. Displays cost savings for the event based on the awarded required items' historical unitprices.
    • Historical = ((Line Item Historical Price) - (Line Item Awarded Price)) * (Awarded Quantity). The item historic values are summed to get the event total historic savings value.
  • **First - Last Bid** - Selected by default. Visible only if some events in the results are either multi-stage or reverse auction. This is a measure of change between the first bid on the event versus the last bid. The first-last bid savings for each line of the event are summed to get the total first-last bid savings for that event.
  • **Reserve** - Selected by default. Visible only if the ability to create auction events is configured. Reserve measures savings for an auction event based on the item's reserve price. The reserve savings is the difference between the reserve price and the
awarded price. If no reserve price is entered on items for an auction event, then this metric is not calculated.

- **Estimated Value** - The value from the Estimated Value field on the Setup page of a draft event. This is the buyer's estimate of what they believe will be the cost of fulfilling the item requests of the event. This will allow users to assess savings without relying on a system-calculated value.

- **Award Date** - Date the event was awarded. This will allow users to amalgamate savings into a user-defined time period when producing targeted cost savings reports.

- **Award Recipient** - Supplier the event was awarded to. This will allow users to measure vendors, assess how repeat winners consistently win events, and ultimately re-evaluate event strategies.

Click the Run Report button to produce the report with the specified filters and columns. The Cost Savings bar chart will display below the report criteria in the Graphs section. Each event in the report is listed in the Details section below the graph with the columns you selected. You can sort the information by any of the columns.

**Cost Savings Details for Specific Events**

From the Cost Savings Summary page, you can select an individual event number under the Details heading to see Cost Savings Details for the specific event. The Cost Savings Details report displays the items on the event, as well as the quantity, supplier, awarded amount, average bid, target price, and historical price for those items. All columns on the report are sortable.

You can navigate back to summary by selecting the Back to Cost Savings Summary link.

**Exporting Results**

You may choose to export the Cost Savings Summary Report by selecting the Export hyperlink at the top of the page. You can also export the Cost Savings Details for a specific event by selecting the Export hyperlink when viewing the event details page. When selected, you will be prompted to enter a file name. Files are available for download on the Sourcing > Sourcing Events > View Exports > Reports tab. You can filter results on the page by date.

**View the Cost Savings Summary and Detail Reports**

You may view a cost savings summary report and details. Users must have the View Sourcing Cost Savings Report permission to access these reports.

**Step-by-Step**

These instructions describe how to run the Cost Savings Summary report.
1. Navigate to Sourcing > Reports > Cost Savings Summary.

2. Select a date range for the report from the drop down Awarded Within field.

3. If additional options are hidden, select the Show Options link.

4. To filter by Work Groups, begin entering a work group name, or select the list icon to select from or search the work group tree.

5. To filter by Sourcing Event Type, begin entering an event type name, or select the list icon to select from or search the event type tree. If this field is left blank, the report will return all event types.

6. To filter by Reporting Commodity Codes, begin entering a commodity code, or select the list icon to select from or search the commodity code tree.

7. To filter by Sourcing Event Creator, begin entering an event creator name, user name, or email, or select the list icon to select from or search all event creators.

8. Under Show Columns, select or deselect the following columns for display on the report, these are sortable when the report is run:
   - Sourcing Event Type
   - Work group Code
   - Work group Name
   - Sourcing Event Creator
   - Reporting Commodity Code
   - Awarded Amount
   - Average Bid
   - Target
   - Historical
   - First - Last Bid
   - Reserve
   - Award Date
   - Estimated Value
   - Award Recipient

10. A graph displays with the average bid and awarded amount cost savings and a detailed report displays below.

11. In the Details section, note the information in columns you have selected to include.
   a. Sort the information by any of the included columns.
   b. Select the Sourcing Event Number to view Cost Savings Detail for the event.

12. To export the Cost Savings Summary results into an Excel file, select the Export hyperlink on the Supplier Award Summary page.
   a. When prompted, enter a File Name for the export request.
   b. If desired, edit the Description for the file.
   c. Click Submit.
   d. A confirmation message displays, with a link to navigate to the file for download.

   a. For your requested export, note the status. If it has not completed, select the Refresh This Page hyperlink.
   b. Once the Status is Completed, select the File Name to save the file or open in Excel.
   c. The Filter tab of the file displays any criteria provided for the report.
   d. The Report tab of the file displays the data from the Supplier Award Summary Report.

**Step-by-Step**

These instructions describe how to run the Cost Savings Detail report.

1. Click the event number of an event appearing on the Cost Savings Summary report to view the Cost Savings Detail report for that event.

2. The report displays the items on the event, as well as the quantity, supplier, awarded amount, average bid, target price, and historical price for those items. Click the heading of any column to sort by that column.

3. Click each item name to view the awarded unit price, average bid, target price, and historical price for that item.

4. Click the supplier name for each item to view detailed information for that supplier.

5. To export the Cost Savings Detail results into an Excel file, select the Export hyperlink on the Cost Savings Details page.
a. When prompted, enter a **File Name** for the export request.

b. If desired, edit the **Description** for the file.

c. Click **Submit**.

d. A confirmation message displays, with a link to navigate to the file for download.

6. Navigate to the **Sourcing > Sourcing Events > View Exports > Reports** tab.

   a. For your requested export, note the status. If it has not completed, select the **Refresh This Page** hyperlink.

   b. Once the Status is Completed, select the File Name to save the file or open in Excel.

   c. The **Filter** tab of the file displays any criteria provided for the report.

   d. The **Report** tab of the file displays the data from the Supplier Award Summary Report.

**Cycle Time Summary Report**

This report allows buyers to judge the efficiency of their sourcing processes by measuring how quickly events get created and awarded. From the report, a user is able to review information on how long their events are in various statuses, including draft, pending, and under evaluation. Report viewers are able to filter on the final status of events and event completion dates within a set range.

A **Reports** sub-menu is available by navigating to **Sourcing > Reports > Cycle Time Summary**. Users must have the View Sourcing Operational Reports permission to access this report.

The Cycle Time Summary report runs automatically when you visit the Cycle Time Summary page for sourcing event completion dates within the fiscal year-to-date. Graphs displaying the **Complete Cycle Time By Final Status, Average Cycle Time By Status, Cycle Time By Status**, and **Pending Status** will display in the Graphs section and detailed **Cycle Time By Status** and **Cycle Time By Final Status** information is displayed in the Details section.

The following criteria are available (you may select **Hide Options / More Options** to toggle criteria).

- **Sourcing Event Completion Date** - The date range for the supplier awards you want to see.

- **Work Groups** - Begin entering a work group name or select the list icon to search and view the work group tree in order to select the work group(s) you wish to include in the results.
**Sourcing Event Type** - The event type for each event.

**Multistage Sourcing Events** - Choose to include, exclude, or only report on multistage sourcing events.

**Sourcing Event Final Status** - Select a status from the dropdown to filter by that status, or do not select any to include all of them.

**Reporting Commodity Codes** - Begin entering a commodity code, or select the list icon to select from or search the commodity code tree.

**Sourcing Event Creator** - The creator of each event.

Graphs displaying the **Complete Cycle Time By Final Status**, **Average Cycle Time By Status**, **Cycle Time By Status**, and **Pending Status** will display in the Graphs section.

You can edit the information in the graph by selecting or deselecting the status labels in the legend of each graph. For example, if you do not want to see Canceled events in a graph, click the Canceled label to remove it from the graph. You can click it again to include it.

Detailed **Cycle Time By Status** and **Cycle Time By Final Status** information is displayed in the Details section.

The **Cycle Time By Status** report displays a list of time ranges counted in days, and the number of events falling in each time range for each status. The report has columns for draft, pending, approved, released, open, and under evaluation statuses. Each number can be clicked to view the sourcing event numbers and names.

The **Cycle Time By Final Status** report displays a list of complete cycle time ranges counted in days, and the number of events falling in each time range for each status. The report has columns for awarded, closed without awarding, canceled, withdrawn, and rejected statuses. Each number can be clicked to view the sourcing event numbers and names.

**View the Cycle Time Summary Report**

You may view a cycle time summary report and details. Users must have the View Sourcing Operational Reports permission to access this report.

**Step-by-Step**

1. Navigate to **Sourcing > Reports > Cycle Time Summary**.

2. Select a date range for the report from the drop down **Sourcing Event Completion Date** field.

3. If additional options are hidden, click the Show Options hyperlink.
4. To filter by **Work Groups**, begin entering a work group name, or select the list icon to select from or search the work group tree.

5. To filter by **Sourcing Event Type**, begin entering an event type name, or select the list icon to select from or search the event type tree. If this field is left blank, the report will return all event types.

6. From the **Multistage Sourcing Events** dropdown, choose to include, exclude, or only report on multistage sourcing events.

7. Use the **Sourcing Event Final Status** to filter by a particular event final status, or do not select any to include all of them.

8. To filter by **Reporting Commodity Codes**, begin entering a commodity code, or select the list icon to select from or search the commodity code tree.

9. To filter by **Event Creator**, begin entering an event creator name, user name, or email, or select the list icon to select from or search all event creators.

10. Click **Run Report**.

11. Graphs displaying the **Complete Cycle Time By Final Status**, **Average Cycle Time By Status**, **Cycle Time By Status**, and **Pending Status** will appear in the Graphs section.

12. Select and deselect status labels in the legend of each graph to see different results.

13. Detailed **Cycle Time By Status** and **Cycle Time By Final Status** reports will appear below the graphs.

    - The Cycle Time By Status report displays a list of time ranges counted in days and the number of events falling in each time range for each status. The report has columns for draft, pending, approved, released, open, and under evaluation statuses. Each number can be clicked to view the sourcing event numbers and names.

    - The Cycle Time By Final Status report displays a list of complete cycle time ranges counted in days and the number of events falling in each time range for each status. The report has columns for awarded, closed without awarding, canceled, withdrawn, and rejected statuses. Each number can be clicked to view the sourcing event numbers and names.
Templates and Libraries

Sourcing customers can configure Templates and Libraries for use in creating Sourcing Events. A Library is made up of collateral, which are specific sections of a sourcing event that you may use over and over... such as a series of questions, prerequisite materials, or items.

Templates can be created with or without selecting pieces of collateral from a Library. To assist with streamlining the event creation process, Event Creators have the ability to create a Sourcing Event from a Template or populate the event using Collateral from a Library.

A user must have the permission to Create Templates and Libraries, and be assigned as a Template and Library Manager for a work group. A user can only create Templates and Libraries for work groups to which they are assigned specifically as a Template and Library Manager. For example, if a user is an Event Creator but not a Template and Library Manager, the user will be able to create events for that work group, but not manage a library or template for that workgroup.

Navigation to Templates and Libraries

Work Group User Group - Template and Library Manager
Managing Libraries

Libraries are managed on the Sourcing > Templates and Libraries > Manage Libraries page. When managing libraries, users have the ability to:

- Create and edit collateral
- Group collateral
- Use collateral to create a template
- Select collateral when creating events

Users with the Manage Templates and Libraries permission have see/edit all libraries for work groups in which the user is assigned as a Template and Library Manager. If the user is assigned as a work group Administrator but not a Template and Library Manager, the user can view the library but not make edits.

On the Manage Libraries page, the user can search for a library by name, the event type associated with the library, or work group associated with the library. A More Options link provides the user with the ability to search by:

- **Collateral Type** - Search by Any Collateral type, or click Selected Collateral types and choose one or more values.
- **Work Groups** - Click the Edit button and choose from work groups (that you have access to) to see libraries associated with a specific work group.
• **Event Types** - Search by Any Event Type, or click Selected Event Types and choose one or more values.

• **Status** - Search for libraries that are Draft (Hidden) or Published.

Library results include:

• **Library Name** - This is the default sort for the library list.

• **Contents** - A list of all the contents of the library. Select an item to navigate to that part of the library.

• **Description** - The description of the library.

• **Last modified** - The last date the library contents were modified. Library results can be sorted by date.

• **Status** - If the library is Published, it can be used for templates and events. If it is Draft (Hidden), it is not visible for templates and events. Library results can be sorted by Status.

• **Actions** - A button for actions displays depending on the user's access to the library's work group:

  • **View** - This button displays if the user has access to the work group but is not assigned as a Template and Library Manager. The user can view the library contents but cannot edit.

  • **Edit** - Select Edit to edit the contents of the library.

  • **Publish** - Displays for libraries that are in Draft (Hidden) status, and makes the library Published so it can be used for templates and events.

  • **Hide Library** - Displays for libraries that are Published, and removes the library from view so it cannot be used for templates and events.

  • **Delete Library** - Removes the Library and its contents.

**Add a New Library**

**Step-by-Step**

Permission(s) required: Manage Templates and Libraries.

1. Navigate to **Sourcing** > **Templates and Libraries** > **Manage Libraries**.

2. Click the **Add Library** button. The **Add Library** overlay shows.

3. Enter a **Library Name**.
4. Enter an optional **Description** for the Library.

5. Associate **work group(s)** to the Library by selecting the **Edit** button.
   a. Only work groups to which you are assigned as a Template and Library Manager will display.
   b. View child work groups by selecting the expand icon.
   c. Select one or more work groups for the library. This will allow events for the selected work groups to use the library contents.
      i. If you select a parent work group, the library will also be applied to all child work groups.
      ii. You may select a child work group without selecting the parent.
   d. When finished selecting work groups, click **Done**.

6. **Event Types** - Select if you want the library available for All Event Types or Selected Event Types.
   a. If Selected Event Types, choose from your organization's configured event types.
   b. This will allow events of the selected (or all) event types to use the library contents (for associated work groups).

7. **Status** - Select if you want this library to be **Published** so that it can immediately be used on the designated event types and work groups, or keep in **Draft (Hidden)** form until you have finalized the collateral.

8. Click **Save Changes**.

9. The Library is created and you are navigated to the Library Settings page. Here, you may edit the Work Groups, Event Types, or Status for the Library.

10. Add collateral as appropriate. For each section, click **Save Changes** when finished. Add as many collateral items as is appropriate for the library, considering the different events that may be entered for the associated work group and event types.

11. **Descriptions** - Click **Add Description** to create descriptions that may be used from this library.
   a. Enter a **Name** for the description, to make it easily recognizable for future selection.
   b. Enter the **Description Content**, using the formatting tools available, if desired.
   c. Click **Save Changes** for each description added.

12. **Prerequisites** - Click to **Add New Prerequisite** to create prerequisite text or information that may be used from this library.
a. Enter **Instructions to supplier** to show on the Prerequisites page, to let the supplier know more about the prerequisite.

b. Select how you would like to display your **Prerequisite Content**:

   i. **Enter text directly (or copy and paste)** - the supplier will see the text directly on the Prerequisites page. If this option is selected, an Edit button shows in order to enter the appropriate text.

   ii. **Attach a file from my computer** - the supplier will select to open/download the attachment from the Prerequisites page. If this option is selected, an Upload button displays in order to attach the file. The maximum upload file size is 25MB.

c. Select the **Type** of Prerequisite:

   i. **Optional** - The supplier is not required to view this prerequisite in order to view or bid on the event.

   ii. **Required to View Event** - The supplier will be required to certify they have reviewed this prerequisite in order to view the event.

   iii. **Required to Enter Bid** - The supplier will be required to certify that they have reviewed this prerequisite in order to bid on the event. They are not required to review the prerequisite simply to view the event details.

d. Enter **Certification Text**. Default text is provided, but you may edit as appropriate for your organization.

e. Select the option for **Supplier Must Also Upload a File** if appropriate.

f. Click **Save Changes**.

13. **Attachments** - Click to **Add New Attachment** to add an attachment that may be used from this library.

   a. If selecting **File** as the **Attachment Type**:

      i. Select the **Upload** button.

      ii. Enter a **Title** for the attachment.

      iii. Select **Browse** and select the appropriate file.

      iv. Click **Save Changes**.

   b. If selecting **Link** as the **Attachment Type**:

      i. Enter an optional **Name** for the link.

      ii. Provide the **URL** for the link.
c. If more than one attachment is listed, you may choose the display order for any new attachments.

14. On the Questions page, you may add questions to a Draft event individually in the UI, or in bulk via an Excel import file.

a. Add a new page by selecting:
   i. Draft event: Add or Import button, then Add Question Page. Enter a Page Title, and choose a display order. Click Save Changes when done.
   ii. Published event: Add New hyperlink, then Question Page. Enter a Page Title, and choose a display order. Click Save Changes when done.

b. Add a new group by selecting:
   i. Draft event: Add or Import button, then Add Question Group. Enter a Group Name, and choose a display order. Click Save Changes when done.
   iii. Published event: Add New hyperlink, then Question Group. Enter a Group Name, and choose a display order. Click Save Changes when done.

c. To enter questions into existing groups, select the Add New Question button within the group, or select Manage Group and:
   i. Add New Question - To add a question to this group of questions.
   ii. Edit Group - To change the name of the group.
   iii. Delete Group - To remove the group of questions.

d. When selecting to Add New Question:
   i. Enter the Question Text. This is displayed to suppliers.
   ii. Select a Response Type for the question (the format of the answer). See Event Questions, on page 67 for more details on the types of responses.
   iii. Indicate if a Supplier Response is Required.
   iv. Select the Upload button if you would like to attach a file to the question.
   v. Once more than one question is provided, indicate the Display Order for the question.
   vi. Select Save Changes to add the question to the page.

15. On the Items page, you may add product and/or service line items to a Draft event individually in the UI, or in bulk via an Excel import file.

a. Add a new group to the Product Line Items or Service Line Items page by selecting:
i. **Draft** event: *Add or Import* button, then *Add Item Group*. Enter a *Group Name*, and choose a display order. Click *Save Changes* when done.

ii. **Published** event: *Add New* hyperlink, then *Item Group*. Enter a *Group Name*, and choose a display order. Click *Save Changes* when done.

b. To enter items into existing groups on the **Product Line Items** or **Service Line Items** page, select the *Add New Item* button within the group on the appropriate page, or select *Manage Group* and:

   i. **Add New Item** - To add an item to this group.

   ii. **Edit Group** - To change the name of the group.

   iii. **Delete Group** - To remove the group of line items.

c. When selecting to add a new item to the **Product Line Items** page, you will be given the option to provide the following information: (Required fields are indicated with an asterisk *):

   i. Enter a **Name** for the item.

   ii. Enter a **Description** for the item.

   iii. Enter a **Catalog Number** for the item, if known.

   iv. Enter a **Quantity** of the item needed.

   v. Select a **Unit of Measure** for the item from the drop-down.

   vi. Select from the following **Options** (these may be changed for individual event items):

      - Select if a **Unit Price is Required** for this item. If selected, the supplier cannot submit a bid response without entering this information.

      - Select if an **Estimated Delivery Date** is Required for this item. If selected, the supplier cannot submit a bid response without this information.

   vii. You may attach a file to the item by selecting **Upload**, entering a title for the file, and selecting the appropriate file to attach.

   viii. Select a **Display Order**, if appropriate.

    ix. Click to **Save Changes**.

d. When selecting to add a new item to the **Service Line Items** page, you will be given the option to provide the following information: (Required fields are indicated with an asterisk *):

...
Enter a Name for the item.

Enter a Description for the service.

Enter a Quantity for the service item.

Enter a Unit of Measure for the item.

Select if a Unit Price is Required for this item. If selected, the supplier cannot submit a bid response without this information.

You may attach a file to the item by selecting Upload, entering a title for the file, and selecting the appropriate file to attach.

Click to Save Changes.

Edit an Existing Library

Step-by-Step

Permission(s) required: Manage Templates and Libraries.


2. To delete a library, select the Edit button drop-down, then Delete Library.

3. To publish a draft library, select the Edit button drop-down, then Publish Library.

4. To hide a published library, select the Edit button drop-down then Hide Library.

5. To edit the Library settings such as the name, description, work groups, event types or status, select the Edit button for the library.
   a. Make edits to the Library Settings as required.
   b. Once changes are made, click to SaveChanges.

6. To edit specific collateral in the library, select the content link for the collateral to be edited. For example, if you want to edit Attachments for a library, click the Attachment hyperlink to navigate directly to that content page of the library.

7. Changes to the library are captured in an audit log, viewed by selecting the History hyperlink for the library.

Libraries - Descriptions

You may include one or more descriptions in a library from which you can select when creating an event. The Description is required in an event, and should give good basic information about the service or products you need.
To add a new description to the library, select Add Description. You will enter a name for the description, and then enter the description content. Note the formatting tools that allow you to format text, insert a link or image, create a bulleted list and more.

Add/Edit Library Descriptions

**Step-by-Step**

Permission(s) required: Manage Templates and Libraries.


2. To edit an existing Library Description, select the Descriptions hyperlink for the appropriate Library. Or, select the Edit button for the library, then navigate to the Descriptions page.

3. When creating a new Library, navigate to the Description page.

4. Click Add Description to create descriptions that may be used from this library.
   a. Enter a Name for the description, to make it easily recognizable for future selection.
   b. Enter the Description Content, using the formatting tools available, if desired.
   c. Click Save Changes for each description added.

5. To remove a description from the Library, select the Edit button, and select Delete.

6. To edit the Description, select the Description Content hyperlink. Or, you may choose the Edit button, and select Edit. Click the Save Changes button to save your edits.

Libraries - Prerequisites

You may include one or more prerequisites in a library from which you can select when creating an event. You may choose to add Prerequisite information to an event if it is important to you that a supplier reviews information about your company and/or the event prior to proceeding with their response. For example, you may want the supplier to certify that they have reviewed your Non-Disclosure Agreement or payment terms.

You will enter text about the prerequisite, and select if you want to enter the content of the prerequisite on the page or attach a file with the appropriate information. You will select if it is optional for the supplier to view the prerequisite, if it's required that the supplier certify they have reviewed it prior to viewing the entire event, or prior to submitting a bid. You may customize the provided Certification Text if needed. You may also ask that a supplier upload a file if you provide the directions to do so.
To add a new prerequisite to the library, select **Add New Prerequisite**. To edit an existing prerequisite, select the **Edit** button to Edit or Delete.

Add/Edit Library Prerequisites

**Step-by-Step**

Permission(s) required: Manage Templates and Libraries.

2. To edit an existing Library Prerequisite, select the Prerequisites hyperlink for the appropriate Library. Or, select the Edit button for the library, then navigate to the Prerequisites page.

3. When creating a new Library, navigate to the Prerequisites page.

4. Click to Add New Prerequisite to create prerequisite text or information that may be used from this library.
   a. Enter Instructions to supplier to show on the Prerequisites page, to let the supplier know more about the prerequisite.
   b. Select how you would like to display your Prerequisite Content:
      i. Enter text directly (or copy and paste) - The supplier will see the text directly on the Prerequisites page. If this option is selected, an Edit button shows in order to enter the appropriate text.
      ii. Attach a file from my computer - The supplier will select to open/-download the attachment from the Prerequisites page. If this option is selected, an Upload button displays in order to attach the file. The maximum upload file size is 25MB.
   c. Select the Type of Prerequisite:
      i. Optional - The supplier is not required to view this prerequisite in order to view or bid on the event.
      ii. Required to View Event - The supplier will be required to certify they have reviewed this prerequisite in order to view the event.
      iii. Required to Enter Bid - The supplier will be required to certify that they have reviewed this prerequisite in order to bid on the event. They are not required to review the prerequisite simply to view the event details.
   d. Enter Certification Text. Default text is provided, but you may edit as appropriate for your organization.
   e. Select the option for Supplier Must Also Upload a File if appropriate.
   f. Click Save Changes.

5. To remove a prerequisite from the Library, select the Edit button, and select Delete.

6. To edit a Prerequisite, select the Edit button, and select Edit. Make the appropriate changes, and click the Save Changes button to save your edits.
Libraries - Attachments

You may include one or more attachments as files or URL links in a library from which you can select when creating an event. An attachment may be a building design or layout, detailed specifications related to products or services, an addendum for the event, etc. When you select to **Add New Attachment**, you will be prompted to select File or Link, and upload the file or enter the URL appropriately.

Add/Edit Library Attachments

**Step-by-Step**

Permission(s) required: Manage Templates and Libraries.


2. To edit an **existing** Library attachment, select the Attachments hyperlink for the appropriate Library. Or, select the Edit button for the library, then navigate to the Attachments page.

3. When creating a new Library, navigate to the Attachments page.

4. When selecting **Add New Attachment**:, you may select to upload a file or include a link.
   a. If selecting **File** as the **Attachment Type**:
      i. Select the Upload button.
      ii. Enter a Title for the attachment.
      iii. Select Browse and select the appropriate file.
      iv. Click Save Changes.
   b. If selecting **Link** as the **Attachment Type**:
      i. Enter an optional Name for the link.
      ii. Provide the URL for the link.
   c. If more than one attachment is listed, you may choose the display order for any new attachments.

5. To remove an attachment from the Library, select the Edit button, and select Delete.
6. To edit the Description, select the **Edit** button, and select Edit. Click to upload a new attachment, or remove the current attachment. Click the **Save Changes** button to save your edits.

**Libraries - Questions**

You may include one or more questions in a library from which you can select when creating an event. You may organize questions pages, and in groups on each page.

To add a new question to the library, select **Add New Question** in the selected group. You may create new groups by selecting the Add or Import button (Draft events) or Add New hyperlink (Published Events). You also have the ability to import questions in bulk within Draft libraries, and export questions from any library.

The following displays a Library in **Draft** status, therefore allowing the user to import questions in bulk via an Excel file.

The following displays a Library in **Published** status. Questions may be added through the UI only, by selecting **Add New** or **Add New Question**. The option to Import is not available for Published libraries.

When selecting to **Add New Question**, you will enter the question text and response type. Some additional criteria for the question may be configured specifically on the event when the question is added to the event, such as auto scoring or cost analysis options.
Add/Edit Library Questions

Step-by-Step

Permission(s) required: Manage Templates and Libraries.


2. To edit an existing Library Question, select the Questions hyperlink for the appropriate Library. Or, select the Edit button for the library, then navigate to the Question page.

3. When creating a new Library, navigate to the Questions page.

4. On the Questions page, you may add questions to a Draft event individually in the UI, or in bulk via an Excel import file.
   a. Add a new page by selecting:
      i. Draft event: Add or Import button, then Add Question Page. Enter a Page Title, and choose a display order. Click Save Changes when done.
      ii. Published event: Add New hyperlink, then Question Page. Enter a Page Title, and choose a display order. Click Save Changes when done.

   b. Add a new group by selecting:
      i. Draft event: Add or Import button, then Add Question Group. Enter a Group Name, and choose a display order. Click Save Changes when done.
      ii. Published event: Add New hyperlink, then Question Group. Enter a Group Name, and choose a display order. Click Save Changes when done.

   c. To enter questions into existing groups, select the Add New Question button within the group, or select Manage Group and:
i. **Add New Question** - To add a question to this group of questions.

ii. **Edit Group** - To change the name of the group.

iii. **Delete Group** - To remove the group of questions.

d. When selecting to **Add New Question**:

   i. Enter the **Question Text**. This is displayed to suppliers.

   ii. Select a **Response Type** for the question (the format of the answer).

   iii. Indicate if a **Supplier Response is Required**.

   iv. Select the **Upload** button if you would like to attach a file to the question.

   v. Once more than one question is provided, indicate the **Display Order** for the question.

   vi. Select **Save Changes** to add the question to the page.

5. To **remove** a question from the Library, select the **Edit** button, and select **Delete**. You may delete multiple questions by selecting the checkbox on the right side of the question and choosing the hyperlink **Delete Selected Question(s)**.

6. To **edit** a question, select the **Edit** button, and select **Edit**. Make the appropriate changes. Click the **Save Changes** button to save your edits.

**To manage Library questions via import/export**

1. Request an Export of current questions or open the template:

   a. To **Export Questions**:

      i. Select the **Export Questions** button. An **Export Questions** overlay displays.

      ii. Enter a **Description** for the export request.

      iii. Select if you want to receive an **Email When Export Is Ready** or not. Depending on the selection for the **Sourcing - Exports** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this export request. Select the **What's This** hyperlink in the overlay for more information.

      iv. Click **Submit**.

   b. To get the **Questions Template**:

      i. Select the **Add or Import** button, then select **Import from File > Get Template**. A **Get Template** overlay displays.
b. Enter a **Description** for the requested template.

c. Click **Submit**.

2. A confirmation displays that the request has been submitted, and the user is navigated to the **Exports and Imports** page of the Library.

3. The requested file status will display. You may select to **Refresh this Page** until the status is **Completed**.

4. Select the **File** name to open or download the file. Best practice is to save the file to your computer/network.

5. Click the **Delete** link for the file if you would like to remove it from the page.

**Prepare the file**

6. Open the questions Export file or Questions Template.

7. Select the **Enable Editing** button in the spreadsheet.

8. Review and follow the instructions on the **Import Instructions** page of the file.

9. You may edit the Page Name. For example, instead of "Page: 1", you may enter "Page: Legal Information".

10. Add a new group by select **Group** as the **Type** on the appropriate page, and entering the group title in the **Group Title or Question Text** column.

11. To modify a group, edit the group title in the **Group Title or Question Text** column.

12. To add a new question:

   a. Select the value **Question** from the options in the **Type** column.

   b. Enter the question text in the **Group Title or Question Text** column.

   c. Indicate **Yes** or **No** for **Response Required** for this question. If **Yes**, a supplier must respond to the question in order to submit a response to the event.

   d. Select the type of response you expect for this question, such as a date, numeric value, option list, etc.

   e. If you selected a response type that involves a list (Dropdown List or Multiple Choice), configure the options below the question.

      i. Select the value **Option** from the selections in the **Type** column.

      ii. Enter the option value in the **Options Suppliers Can Pick From** column.

      iii. Continue adding options as appropriate.
f. Auto Score and Cost Analysis options in the **Optional Questions Section** should be provided at the event level.

13. When all questions have been entered, save the file in .xls or .xlsx format. Note that the information in the file will completely replace any questions information currently in the event.

**Validate / Import the file**

14. Navigate to the Questions page of the library.

15. Select the **Add or Import** button, then **Import from File > Import**. An **Import Questions** overlay displays.

   a. Select an **Import Action**. Import is the default action, and will import the questions into the library if there are no errors in the file. You may choose to **Validate only**, which will simply check the file for errors and will not import the file.

   b. Browse and select a **File Name**.

   c. Enter an optional **Description** for the import.

   d. Select if you want to receive an **Email When Import Is Ready** or not. Depending on the selection for the **Sourcing - Imports** or **Sourcing - Validate** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this request. Select the **What's This** hyperlink in the overlay for more information.

   e. Click **Submit** to import (or validate) the file.

   f. A confirmation displays, reminding the user that the file information will replace all existing data in this section of the library. Click **Yes** to confirm.

5. A confirmation message display that the questions have been submitted for import, and the user is navigated to the **Exports and Imports** page of the Library.

6. The requested file status will display. You may select to **Refresh this Page** until the status is **Completed**. If there are any errors, you may download and open the file to review. If there are no errors, you will simply see the request completed.

7. Once the request completes the import process, you may view the updated questions in the Questions section of the Library.

8. Event **History** captures new and edited questions.

**Libraries - Additional Item Fields**

You may include one or more additional item fields in a library which you can select when creating an event.
To add an additional item field to the library, click **Create Additional Field** on the Additional Item Fields page of the selected library.

You will enter the field name, what type of item the field is applicable to, whether suppliers can respond, and fieldtype.

When adding additional item fields from a library to a sourcing event, **conditional visibility** settings are carried to the sourcing events they are added to, however, note the following:

- When adding additional item fields from a library to a sourcing event, scoring and cost adjustment values for response options must always be configured within the sourcing event.

- When adding a set of additional item fields with conditional visibility settings from a library or template to a sourcing event, only the top level additional item fields (parents) are available for selection, but all fields in the hierarchy (child and grandchild) are added to the event when the parent is added.

**Add/Edit Additional Item Fields in the Library**

**Step-by-Step**

Permission(s) required: Manage Templates and Libraries.

1. Navigate to **Sourcing > Templates and Libraries > Event Libraries**.

2. Choose one of the following options to open the **Additional Item Fields** page:

   - *To edit an existing Library Additional Item Field* - Select the **Edit** button for the library, then navigate to the **Additional Item Fields** page.

   - *If creating a new library* - Click **Add Library**, complete fields in the **Add Library** window, then navigate to the **Additional Item Fields** page.

3. Choose one of the following options to create or modify an additional item field:

   - **Create an additional item field** - Click the **Additional Item Fields** button and select **Create Additional Field**.

   - **Create an additional item field with conditional visibility settings** - Choose this option to create a field that is only displayed when a specified value is selected in its parent field. Click the **Additional Item Fields** button and select **Create Conditional Follow Up** from the drop down menu, then select the **additional item field** that will be immediately above the field you are creating in the conditional visibility hierarchy.
4. Complete the following fields:

a. If you are creating or editing a conditional field, in the **Conditional Upon Value** field, select the value from the parent field that will cause the field you are creating to be displayed.

b. Enter a **Name** for the field. This is the question you expect a supplier to answer by completing the field.

c. Enter an optional **Description** for the field.

d. In the **Applicable To** field, select if the field is applicable to product line items, service line items, or both. If you are creating a conditional field this will be a read-only field that displays what has been selected on the parent field.

e. In the **Supplier Can Respond** field, select **Yes** or **No** to indicate whether or not suppliers are able to respond to the field. If you are creating a conditional field, choose Yes. Additional checkboxes are displayed depending on your selection:

   - **Visible to supplier** - Displayed if you select **No**. Select to enable suppliers to view the field even when response is disabled. If not selected, only internal users can view and edit the field.

   - **Supplier response is required** - Displayed if you select **Yes**. Select the checkbox to make it mandatory that suppliers complete the field before they can submit a bid.

f. Select a **field type**:

   **Note:** The following field types support auto-scoring, cost analysis, and disqualifying responses: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Choice (Pick Many), Date.

   - **Text (Single Line)** - The supplier response is a single line of text, up to 100 characters.

   - **Text (Multi-Line)** - The supplier response is text, and is entered into a text box that can accept up to 2000 characters.

   - **Numeric Text Box** - The supplier response must be a number.

   - **Yes/No** - The supplier response is to select Yes or No for the question.

   - **Dropdown List (Pick One)** - You will configure several different values for the supplier response, the supplier will access the options via a dropdown list. The supplier can select one option from the list.
- **Multiple Choice (Pick One)** - You will configure several different values for the supplier response, and the supplier may select only one of the values as a response. The choices are displayed as radio buttons.

- **Multiple Select (Pick Many)** - You will configure several values for the supplier response, and the supplier may select multiple values as a response. The choices are displayed as checkboxes.

- **Date** - The supplier response is a date.

g. The **Set Disqualifying Response** checkbox is displayed if Yes is selected for **Supplier Can Respond** and the appropriate **Field Type** is selected. Enable this option if you want to configure a response to an item-level question that, if selected, will disqualify a supplier. The disqualifying response is defined under Response Options.

h. Select the following checkboxes to configure auto-scoring or cost analysis for the field:

   - **Use Response in Auto Score** - Select to use supplier responses to additional item fields for auto-scoring. If selected, scoring values are added to each response in the Response Options section.

   - **Use Response in Cost Analysis** - Select to use supplier responses to additional item fields for cost analysis. If selected, cost adjustments are added to each response in the Response Options section.

   **Note:** These checkboxes are displayed if auto-scoring and cost analysis have been enabled for the event and set to be applied at the individual line level, and the field type chosen supports auto-scoring and cost analysis.

i. If you have selected a field type that requires **Response Options** to be defined, enter each response that can be selected for the field and assign auto-score and cost analysis values, and identify disqualifying responses.

   **Note:** The fields displayed in this section will vary based on the field type. For example, you will see different fields for the Date and Yes/No field types.

You will also see different columns displayed if the Auto Score, Cost Analysis, or Set Disqualifying Response checkboxes have been selected. If the **Use Response in Auto Score** checkbox is selected, a **Score** column is displayed and can be used to assign auto score points to a response option. If the **Use Response in Cost Analysis** checkbox is selected, a **Cost Adjustment** column is displayed and can be used to assign cost adjustment values to a response option.
j. If more than one additional item field is provided, indicate the **Display Order** for the field.

k. Click **Save Changes**.

5. To **remove** an additional item field from the Library, select the **Edit** button, and select **Delete**.

**Libraries - Items**

You may include one or more items in a library from which you can select when creating an event. You may organize items in groups for product line items and service line items.

To add a new item to the library, select **Add New Item** in the selected group. You may create new groups by selecting the **Add or Import** button (Draft events) or **Add Group** hyperlink (Published Events). You also have the ability to import items in bulk within Draft libraries, and export items from any library.

The following displays a Library in **Draft** status, therefore allowing the user to import items in bulk via an Excel file.

The following displays a Library in **Published** status. Questions may be added through the UI only, by selecting **Add New** or **Manage Group > Add New Item**. The option to Import is not available for Published libraries.
When selecting to Add New Item, you will enter information about the product or service. Some additional information for the items may be configured specifically on the event when the item is added to the event, such as requested delivery dates.

Add/Edit Library Items

**Step-by-Step**

Permission(s) required: Manage Templates and Libraries.

2. To edit an existing Library Item, select the Items hyperlink for the appropriate Library. Or, select the Edit button for the library, then navigate to the Items page.

3. When creating a new Library, navigate to the Items page.

4. On the Items page, you may add product and/or service line items to a Draft event individually in the UI, or in bulk via an Excel import file.
   a. Add a new group to the Product Line Items or Service Line Items page by selecting:
      i. Draft event: Add or Import button, then Add Item Group. Enter a Group Name, and choose a display order. Click Save Changes when done.
      ii. Published event: Add New hyperlink, then Item Group. Enter a Group Name, and choose a display order. Click Save Changes when done.
   b. To enter items into existing groups on the Product Line Items or Service Line Items page, select the Add New Item button within the group on the appropriate page, or select Manage Group and:
      i. Add New Item - To add an item to this group.
      ii. Edit Group - To change the name of the group.
      iii. Delete Group - To remove the group of line items.
   c. When selecting to add a new item to the Product Line Items page, you will be given the option to provide the following information: (Required fields are indicated with a star★)
      i. Enter a Name for the item.
      ii. Enter a Description for the Item.
      iii. Enter a Catalog Number for the item, if known.
      iv. Enter a Quantity of the item needed. Alternatively, you can make the Quantity field a vendor-supplied field using the following checkbox:
         - Make Quantity a Supplier Response Field - Selecting this option allows suppliers to enter an amount in the Quantity field. You will be prevented from entering data in the Quantity field if you make Quantity a supplier response field.
      v. Select a Unit of Measure for the item from the drop-down.
      vi. Select from the following Options (these may be changed for individual event items):
• Select if a **Unit Price is Required** for this item. If selected, the supplier cannot submit a bid response without entering this information.

• Select if an **Estimated Delivery Dateis Required** for this item. If selected, the supplier cannot submit a bid response without this information.

vii. You may attach a file to the item by selecting **Upload**, entering a title for the file, and selecting the appropriate file to attach.

viii. Select a **Display Order**, if appropriate.

ix. Click to **Save Changes**.

d. When selecting to add a new item to the **Service Line Items** page, you will be given the option to provide the following information: (Required fields are indicated with a star ★)

i. Enter a **Name** for the item.

ii. Enter a **Description** for the service.

iii. Enter a **Quantity** for the service item. Alternatively, you can make the Quantity field a vendor-supplied field using the following checkbox:

   • **Make Quantity a Supplier Response Field** - Selecting this option allows suppliers to enter an amount in the Quantity field. You will be prevented from entering data in the Quantity field if you make Quantity a supplier response field.

iv. Enter a **Unit of Measure** for the item.

v. Select if a **Unit Price is Required** for this item. If selected, the supplier cannot submit a bid response without this information.

vi. You may attach a file to the item by selecting **Upload**, entering a title for the file, and selecting the appropriate file to attach.

vii. Click to **Save Changes**.

5. To **remove** an item from the Library, select the **Edit** button, and select **Delete**. To delete multiple items, select the checkbox for the items and click the link **Delete Selected Item(s)**.

6. To **edit** an item, select the **Edit** button, and select **Edit**. Click the **Save Changes** button to save your edits.

**To manage Library items via import/export**
1. Request an Export of current items or open the template:
   a. To **Export Questions**:
      i. Select the **Export Items** button. An **Export Items** overlay displays.
      ii. Enter a **Description** for the export request.
      iii. Select if you want to receive an **Email When Export Is Ready** or not. Depending on the selection for the **Sourcing - Exports** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this export request. Select the **What's This** hyperlink in the overlay for more information.
      iv. Click **Submit**.
   b. To get the **Items Template**:
      i. Select the **Add or Import** button, then select **Import from File > Get Template**. A **Get Template** overlay displays.
      ii. Enter a **Description** for the requested template.
      iii. Click **Submit**.

2. A confirmation displays that the request has been submitted, and the user is navigated to the **Exports and Imports** page of the Library.

3. The requested file status will display. You may select to **Refresh this Page** until the status is **Completed**.

4. Select the **File** name to open or download the file. Best practice is to save the file to your computer/network.

5. Click the **Delete** link for the file if you would like to remove it from the page.

**Prepare the file**

6. Open the items Export file or Items Template.

7. Select the **Enable Editing** button in the spreadsheet.

8. Review and follow the instructions on the **Import Instructions** page of the file.

9. Worksheets show for Product Line Items and Service Line Items. **Note**: All Item columns display, but some are not utilized for libraries. Any information entered in these fields is ignored.

10. Add a new group by select **Group** as the **Type** on the appropriate worksheet, and entering the group title in the **Name** column. To edit a group, simply edit the **Name**.
11. To add a new item to **Product Line Items**:  
   a. On the **Product Line Items** worksheet, select the value **Item** from the options in the **Type** column.  
   b. Enter a **Name** for the item.  
   c. Enter the following information as appropriate for the product:  
      i. Description  
      ii. Catalog Number  
      iii. Quantity  
      iv. Unit of Measure  
   d. Note that the following information should be configured at the event level. **Any information imported into the library for these fields will be ignored**:  
      i. Commodity Code  
      ii. Target Price  
      iii. Alternates Allowed  
      iv. Requested Delivery Option  
      v. Requested Delivery Date  
      vi. Requested Delivery Days  
   e. If the supplier must enter a unit price for the item, select **Yes** for **Unit Price Required?**.  
   f. If the supplier must provide an estimated delivery date for the item, select **Yes** for **Delivery Date Required?**.  
12. To add a new item to **Service Line Items**:  
   a. On the **Service Line Items** worksheet, select the value **Item** from the options in the **Type** column.  
   b. Enter a **Name** for the item.  
   c. Enter the following information as appropriate for the service item:  
      i. Description  
      ii. Quantity  
      iii. Unit of Measure
d. Note that the following information should be configured at the event level. **Any information imported into the library for these fields will be ignored:**
   
i. Commodity Code
   
ii. Target Price
   
iii. Alternates Allowed?
   
iv. Requested Delivery Option
   
v. Requested Start Date
   
vi. Requested End Date
   
vii. Requested Delivery Days
   
e. If the supplier must enter a unit price for the item, select **Yes** for **Unit Price Required**.

13. When all items have been entered, save the file in .xls or .xlsx format. Note that the information in the file will completely replace any items information currently in the library.

**Validate / Import the file**

14. Navigate to the **Items** page of the library.

15. Select the **Add or Import** button, then **Import from File > Import**. An **Import Items** overlay displays.

   a. Select an **Import Action**. **Import** is the default action, and will import the items into the library if there are no errors in the file. You may choose to **Validate** only, which will simply check the file for errors and will not import the file.

   b. Browse and select a **File Name**.

   c. Enter an optional **Description** for the import.

   d. Select if you want to receive an **Email When Import Is Ready** or not. Depending on the selection for the **Sourcing - Imports** or **Sourcing - Validate** Notification Preference in your user profile, **Yes** or **No** will be selected for you, but can be changed for this request. Select the **What's This** hyperlink in the overlay for more information.

   e. Click **Submit** to import (or validate) the file.

   f. A confirmation displays, reminding the user that the file information will replace all existing data in this section of the library. Click **Yes** to confirm.

16. A confirmation message display that the items have been submitted for import, and the user is navigated to the **Exports and Imports** page of the Library.
17. The requested file status will display. You may select to Refresh this Page until the status is Completed. If there are any errors, you may download and open the file to review. If there are no errors, you will simply see the request completed.

18. Once the request completes the import process, you may view the updated items in the Items section of the event.

19. Event History captures new and edited items.

Using Library Elements in Events

Once you have libraries configured, you may choose to use an element from a library when configuring an event.

When creating an event, note the opportunity to use an item from a library in the following sections:

- **Description** - Click on the Copy from Library button, select a library to which you have access, and choose the appropriate description from the library.

- **Prerequisites** - When selecting the Add Prerequisite button, choose Add from Library. Select the appropriate Library, and then one or more prerequisites.

- **Attachments** - When selecting the Add Attachment button, choose Add from Library. Select the appropriate Library, and then one or more attachments.

- **Questions** - You may add a question page or group from a library by selecting the Add or Import button, choose Add from Library, then select the appropriate option for Question Page, Question Group or Individual Questions. You may add questions from a library to an existing group by selecting the Add Question button, then Add Questions from Library.

- **Additional Item Fields** - You may include one or more additional item fields from a library which can be selected when creating an event. Auto-score, cost analysis and conditional visibility settings on additional item fields in event templates are carried to the sourcing events to which they are added. When adding a set of additional item fields with conditional visibility settings from a library to a sourcing event, only the top level additional item fields (parents) are available for selection, but all fields in the hierarchy (child and grandchild) are added to the event when the parent is added.

- **Items** - You may add an item group from a library by selecting the Add or Import button, choose Import from Library, then select the appropriate option for Items Group or Individual Items. You may add items from a library to an existing group by selecting the Add Product Line Item or Add Service Line Item button (depending on which page of items you are on), then Add Item from Library.
Managing Templates

Templates are managed on the Sourcing > Templates and Libraries > Manage Templates page. When managing templates, users have the ability to:

- Create and edit templates
- Copy templates
- Group templates
- Associate templates to work groups (to which the user has access)
- Event creators can create events using templates associated with the work group for the event.

All users with the Manage Templates and Libraries permission have access to see templates for work groups the user is assigned as a Template and Library Manager. When creating a template, the user can only associate the template with work groups to which the user is a Template and Library Manager.

A user may also create an event based on a template directly from the Manage Templates page. The user must have access to the work groups assigned to the template, and have the permission to create events.

Add a New Template

Step-by-Step

Permission(s) required: Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Event Templates.
2. Click the Add Template button. The Add Template overlay shows.
3. Enter a Template Name.
4. Enter an optional Description for the template.
5. Select the Event Type for which this template will be available.
6. Associate work group(s) to the template by selecting the Edit button:
   a. Only work groups to which you are assigned as a Template and Library Manager will display.
   b. View child work groups by selecting the expand icon.
c. Select one or more work groups for the template. This will allow events for the selected work groups to use the template.
   
i. If you select a parent work group, the template may also be applied to all child work groups.
   
ii. You may select a child work group without selecting the parent.
   
d. When finished selecting work groups, click **Done**.

7. Select if you would like to **Protect Template**. If enabled, Event Creators cannot remove template content from an event that is utilizing the template. If it is not enabled, Event Creators may remove parts of the template content for the event.

8. On the **Status** field choose whether you want this template to be **Published** so that it can immediately be used on the designated event type and work groups, or keep in **Draft (Hidden)** form until you have finalized the template.

9. Click **Save Changes**. The template is created and you are navigated to the Template Settings page. Here, you may edit the Template Name, Description, Event Types, Work Groups, Protected setting, or Status. If any edits are made, click **Save Changes**.

10. Add information to the template as appropriate. Sections display according to the Event Type you selected for the template.

11. On the **Description** page, enter a description for the template, or click to **Copy from Library**. If you Copy from Library, an overlay displays allowing you to select a Library, and then Description text.

12. On the **Prerequisites** page, click **Add Prerequisite** and then select **Add New Prerequisite** or **Add from Library**.

a. For each new **Prerequisite** added:
   
i. Enter instructions for the supplier.
   
ii. Select how you want to enter content - by attaching a file or entering the content directly.
   
iii. Select if this prerequisite is Optional for the supplier to view, Required for the supplier to view the event, or Required for the supplier to bid on the event.
   
iv. Edit the Certification text, if appropriate.
   
v. Select if you want the Supplier to Upload a File for this prerequisite.
   
vi. Click to **Save Changes**.

b. When selecting to **Add from Library**, select the library, the prerequisite(s), then
click Add Selected Prerequisites.

c. Click the Edit button to choose to Edit or Delete the Prerequisite.

13. On the Buyer Attachments page, click to Add Attachment and then select Add New Attachment or Add from Library.

a. For each new Attachment added:
   i. Choose File or Link for the type of attachment.
   ii. Browse and upload the file, or enter the URL information as appropriate.
   iii. Click Save Changes.

b. If selecting to Add from Library, select the library, the attachment(s), then click Add Selected Attachments.

c. Click the Edit button to choose to Edit or Delete the Attachment.

14. On the Questions page, click to Add Question and then select Add New Question or Add Questions from Library.

a. If you would like to group your questions, select Manage Group and select to:
   i. Add New Question - To add a question to this group of questions.
   ii. Add Questions from Library - To add questions from a library.
   iii. Edit Group - To change the name of the group.
   iv. Delete Group - To remove the group of questions.

b. When selecting to Add New Question:
   i. Enter the Question Text. This is displayed to suppliers.
   ii. Select a Response Type for the question (the format of the answer). See Event Questions, on page 67 for more details on the types of responses.
   iii. Indicate if a Supplier Response is Required.
   iv. Select the Upload button if you would like to attach a file to the question.
   v. Once more than one question is provided, indicate the Display Order for the question.
   vi. Select Save Changes to add the question to the page.

c. When selecting to Add from Library, select the library, the page and/or group, the specific questions, then click Add Selected Questions.
d. You may select to **Add New** to create a new group or new page of questions visible to the supplier.

e. You may delete multiple questions by selecting the checkbox on the right side of the question and choosing the hyperlink **Delete Selected Question(s)**.

f. Click the Edit button to choose to **Edit** or **Delete** a question. To delete multiple questions, select the checkbox for the items and click the link **Delete Selected Question(s)**.

15. On the **Additional Item Fields** page, choose to **Create Additional Field**, **Add Field From Library** or **Create Conditional Follow Up** (to create a field that is displayed when a specific value on the parent field is selected):

   a. For each new **additional item field** added:
      
      i. Enter a **Name** and **Description** for the field.

      ii. In the **Applicable To** field, select if the field is applicable to product line items, service line items, or both. If you are creating a conditional field this will be a read-only field that displays what has been selected on the parent field.

      iii. In the **Supplier Can Respond** field, select **Yes** or **No** to indicate whether or not suppliers are able to respond to the field. If you are creating a conditional field, choose Yes. Additional checkboxes are displayed depending on your selection:

         - **Visible to supplier** - Displayed if you select **No**. Select to enable suppliers to view the field even when response is disabled. If not selected, only internal users can view and edit the field.

         - **Supplier response is required** - Displayed if you select **Yes**. Select the checkbox to make it mandatory that suppliers complete the field before they can submit a bid.

      iv. Select a **field type**.

      v. The **Set Disqualifying Response** checkbox is displayed if **Yes** is selected for **Supplier Can Respond** and the appropriate **Field Type** is selected. Click the checkbox if you want to configure a response to an item-level question that, if selected, will disqualify a supplier. The disqualifying response is defined under Response Options.

      vi. Select the following checkboxes to configure auto-scoring or cost analysis for the field:

         - **Use Response in Auto Score** - Select to use supplier responses to additional item fields for auto-scoring. If selected, scoring values are added to each response in the Response Options section.
• **Use Response in Cost Analysis** - Select to use supplier responses to additional item fields for cost analysis. If selected, cost adjustments are added to each response in the Response Options section.

**Note:** These checkboxes are displayed if auto-scoring and cost analysis have been enabled for the event and set to be applied at the individual line level, and the field type chosen supports auto-scoring and cost analysis.

vii. If you have selected a field type that requires **Response Options** to be defined, enter each response that can be selected for the field, assign auto-score and cost analysis values, and identify disqualifying responses.

viii. If more than one additional item field is provided, indicate the **Display Order** for the field.

ix. Click **Save Changes**.

b. If selecting **Add From Library**, select the library, then the additional item fields, then click **Add Selected Item Fields**.

c. If selecting **Create Conditional Follow Up**, select the **additional item field** that will be immediately above the field you are creating in the conditional visibility hierarchy and complete these fields:

   i. In the **Conditional Upon Value** field, select the value from the parent field that will cause the field you are creating to be displayed.

   ii. Enter a **Name** and **Description** for the field.

   iii. The **Supplier Can Respond** field must be set to **Yes**. Select the **Supplier response is required** checkbox to make it mandatory that suppliers complete the field before they can submit a bid.

   iv. Select one of the following **Field Types**: Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Choice (Pick Many).

   v. Choose whether to use supplier responses for scoring and cost analysis by selecting the **Use Response in Auto Score** or **Use Response in Cost Analysis** checkboxes.

   vi. Click the **Select Disqualifying Response** checkbox if you want to configure a response to an item-level question that, if selected, will disqualify a supplier.

   vii. If you have selected a field type that requires **Response Options** to be defined, enter each response that can be selected for the field, assign auto-score and cost analysis values, and identify disqualifying responses.
viii. If more than one additional item field is provided, indicate the **Display Order** for the field.

ix. Click **Save Changes**.

16. On the **Items** page, you may add product and/or service line items for the supplier's response.

a. If you would like to group your line items, select **Manage Group** and select to:
   i. **Add New Item** - To add an item to this group.
   ii. **Add New Item from Library** - To add an item from the library.
   iii. **Edit Group** - To change the name of the group.
   iv. **Delete Group** - To remove the group of line items.

b. When selecting to add a new item to the **Product Line Items** page, you may select the **Manage Group > Add New Item** link, or the **Add New Item** button for the group (required fields are indicated with a star ⭐):
   i. Enter a **Name** for the item.
   ii. (optional for Product Line Items only) If the **Brand** option is enabled for your organization, type a brand name in the field. The system will check to see if the name matches brands in the system. If there is a match, the name is added to the Brand field. If it does not match, the message **Try Searching Again** is displayed.
   iii. Enter a **Description** for the item.
   iv. Enter a **Catalog Number** for the item, if known.
   v. Enter a **Quantity** of the item needed.
   vi. Select a **Unit of Measure** for the item from the drop-down.
   vii. Select from the following **Options** these may be changed for individual event items):
      - Select if a **Unit Price is Required** for this item. If selected, the supplier cannot submit a bid response without entering this information.
      - Select if an **Estimated Delivery Date is Required** for this item. If selected, the supplier cannot submit a bid response without this information.
   viii. If you would like to associate a **Commodity Code** with the item, select the **Edit** button and choose from your organization's commodity codes. Only one commodity code may be selected for each item.
ix. You may attach a file to the item by selecting **Upload**, entering a title for the file, and selecting the appropriate file to attach.

x. Click to **Save Changes**.

c. When selecting to add a new item to the **Service Line Items** page, you may select the **Manage Group > Add New Item** link, or the **Add New Item** button for the group (required fields are indicated with a star ✶):

i. Enter a **Name** for the item.

ii. Enter a **Description** for the service.

iii. Enter a **Quantity** for the service item.

iv. Enter a **Unit of Measure** for the item.

v. For **Options**, select if a **Unit Price is Required** for this item. If selected, the supplier cannot submit a bid response without this information.

vi. If you would like to associate a **Commodity Code** with the item, select the **Edit** button and choose from your organization's commodity codes. Only one commodity code may be selected for each item.

vii. You may attach a file to the item by selecting **Upload**, entering a title for the file, and selecting the appropriate file to attach.

viii. Click to **Save Changes**.

d. When selecting to **Add from Library**, select the library, the line items group and the questions will display. Select the appropriate questions, then choose the item group to show them in the template, as well as the display order. Then click **Add Selected Items**.

e. Click the **Edit** button to choose to **Edit** or **Delete** items. To delete multiple items, select the checkbox for the items and click the link **Delete Selected Item(s)**.